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Executive Summary

For decades, cybersecurity attacks have highlighted the dangers of having computers with unpatched
software. Even with widespread awareness of these dangers, however, keeping software up-to-date
with patches remains a problem. Deciding how, when, and what to patch can be difficult for any
organization. Each organization must balance security with mission impact and business objectives by
using a risk-based methodology. To address these challenges, the NCCoE has collaborated with
cybersecurity technology providers to explore approaches for improving enterprise patching practices
for general information technology (IT) systems. These practices are intended to help your organization
improve its security and reduce the likelihood of data breaches with sensitive personal information and
other successful compromises. The practices can also play an important role as your organization
embarks on a journey to zero trust.

There are a few root causes for many data breaches, malware infections, ransomware attacks, and other
security incidents, and known—but unpatched—vulnerabilities in software is one of them.
Implementing a few security hygiene practices, such as patching operating systems, applications, and
firmware, can prevent many incidents from occurring, lower the potential impact of incidents that do
occur, and increase the cost to the attacker. Unfortunately, security hygiene is easier said than done.
Despite widespread recognition that patching is effective and attackers regularly exploit unpatched
software, many organizations cannot or do not adequately patch. There are myriad reasons why, not the
least of which are that it’s resource-intensive and that the act of patching can reduce system and service
availability. Many organizations struggle to prioritize patches, test patches before deployment, and
adhere to policies for how quickly patches are applied in different situations. Delaying patch deployment
gives attackers a larger window of opportunity.

This practice guide can help your organization:

= overcome common obstacles involving enterprise patching for general IT
systems

= achieve a comprehensive security hygiene program based on existing standards,
guidance, and publications

= enhance its recovery from incidents that occur, and minimize the impact of
incidents on the organization and its constituents

To address these challenges, the NCCoE has collaborated with cybersecurity technology providers to
develop an example solution. It demonstrates how tools can be used to 1) implement the inventory and
patching capabilities organizations need to handle both routine and emergency patching situations, as
well as 2) implement isolation methods or other mitigations as alternatives to patching. The solution
also demonstrates recommended security practices for patch management systems themselves.
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The NCCoE assembled existing commercial and open source tools to aid with the most challenging
aspects of patching. The NCCoE built upon previous NIST work documented in NIST Special Publication
(SP) 800-40 Revision 3, Guide to Enterprise Patch Management Technologies and NIST SP 800-184, Guide
for Cybersecurity Event Recovery.

Collaborator Security Capability or Component

Asset discovery and inventory; network access control; network
R LK policy enforcement

CISCO

Hardware and firmware inventory; firmware vulnerability
assessment; firmware integrity monitoring; firmware updates

< sium?
celyp

A
-

0 RESCOUT Asset discovery and inventory; security policy enforcement

Asset inventory; configuration management; software updates;
vulnerability scanning of source code as part of a DevOps pipeline

<|||i
@

L k t® Security policy enforcement; vulnerability scanning and reporting;
oo OU software discovery and inventory; firmware vulnerability assessment

and policy enforcement

Asset discovery; configuration management; software updates

Microsoft

Asset discovery and inventory; vulnerability scanning, reporting, and
prioritization

Vulnerability scanning and remediation; configuration management;
software updates

While the NCCoE is using commercial and open source products to address this challenge, the practice
guide will not endorse these particular products, nor will it guarantee compliance with any regulatory
initiatives. Your organization's information security experts should identify the products that will best
integrate with your existing tools and IT system infrastructure. Your organization can adopt this solution
or one that adheres to these guidelines in whole, or you can use this guide as a starting point for
tailoring and implementing parts of a solution.

HOW TO USE THIS GUIDE

Depending on your role in your organization, you might use this guide in different ways:
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Business decision makers, including chief information security and technology officers can use this
part of the guide, NIST SP 1800-31A: Executive Summary, to understand the drivers for the guide, the
cybersecurity challenge we address, our approach to solving this challenge, and how the solution could
benefit your organization. Business decision makers can also use NIST SP 800-40 Revision 4, Guide to
Enterprise Patch Management Planning: Preventive Maintenance for Technology. It complements the
implementation focus of this guide by recommending creation of an enterprise strategy to simplify and
operationalize patching while also reducing risk.

Technology, security, and privacy program managers who are concerned with how to identify,
understand, assess, and mitigate risk can use NIST SP 1800-31B: Security Risks and Capabilities, which
describes what we built and why, including the risk analysis performed and the security capabilities
provided by the example implementation. NIST SP 800-40 Revision 4, Guide to Enterprise Patch
Management Planning: Preventive Maintenance for Technology may also be helpful.

IT professionals who want to implement an approach like this can make use of NIST SP 1800-31C: How-
To Guides, which provide specific product installation, configuration, and integration instructions for
building the example implementation, allowing you to replicate all or parts of this project.

You can view or download the guide at https://www.nccoe.nist.gov/projects/critical-cybersecurity-
hygiene-patching-enterprise. Help the NCCoE make this guide better by sharing your thoughts with us as
you read the guide. If you adopt this solution for your own organization, please share your experience
and advice with us. We recognize that technical solutions alone will not fully enable the benefits of our

solution, so we encourage organizations to share lessons learned and best practices for transforming the
processes associated with implementing this guide.

To provide comments or to learn more by arranging a demonstration of this example implementation,
contact the NCCoE at cyberhygiene@nist.gov.

Collaborators participating in this project submitted their capabilities in response to an open call in the
Federal Register for all sources of relevant security capabilities from academia and industry (vendors
and integrators). Those respondents with relevant capabilities or product components signed a
Cooperative Research and Development Agreement (CRADA) to collaborate with NIST in a consortium to
build this example solution.

Certain commercial entities, equipment, products, or materials may be identified by name or company
logo or other insignia in order to acknowledge their participation in this collaboration or to describe an
experimental procedure or concept adequately. Such identification is not intended to imply special
status or relationship with NIST or recommendation or endorsement by NIST or NCCoE; neither is it
intended to imply that the entities, equipment, products, or materials are necessarily the best available
for the purpose.

NIST SP 1800-31A: Improving Enterprise Patching for General IT Systems 3
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Certain commercial entities, equipment, products, or materials may be identified by name or company
logo or other insignia in order to acknowledge their participation in this collaboration or to describe an
experimental procedure or concept adequately. Such identification is not intended to imply special
status or relationship with NIST or recommendation or endorsement by NIST or NCCoE; neither is it
intended to imply that the entities, equipment, products, or materials are necessarily the best available
for the purpose.

While NIST and the NCCoE address goals of improving management of cybersecurity and privacy risk
through outreach and application of standards and best practices, it is the stakeholder’s responsibility to
fully perform a risk assessment to include the current threat, vulnerabilities, likelihood of a compromise,
and the impact should the threat be realized before adopting cybersecurity measures such as this
recommendation.

National Institute of Standards and Technology Special Publication 1800-31B, Natl. Inst. Stand. Technol.
Spec. Publ. 1800-31B, 49 pages, (April 2022), CODEN: NSPUE2

As a private-public partnership, we are always seeking feedback on our practice guides. We are
particularly interested in seeing how businesses apply NCCoE reference designs in the real world. If you
have implemented the reference design, or have questions about applying it in your environment,
please email us at cyberhygiene@nist.gov.

All comments are subject to release under the Freedom of Information Act.

National Cybersecurity Center of Excellence
National Institute of Standards and Technology
100 Bureau Drive
Mailstop 2002
Gaithersburg, MD 20899

Email: nccoe@nist.gov
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The National Cybersecurity Center of Excellence (NCCoE), a part of the National Institute of Standards
and Technology (NIST), is a collaborative hub where industry organizations, government agencies, and
academic institutions work together to address businesses’ most pressing cybersecurity issues. This
public-private partnership enables the creation of practical cybersecurity solutions for specific
industries, as well as for broad, cross-sector technology challenges. Through consortia under
Cooperative Research and Development Agreements (CRADAs), including technology partners—from
Fortune 50 market leaders to smaller companies specializing in information technology security—the
NCCoE applies standards and best practices to develop modular, adaptable example cybersecurity
solutions using commercially available technology. The NCCoE documents these example solutions in
the NIST Special Publication 1800 series, which maps capabilities to the NIST Cybersecurity Framework
and details the steps needed for another entity to re-create the example solution. The NCCoE was
established in 2012 by NIST in partnership with the State of Maryland and Montgomery County,
Maryland.

To learn more about the NCCoE, visit https://www.nccoe.nist.gov/. To learn more about NIST, visit
https://www.nist.gov.

NIST Cybersecurity Practice Guides (Special Publication 1800 series) target specific cybersecurity
challenges in the public and private sectors. They are practical, user-friendly guides that facilitate the
adoption of standards-based approaches to cybersecurity. They show members of the information
security community how to implement example solutions that help them align with relevant standards
and best practices, and provide users with the materials lists, configuration files, and other information
they need to implement a similar approach.

The documents in this series describe example implementations of cybersecurity practices that
businesses and other organizations may voluntarily adopt. These documents do not describe regulations
or mandatory practices, nor do they carry statutory authority.

Patching is the act of applying a change to installed software — such as firmware, operating systems, or
applications — that corrects security or functionality problems or adds new capabilities. Despite
widespread recognition that patching is effective and attackers regularly exploit unpatched software,
many organizations cannot or do not adequately patch. There are myriad reasons why, not the least of
which are that it’s resource-intensive and that the act of patching can reduce system and service
availability. Also, many organizations struggle to prioritize patches, test patches before deployment, and
adhere to policies for how quickly patches are applied in different situations. To address these
challenges, the NCCoE collaborated with cybersecurity technology providers to develop an example

NIST SP 1800-31B: Improving Enterprise Patching for General IT Systems ii
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solution that addresses these challenges. This NIST Cybersecurity Practice Guide explains how tools can
be used to implement the patching and inventory capabilities organizations need to handle both routine
and emergency patching situations, as well as implement isolation methods or other emergency
mitigations as alternatives to patching. It also explains recommended security practices for patch
management systems themselves.

KEYWORDS

cyber hygiene; enterprise patch management; firmware; patch; patch management; software; update;
upgrade; vulnerability management

ACKNOWLEDGMENTS

We are grateful to the following individuals for their generous contributions of expertise and time.

Name Organization

Peter Romness Cisco

Matthew Hyatt Cisco

John Loucaides Eclypsium

Travis Raines Eclypsium

Timothy Jones Forescout

Tom May Forescout

Michael Correa Forescout

Jeffrey Ward IBM MaaS360 with Watson
Joseph Linehan IBM MaaS360 with Watson
Cesare Coscia IBM MaaS360 with Watson
Jim Doran IBM Research Team
Shripad Nadgowda IBM Research Team

NIST SP 1800-31B: Improving Enterprise Patching for General IT Systems iii



"T€-008T°dS LSIN/8209°0T/840°'10p//:sd1Y :woly 981eYd Jo 9244 d|qe|ieAe s| uolealjgnd sy

Name Organization

Victoria Mosby Lookout

Tim LeMaster Lookout

Dan Menicucci Microsoft

Steve Rachui Microsoft

Parisa Grayeli The MITRE Corporation
Yemi Fashina The MITRE Corporation
Nedu Irrechukwu The MITRE Corporation
Joshua Klosterman The MITRE Corporation
Allen Tan The MITRE Corporation
Josh Moll Tenable

Chris Jensen Tenable

Jeremiah Stallcup Tenable

John Carty VMware

Kevin Hansen VMware

Rob Robertson VMware

Rob Hilberding VMware

Brian Williams VMware

The Technology Partners/Collaborators who participated in this build submitted their capabilities in
response to a notice in the Federal Register. Respondents with relevant capabilities or product

NIST SP 1800-31B: Improving Enterprise Patching for General IT Systems iv



"T€-008T°dS LSIN/8209°0T/840°'10p//:sd1Y :woly 981eYd Jo 9244 d|qe|ieAe s| uolealjgnd sy

components were invited to sign a Cooperative Research and Development Agreement (CRADA) with
NIST, allowing them to participate in a consortium to build this example solution. We worked with:

Technology Partner/Collaborator Build Involvement

Cisco Cisco Firepower Threat Defense (FTD)
Cisco ldentity Services Engine (ISE)

Eclypsium Eclypsium Administration and Analytics Service
Forescout Forescout Platform
1BM IBM Code Risk Analyzer

IBM MaaS360 with Watson

Lookout Lookout Mobile Endpoint Security
Microsoft Microsoft Endpoint Configuration Manager
Tenable Nessus
Tenable.io
Tenable.sc
VMware VMware vRealize Automation SaltStack Config
DOCUMENT CONVENTIONS

The terms “shall” and “shall not” indicate requirements to be followed strictly to conform to the
publication and from which no deviation is permitted. The terms “should” and “should not” indicate that
among several possibilities, one is recommended as particularly suitable without mentioning or
excluding others, or that a certain course of action is preferred but not necessarily required, or that (in
the negative form) a certain possibility or course of action is discouraged but not prohibited. The terms
“may” and “need not” indicate a course of action permissible within the limits of the publication. The
terms “can” and “cannot” indicate a possibility and capability, whether material, physical, or causal.
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NOTICE: The Information Technology Laboratory (ITL) has requested that holders of patent claims whose
use may be required for compliance with the guidance or requirements of this publication disclose such
patent claims to ITL. However, holders of patents are not obligated to respond to ITL calls for patents and
ITL has not undertaken a patent search in order to identify which, if any, patents may apply to this
publication.

As of the date of publication and following call(s) for the identification of patent claims whose use may
be required for compliance with the guidance or requirements of this publication, no such patent claims
have been identified to ITL.

No representation is made or implied by ITL that licenses are not required to avoid patent infringement in
the use of this publication.
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The National Cybersecurity Center of Excellence (NCCoE) at the National Institute of Standards and
Technology (NIST) recognizes the challenges that organizations face in keeping software up to date with
patches. Patches correct security and functionality problems in software and firmware. From a security
perspective, patches are most often of interest because they are mitigating software flaw vulnerabilities;
applying patches to eliminate these vulnerabilities significantly reduces the opportunities for
exploitation. Patches can also add new features, including security capabilities. Sometimes there are
alternatives to patches, such as temporary mitigations involving software or security control
reconfiguration before patches are ready, but these mitigations are not permanent fixes and they may
impact functionality.

The NCCoE developed the Critical Cybersecurity Hygiene: Patching the Enterprise (Patching) project to
provide approaches for improving enterprise patching practices for general information technology (IT)
systems. The aim is to help organizations balance security with mission impact and business objectives.

This project utilizes commercial tools to aid with functions that include asset discovery characterization
and prioritization, and patch implementation tracking and verification. It includes actionable and
prescriptive guidance on establishing policies and processes for the entire patching lifecycle. This
volume explains why we built the example solution to address patching challenges, including the risk
analysis we performed and the security capabilities that the example solution provides.

1.1 Challenge

There are a few root causes for many data breaches, malware infections such as ransomware, and other
security incidents, and known—but unpatched—vulnerabilities in software are one of them.
Implementing a few security hygiene practices, such as patching, can address those root causes.
Patching is the act of applying a change to installed software — such as firmware, operating systems, or
applications — that corrects security or functionality problems or adds new capabilities. Patching can
prevent many incidents from occurring by minimizing the attack surface and lower the potential impact
of incidents that occur. In other words, security hygiene practices make it harder for attackers to
succeed and reduce the damage they can cause.

Unfortunately, security hygiene is easier said than done. Despite widespread recognition that (a)
patching is effective and (b) attackers regularly exploit unpatched software, many organizations cannot
or do not adequately patch. There are myriad reasons why, not the least of which are that it is resource-
intensive and that the act of patching is perceived to reduce system and service availability. However,
delaying patch deployment gives attackers a larger window of opportunity to take advantage of the
exposure. Many organizations struggle to inventory their assets, prioritize patches, have defined and
consistent processes and procedures for deployment, and adhere to policies and metrics for how quickly
patches are applied in different situations. Also, deploying enterprise patch management tools that
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operate with privileged access within an enterprise can itself create additional security risks for an
organization if the tools are not secured properly.

1.2 Solution

To address these challenges, the NCCoE collaborated with cybersecurity technology providers to
develop an example solution. It demonstrates how tools can be used to 1) implement the inventory and
patching capabilities organizations need to handle both routine and emergency patching situations, as
well as 2) implement temporary mitigations, isolation methods, or other alternatives to patching. The
solution also demonstrates recommended security practices for protecting the patch management
systems themselves against threats.

This draft covers both phases of the example solution, which involves patching, updating, and
configuring two types of general IT assets. Phase 1 focuses on desktop and laptop computers and on-
premises servers, and phase 2 adds mobile devices and containers.

The NCCoE has also created a companion publication, NIST Special Publication (SP) 800-40 Revision 4,
Guide to Enterprise Patch Management Planning: Preventive Maintenance for Technology. It

complements the implementation focus of this guide by recommending creation of an enterprise
strategy to simplify and operationalize patching while also reducing risk.

1.3 Benefits

The demonstrated approach offers several benefits to organizations that implement it, including the
following:

= Vulnerabilities in the organization’s IT systems that are susceptible to cyber attacks are
addressed more quickly, which reduces risk and lowers the likelihood of an incident occurring.

= Increased automation provides a traceable and repeatable process and leads to a decrease in
hours worked by the organization’s security administrators, system administrations, and others
who have patching responsibilities.

= [|timproves compliance with laws, regulations, mandates, local organization policy, and other
requirements to keep the organization’s software patched.

= The practices it demonstrates can play an important role as your organization embarks on a
journey to zero trust.

This NIST Cybersecurity Practice Guide demonstrates a standards-based example solution and provides
users with the information they need to replicate the proposed approach for improving enterprise
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patching practices for general IT systems. This design is modular and can be deployed in whole or in
part.

This guide contains three volumes:

= NIST SP 1800-31A: Executive Summary — why we wrote this guide, the challenge we address,
why it could be important to your organization, and our approach to solving the challenge

= NIST SP 1800-31B: Security Risks and Capabilities — why we built the example implementation,
including the risk analysis performed and the security capabilities provided by the
implementation (you are here)

= NIST SP 1800-31C: How-To Guides — what we built, with instructions for building the example
implementation, including all the details that would allow you to replicate all or parts of this
project

Depending on your role in your organization, you might use this guide in different ways:

Business decision makers, including chief security and technology officers, will be interested in the
Executive Summary, NIST SP 1800-31A, which describes the following topics:

= challenges that enterprises face in mitigating risk from software vulnerabilities
= example solution built at the NCCoE
= benefits of adopting the example solution

Business decision makers can also use NIST SP 800-40 Revision 4, Guide to Enterprise Patch Management
Planning: Preventive Maintenance for Technology.

Technology or security program managers who are concerned with how to identify, understand, assess,
and mitigate risk will be interested in this part of the guide, NIST SP 1800-31B, which describes what we
did and why. The following sections will be of particular interest:

= Section 3.5.1, Threats, Vulnerabilities, and Risks, provides a description of the risk analysis we
performed.

= Section 3.5.2, Security Control Map, maps the security characteristics of this example solution to
cybersecurity standards and best practices.

You might share the Executive Summary, NIST SP 1800-31A, with your leadership team members to help
them understand the importance of adopting standards-based, automated patch management. Also,
NIST SP 800-40 Revision 4, Guide to Enterprise Patch Management Planning: Preventive Maintenance for
Technology may be helpful to you and your leadership team.

IT professionals who may be interested in implementing an approach similar to ours will find the entire
practice guide useful. In particular, the How-To portion of the guide, NIST SP 1800-31C could be used to
replicate all or parts of the build created in our lab. Furthermore, the How-To portion of the guide
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provides specific product installation, configuration, and integration instructions for implementing the
example solution. We have omitted the general installation and configuration steps outlined in
manufacturers’ product documentation since they are typically made available by manufacturers.
Instead, we focused on describing how we incorporated the products together in our environment to
create the example solution.

This guide assumes that the reader of this document is a seasoned IT professional with experience in
implementing security solutions within an enterprise setting. While we have used a suite of commercial
products to address this challenge, this guide does not endorse these particular products. Your
organization can adopt this solution or one that adheres to these guidelines in whole, or you can use this
guide as a starting point for tailoring and implementing parts of an automated enterprise patch
management system. Your organization’s security experts should identify the products that will best
integrate with your existing tools and IT system infrastructure. We hope that you will seek products that
are congruent with applicable standards and recommended practices. Section 4.2, Technologies, lists
the products we used and maps them to the cybersecurity controls provided by this example solution.

A NIST Cybersecurity Practice Guide does not describe “the” solution, but a possible solution. This is a
draft guide. We seek feedback on its contents and welcome your input. Comments, suggestions, and
success stories will improve subsequent versions of this guide. Please contribute your thoughts to
cyberhygiene@nist.gov.

2.1 Typographic Conventions

The following table presents typographic conventions used in this volume.

Typeface/Symbol Meaning Example

Italics file names and path names; references | For language use and style guidance,
to documents that are not hyperlinks; see the NCCoE Style Guide.
new terms; and placeholders

Bold names of menus, options, command Choose File > Edit.
buttons, and fields
Monospace command-line input, onscreen mkdir

computer output, sample code
examples, and status codes

Monospace Bold | command-line user input contrasted service sshd start
with computer output
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Typeface/Symbol Meaning Example

blue text link to other parts of the document, a All publications from NIST’s NCCoE are
web URL, or an email address available at
https://www.nccoe.nist.gov.

The NCCoE issued an open invitation to technology providers to participate in demonstrating how
organizations can use technologies to improve enterprise patch management for their general IT assets.
Cooperative Research and Development Agreements (CRADAs) were established with qualified
respondents, and a build team was assembled. The team fleshed out the initial architecture, and the
collaborators’ components were composed into an example implementation, i.e., build. The build team
documented the architecture and design of the build. As the build progressed, the team documented
the steps taken to install and configure each component of the build.

Finally, the team verified that the build provided the desired capabilities. This included conducting a risk
assessment and a security characteristic analysis, then documenting the results, including mapping the
security contributions of the demonstrated approach to the Framework for improving Critical
Infrastructure Cybersecurity (NIST Cybersecurity Framework), NIST SP 800-53, the Security Measures for

“EO-Critical Software” Use Under Executive Order (EO) 14028, and other relevant standards and
guidelines.

3.1 Audience

This guide is intended for chief information officers (ClOs), chief information security officers (CISOs),
cybersecurity directors and managers, and others who are responsible for managing organizational risk
related to patch management. It also contains information of use for security engineers and architects,
system administrators, security operations personnel, and others who are involved in enterprise patch
management.

3.2 Scope

This project only covers general IT systems: desktops/laptops, servers, virtual machines and containers,
and mobile devices running current software. There are additional challenges with patching legacy IT
systems, as well as industrial control systems (ICS), Internet of Things (loT) devices, and other
technologies stemming from operational technology (OT), so they will not be covered in this project.

All aspects of security hygiene other than those related to patching are out of the scope of this project.
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3.3 Assumptions

This project is guided by the following assumptions:

= An IT endpoint for an enterprise would have firmware, operating system(s), and application(s) to
be patched. The endpoint may be in a fixed location within the organization’s own facilities or in
a fixed location at a third-party facility (e.g., a data center), or it may be intended for use in
multiple locations, such as a laptop used at the office and for telework. The proposed approach
for improving enterprise patching practices would have to account for all these possibilities.

=  Problems sometimes occur with patches, such as a failure during installation, a patch that
cannot take effect until the endpoint is rebooted, or a patch that is uninstalled because of
operational concerns or because an attacker rolled it back in order to have an entry point to the
system. This project follows a “verify everything and trust nothing” philosophy that does not
assume installing a patch automatically means the patch is successfully and permanently
applied.

= There are no standard protocols, formats, etc. for patch management, including patch
distribution, integrity verification, installation, and installation verification. It is also highly
unlikely for a single patch management system to be able to handle all patch management
responsibilities for all software on IT endpoints. For example, some applications may handle
patching themselves and not be capable of integrating with a patch management system for
patch acquisition and installation.

3.4 Scenarios

This project addresses all the scenarios described below.

3.4.1 Scenario 0: Asset identification and assessment

This scenario identifies the assets and classifies them based on vulnerability impact levels to prioritize
the order of remediation. It leverages tools to discover assets across the enterprise and the cloud and to
enumerate their firmware, operating systems (0S), and applications. Knowing which software and
software versions are in use and predetermining remediation priorities are critically important to all
other patching processes. Without accurate, up-to-date, and comprehensive information, an
organization will have difficulties effectively and efficiently performing patching processes, thus
increasing risk. While many enterprises have constant asset attrition, it is important to have full and
accurate inventory of critical assets and the best possible inventory for the full enterprise.

3.4.2 Scenario 1: Routine patching

This is the standard procedure for patches that are on a regular release cycle and haven’t been elevated
to an active emergency status (see Scenario 3). Routine patching includes endpoint firmware, OS, and
applications, and server OS and applications hosted on-premises or in the cloud (e.g., Infrastructure as a
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Service). Most patching falls under this scenario or Scenario 2. However, because routine patching does
not have the urgency of emergency patching, and routine patch installation can interrupt operations
(e.g., device reboots), it is often postponed and otherwise neglected. This provides many additional
windows of opportunity for attackers.

3.4.3 Scenario 2: Routine patching with cloud delivery model

This is the standard procedure for patches that are delivered through a cloud delivery model, such as a
“Windows as a Service (WaaS)” model with Windows operating systems, Apple Software Update, and
mobile device software updates for Android and iOS devices provided by device manufacturers or
mobile operators. This scenario is similar in importance to Scenario 1, Routine Patching. However,
organizations may not be as accustomed to cloud-delivered patches (which are frequently cumulative
for the whole system vs. discrete patches), so this scenario is somewhat more likely to be overlooked by
organizations, which increases risk.

3.4.4 Scenario 3: Emergency patching

This is the emergency procedure to address active patching emergencies in a crisis situation, such as
extreme severity vulnerabilities like the Server Message Block (SMB) vulnerability detailed in MS17-010,
as well as vulnerabilities that are being actively exploited in the wild. The scope of targets is the same as
Scenario 1. Emergency patching needs to be handled as efficiently as possible to prevent imminent
exploitation of vulnerable devices. Key characteristics include identifying vulnerable assets, triaging and
applying patches based on a priority list, and tracking and monitoring the state of those assets.

3.4.5 Scenario 4: Emergency mitigation (and backout if needed)

This is the emergency procedure in a crisis situation to temporarily mitigate risk for vulnerabilities prior
to a vendor releasing a patch. It is typically required when the vulnerability is being actively exploited in
the wild. The mitigation can vary and may or may not need to be rolled back afterward. The scope of
targets is the same as Scenario 1. Organizations need to be prepared to quickly implement a wide
variety of emergency mitigations to protect vulnerable devices. Without processes, procedures, and
tools in place to implement emergency mitigations, too much time may be lost and vulnerable devices
may be compromised before mitigations are in place. This may require disabling system functionality,
having automated mechanisms to apply these changes, and having capabilities to revert back these
changes when a permanent and approved patch is released.

3.4.6 Scenario 5: Isolation of unpatchable assets

This is the reference architecture and implementation of isolation methods to mitigate the risk of
systems which cannot be easily patched. This is typically required if routine patching is not able to
accommodate these systems within a reasonable timeframe (usually X days or less). Most systems in
this scope are legacy unsupported systems or systems with very high operational uptime requirements.
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Isolation is a form of mitigation that can be highly effective at stopping threats against vulnerable
devices. Organizations need to be prepared to implement isolation methods when needed and to undo
the isolation at the appropriate time to restore regular device access and functionality.

3.4.7 Scenario 6: Patch management system security (or other system with
administrative privileged access)

This is a reference architecture and implementation of recommended security practices for systems like
patch management systems which have administrative privileged access over many other systems. This
includes practices like least privilege, privileged access workstations, and software updates.

3.5 Risk Assessment

NIST SP 800-30 Revision 1, Guide for Conducting Risk Assessments, states that risk is “a measure of the
extent to which an entity is threatened by a potential circumstance or event, and typically a function of:

(i) the adverse impacts that would arise if the circumstance or event occurs; and (ii) the likelihood of
occurrence.” The guide further defines risk assessment as “the process of identifying, estimating, and
prioritizing risks to organizational operations (including mission, functions, image, reputation),
organizational assets, individuals, other organizations, and the Nation, resulting from the operation of
an information system. Part of risk management incorporates threat and vulnerability analyses, and
considers mitigations provided by security controls planned or in place.”

The NCCoE recommends that any discussion of risk management, particularly at the enterprise level,
begins with a comprehensive review of NIST SP 800-37 Revision 2, Risk Management Framework for
Information Systems and Organizations—material that is available to the public. The Risk Management

Framework (RMF) guidance, as a whole, proved to be invaluable in giving us a baseline to assess risks,
from which we developed the project, the security characteristics of the build, and this guide. Also, the
NIST Cybersecurity Framework and NIST SP 800-53 Revision 5, Security and Privacy Controls for
Information Systems and Organizations informed our risk assessment and subsequent
recommendations from which we developed the security characteristics of the build and this guide.

3.5.1 Threats, Vulnerabilities, and Risks

The objective of this project is to demonstrate example solutions for each of the scenarios described in
Section 3.4. Scenarios 0 through 5 collectively address improving the mitigation of software
vulnerabilities in small to large IT enterprises for general IT assets. The last scenario, Scenario 6 (see
Section 3.4.7) focuses on the security of the patch management technologies themselves. Scenario 6 has
a different set of threats, vulnerabilities, and risks than the other scenarios, so it is discussed separately
in this section. See NIST SP 1800-31 Volume C for information on which technologies we used to
demonstrate each of the scenarios.
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Scenarios 0 through 5

Collectively, the objective of Scenarios 0 through 5 is to ensure that software vulnerabilities are
mitigated, either through patching or by using additional security controls, for firmware, operating
systems, applications, and any other forms of software. The pertinent threats encompass the enormous
range of attackers and attacks that target software vulnerabilities. Major risks can be grouped into three
categories:

=  Vulnerabilities aren’t mitigated, leaving them susceptible to compromise. Potential causes of
this include organizations being unaware of vulnerabilities or vulnerable assets, patching being
delayed because of limited resources, users declining to install patches or reboot devices in
order for patches to take effect, and organizations choosing not to implement isolation
techniques or other mitigations to protect unpatchable assets.

= |nstalling patches causes unintended side effects. Examples include breaking the patched
software or other software on the asset, inadvertently altering configuration settings to weaken
security, adding software functionality without adequately securing that functionality, and
disrupting interoperability with other software or assets.

=  Patch integrity is compromised. A patch’s integrity could be compromised at several places in
the path from vendor to asset. Examples include the software vendor itself being compromised,
the organization downloading patches from an unauthorized source, patches being tampered
with while in transit to the organization, and patches being altered in storage at the
organization.

Scenario 6

The objective of Scenario 6 is to protect the example solution itself from compromise. To be effective,
the example solution requires administrative privileged access for many assets, so this makes it an
attractive target for attackers. The example solution also holds sensitive information regarding what
computing assets the organization has and what vulnerabilities each asset has, so safeguarding this
information from attackers is important. Vulnerabilities that the example solution might have include
software vulnerabilities in its own components, misconfigurations, and security design errors, such as
not encrypting its network communications.

3.5.2 Security Control Map

Table 3-1 provides a security mapping for Scenarios 0 through 5. It maps the characteristics of the
commercial products comprising the example solution (as detailed in Table 4-1) to the applicable
standards and best practices described in the Framework for Improving Critical Infrastructure
Cybersecurity (Cybersecurity Framework) and NIST SP 800-53 Revision 5. This exercise is meant to
demonstrate the real-world applicability of standards and recommended practices, but does not imply
that products with these characteristics will meet your industry's requirements for regulatory approval
or accreditation.
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Table 3-1: Mapping Security Characteristics of the Example Solution for Scenarios 0-5

Cybersecurity Framework

Category

Asset Management (ID.AM):
The data, personnel, devices,
systems, and facilities that
enable the organization to
achieve business purposes are
identified and managed
consistent with their relative
importance to organizational
objectives and the
organization’s risk strategy.

Cybersecurity Framework
Subcategory

ID.AM-1: Physical devices and
systems within the organization
are inventoried

SP 800-53 Revision 5
Controls

CM-8, System Component
Inventory

ID.AM-2: Software platforms and
applications within the
organization are inventoried

CM-8, System Component
Inventory

Identity Management,
Authentication and Access
Control (PR.AC): Access to
physical and logical assets and
associated facilities is limited to
authorized users, processes,
and devices, and is managed
consistent with the assessed
risk of unauthorized access to
authorized activities and
transactions.

PR.AC-4: Access permissions and
authorizations are managed,
incorporating the principles of
least privilege and separation of
duties

AC-3, Access Enforcement

PR.AC-5: Network integrity is
protected (e.g., network
segregation, network
segmentation)

AC-3, Access Enforcement

Data Security (PR.DS): Infor-
mation and records (data) are
managed consistent with the
organization’s risk strategy to
protect the confidentiality, in-
tegrity, and availability of infor-
mation.

PR.DS-6: Integrity checking
mechanisms are used to verify
software, firmware, and
information integrity

SI-7, Software, Firmware, and
Information Integrity
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Cybersecurity Framework

Category

Information Protection
Processes and Procedures
(PR.IP): Security policies (that
address purpose, scope, roles,
responsibilities, management
commitment, and coordination
among organizational entities),
processes, and procedures are
maintained and used to manage
protection of information
systems and assets.

Cybersecurity Framework
Subcategory

PR.IP-3: Configuration change
control processes are in place

SP 800-53 Revision 5
Controls

CM-3, Configuration Change
Control

PR.IP-12: A vulnerability
management plan is developed
and implemented

RA-3, Risk Assessment

RA-5, Vulnerability
Monitoring and Scanning

RA-7, Risk Response
SI-2, Flaw Remediation

Protective Technology (PR.PT):
Technical security solutions are
managed to ensure the security
and resilience of systems and
assets, consistent with related
policies, procedures, and agree-
ments.

PR.PT-1: Audit/log records are
determined, documented,
implemented, and reviewed in
accordance with policy

AU-6, Audit Record Review,
Analysis, and Reporting

Security Continuous
Monitoring (DE.CM): The
information system and assets
are monitored to identify
cybersecurity events and verify
the effectiveness of protective

measures.

DE.CM-1: The network is
monitored to detect potential
cybersecurity events

CA-7, Continuous Monitoring

DE.CM-8: Vulnerability scans are
performed

RA-3, Risk Assessment
SI-4, System Monitoring

Table 3-2 provides a security mapping for Scenario 6 for the example solution. Although it has the same
format as Table 3-1, the two tables have different functions. Table 3-1 lists the Cybersecurity Framework
Subcategories and SP 800-53 Revision 5 security controls that the example solution supports. Table 3-2

lists the Cybersecurity Framework Subcategories and SP 800-53 Revision 5 security controls that are
needed to support the example solution—to mitigate the risks of the solution itself.
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Table 3-2: Mapping Security Characteristics of the Example Solution for Scenario 6

Cybersecurity Framework

Category

Identity Management,
Authentication and Access
Control (PR.AC): Access to
physical and logical assets and
associated facilities is limited to
authorized users, processes,
and devices, and is managed
consistent with the assessed
risk of unauthorized access to
authorized activities and
transactions.

Cybersecurity Framework
Subcategory

PR.AC-4: Access permissions and
authorizations are managed,
incorporating the principles of
least privilege and separation of
duties

SP 800-53 Revision 5
Controls

AC-3, Access Enforcement
AC-5, Separation of Duties
AC-6, Least Privilege

PR.AC-7: Users, devices, and other
assets are authenticated (e.g.,
single-factor, multi- factor)
commensurate with the risk of the
transaction (e.g., individuals’
security and privacy risks and
other organizational risks)

AC-2, Account Management
IA-2, Identification and
Authentication
(Organizational Users)

IA-3, Device Identification
and Authentication

IA-4, Identifier Management
IA-5, Authenticator
Management

1A-9, Service Identification
and Authentication

Data Security (PR.DS):
Information and records (data)
are managed consistent with
the organization’s risk strategy
to protect the confidentiality,
integrity, and availability of
information.

PR.DS-1: Data-at-rest is protected

SC-28, Protection of
Information at Rest

PR.DS-2: Data-in-transit is
protected

SC-8, Transmission
Confidentiality and Integrity

Protective Technology (PR.PT):
Technical security solutions are
managed to ensure the security
and resilience of systems and
assets, consistent with related
policies, procedures, and
agreements.

PR.PT-3: The principle of least
functionality is incorporated by
configuring systems to provide
only essential capabilities

CM-7, Least Functionality
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This section highlights the components of the example solution and the collaborators who contributed
those components and participated in the solution design, implementation, configuration,
troubleshooting, and/or testing. More information on each component, including instructions for
installing and configuring it as part of the example solution, is provided in NIST SP 1800-31C, How-To
Guides.

4.1 Collaborators

Collaborators that participated in this build and the capabilities of their contributions to the example
solution are described briefly in the subsections below.

4.1.1 Cisco

Cisco Systems is a provider of enterprise, telecommunications, and industrial networking solutions. Cisco
Identity Services Engine (ISE) enables a dynamic and automated approach to policy enforcement that
simplifies the delivery of highly secure, micro-segmented network access control. ISE empowers
software-defined access and automates network segmentation within IT and OT environments. Cisco
Firepower Threat Defense (FTD) is a threat-focused, next-generation firewall with unified management.
It provides advanced threat protection before, during, and after attacks. By delivering comprehensive,
unified policy management of firewall functions, application control, threat prevention, and advanced
malware protection from the network to the endpoint, it increases visibility and security posture while
reducing risks.

4.1.2 Eclypsium

Eclypsium is an enterprise firmware security company. The cloud-based solution identifies, verifies, and
fortifies firmware and hardware in laptops, servers, network gear, and devices. Eclypsium
Administration and Analytics Service secures against persistent and stealthy firmware attacks, provides
continuous device integrity, delivers firmware patching at scale, and prevents ransomware and
malicious implants. Eclypsium also provides an on-premises version that has parity with the cloud-based
platform.

4.1.3 Forescout

Forescout assesses device security posture in real time upon connection and initiates remediation
workflows with your existing security tools to enforce compliance. It continuously monitors all devices
for new threats and reassesses their patch level hygiene every time the device leaves and returns to the
corporate network. Forescout works to assess all device types, including transient devices often missed
by point-in-time scans, without requiring agents. Forescout’s solution goes beyond simple device
authentication to identify every device, assess its security posture, trigger remediation workflows, and
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implement access control across heterogeneous networks to unpatched assets. It continuously monitors
all connected devices and automates response when noncompliance or unpatched assets are detected.

4.1.4 IBM

IBM MaaS360 with Watson is a unified endpoint management (UEM) solution that transforms how
organizations support users, apps, content, and data across every type of mobile device: laptops,
smartphones, tablets, and loT. IBM MaaS360 was built almost twenty years ago as a cloud-based
Software-as-a-Service (SaaS) platform that integrates with preferred security and productivity tools,
allowing modern business leaders to derive immediate value. IBM MaaS360 is the only UEM platform
that leverages the power of the Watson Artificial Intelligence engine to deliver contextually relevant
security insights for administrators, while ensuring continuous monitoring of the riskiest end users.

IBM Code Risk Analyzer was developed in conjunction with IBM Research projects and customer
feedback. It enables developers to quickly assess and remediate security and legal risks that they are
potentially introducing into their source code, and it provides feedback directly in Git artifacts (for
example, pull/merge requests) as part of continuous delivery in a DevOps pipeline. IBM Code Risk
Analyzer is provided as a set of Tekton tasks, which can be easily incorporated into delivery pipelines.

4.1.5 Lookout

Lookout is an integrated endpoint-to-cloud security solution provider with mobile endpoint protection
offerings. Lookout’s Mobile Endpoint Security (MES) solution provides cloud-centric behavior-based
detection capabilities; it performs behavioral analysis based on telemetry data from nearly 200 million
devices and over 120 million apps. This analysis enables Lookout to deliver efficient protection with a
lightweight app on the device that optimizes processor speed and battery life. In addition, continuously
monitoring changes to the endpoint enables detection of risks that span from jailbreaking or rooting a
device to advanced device compromise. With insight into both real-time changes on a device and the
aggregate view of behavior across the broader mobile ecosystem, Lookout endpoint protection can
detect zero-day threats.

4.1.6 Microsoft

Microsoft Endpoint Manager helps deliver the modern workplace and modern management to keep
your data secure in the cloud and on-premises. Endpoint Manager includes the services and tools you
use to manage and monitor mobile devices, desktop computers, virtual machines, embedded devices,
and servers. Endpoint Manager combines several services, including Configuration Manager (Microsoft
Endpoint Configuration Manager), an on-premises management solution for desktops, servers, and
laptops that are on your network or internet-based. Endpoint Configuration Manager can be integrated
with Intune, Azure Active Directory (AD), Microsoft Defender for Endpoint, and other cloud services.
Endpoint Configuration Manager can deploy apps, software updates, and operating systems, and also be
used to monitor compliance and to query and act on clients in real time.
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4.1.7 Tenable

Tenable.sc is Tenable’s on-premises vulnerability management solution. Built on Nessus technology, the
Tenable.sc family of products identifies, investigates, and prioritizes vulnerabilities. You get real-time,
continuous assessment of your security and compliance posture so you can discover unknown assets
and vulnerabilities, monitor unexpected network changes, and prioritize weaknesses to minimize your
cyber risk and prevent breaches. Tenable.sc includes over 350 pre-built, highly customizable dashboards
and reports to give you immediate insight into your security compliance, effectiveness, and risk. You can
continuously measure, analyze, and visualize the effectiveness of your security program, based on high-
level business objectives and underlying customizable policies that executives care about.

Powered by Nessus technology and managed in the cloud, Tenable.io provides the industry’s most
comprehensive vulnerability coverage with the ability to predict which security issues to remediate first.
Using an advanced asset identification algorithm, Tenable.io provides the most accurate information
about dynamic assets and vulnerabilities in ever-changing environments. As a cloud-delivered solution,
its intuitive dashboard visualizations, comprehensive risk-based prioritization, and seamless integration
with third-party solutions help security teams maximize efficiency and scale for greater productivity.

4.1.8 VMware

VMware vRealize Automation includes SaltStack Config, a modern configuration management platform
with the performance, speed, and agility IT teams need to manage large, complex IT systems and
improve efficiency at scale. For this project, vRealize Automation SaltStack Config provides device
configuration and software distribution capabilities. Specifically, it allows for configuration changes to be
made to devices by updating or removing software as well as updating settings such as network
information.

SaltStack SecOps, an add-on to the vRealize products, gives system administrators the ability to create
security policies and scan assets to determine whether they are compliant with supported, industry-
recognized security benchmarks. SaltStack SecOps also has the ability to scan your system for Common
Vulnerabilities and Exposures (CVEs), then immediately apply the updates or patches to remediate the
advisories.

4.2 Technologies

Table 4-1 lists all the technologies used in this project, the primary functions that each technology
provides to the project, and the Cybersecurity Framework Subcategories that the technology supports in
this project. Please refer to Table 3-1 for an explanation of the NIST Cybersecurity Framework
Subcategory codes.
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Table 4-1: Technologies Used in the Build

Technology

Cisco Firepower Threat
Defense (FTD) and Cisco
Firepower Management

Primary Functions

Network policy enforcement

Cybersecurity Framework

Subcategories
PR.AC-4, PR.AC-5, DE.CM-1

Center (FMC)
Cisco ldentity Services Asset discovery and inventory; ID.AM-2, PR.AC-4, PR.AC-5
Engine (ISE) network access control

Eclypsium Administration
and Analytics Service

Hardware and firmware inventory;
firmware vulnerability assessment,
integrity monitoring, and updating

ID.AM-1, ID.AM-2, PR.DS-6,
PR.IP-12

Forescout Platform

Asset discovery and inventory;
security policy enforcement

ID.AM-2, PR.AC-4, PR.AC-5,
PR.IP-3, PR.PT-1

IBM Code Risk Analyzer

Vulnerability scanning for source code

PR.IP-12

IBM MaaS360 with Watson

Asset inventory; configuration
management; software updates

ID.AM-2, PR.IP-3, PR.IP-12

Lookout Mobile Endpoint
Security (MES)

Security policy enforcement;
vulnerability scanning and reporting;
software discovery and inventory;
firmware vulnerability assessment and
policy enforcement

PR.AC-4, PR.IP-3, PR.IP-12

Microsoft Endpoint
Configuration Manager

Asset discovery; configuration
management; software updates

ID.AM-2, PR.IP-3, PR.IP-12

Tenable.sc, Tenable.io, and
Nessus

Asset discovery and inventory;
vulnerability scanning and reporting

ID.AM-2, PR.PT-1, DE.CM-8

VMware vRealize
Automation SaltStack
Config and SaltStack
SecOps

Vulnerability scanning and
remediation; configuration
management; software updates

PR.IP-3, PR.IP-12, DE.CM-8

The following sections summarize the security capabilities that each technology provided to the

example solution.
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4.2.1 Cisco Firepower Threat Defense (FTD) & Firepower Management Center
(FMC)

Cisco Firepower Threat Defense (FTD) is a virtual firewall that was utilized as the networking backbone
that connected all of the lab subnets. This build also used the Cisco FTD firewall to provide network
access management capabilities, including enforcing network access control using firewall rules. Cisco
FTD was deployed and managed in the lab via a separate Cisco Firepower Management Center (FMC)
virtual machine.

To support the unpatchable asset scenario (Scenario 5), the integration between Cisco FTD and Cisco
Identity Services Engine (ISE) via Cisco Platform Exchange Grid (pxGrid) allowed for the firewall to ingest
security group tags (SGTs) that were applied by ISE. SGTs were then used in custom firewall rules to
restrict network access to any machine that was given a quarantine tag. Section 4.2.2 has more
information on this integration.

4.2.2 Cisco ldentity Services Engine (ISE)

In this build Cisco Identity Services Engine (ISE) provided asset discovery, asset inventory, and network
access control to enforce administrator-created security and access control policies. Cisco ISE had
integrations with several other example solution technologies, including the following:

= Anintegration between ISE and AD allowed the user of a device to be identified. This
information could then be used in custom policy.

= A Dynamic Host Configuration Protocol (DHCP) relay was established between ISE and the lab
DHCP server. This integration allowed for ISE to identify any device that was assigned an IP
address. This allowed devices to be discovered as they joined the network.

=  Cisco ISE was configured to integrate with Tenable.sc via an adapter. Cisco ISE leveraged this
adapter to prompt Tenable to scan devices newly connected to the network. Cisco ISE could
then ingest this scan data to find the Common Vulnerability Scoring System (CVSS) scores of
device vulnerabilities. An ISE policy was written to apply a quarantine action, via SGTs, to any
device with a CVSS score equal to or greater than 7 (corresponding to high and critical
vulnerabilities).

= Cisco pxGrid was configured to share contextual information about authenticated devices to the
firewall. Cisco ISE was utilized to apply SGTs to devices as they were assessed for vulnerabilities.
These SGTs were then passed to the lab firewall via pxGrid, where they could be used in custom
firewall rules. pxGrid was also used to share communications between Forescout and Cisco ISE.
Forescout could apply a quarantine tag to observed devices, which would then be shared with
ISE.
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4.2.3 Eclypsium Administration and Analytics Service

In this build, we utilized Eclypsium Administration and Analytics Service to provide agent-based
identification of hardware and firmware for our laptop, desktop, and server endpoints while also
monitoring the firmware for vulnerable or end-of-life versions. Eclypsium monitored laptop and virtual
machine (VM) firmware integrity, and alerted if a component or its associated firmware changed. It also
monitored endpoints for known security vulnerabilities from out-of-date firmware. Finally, we utilized
Eclypsium’s beta firmware update script, which automatically finds the latest known Basic Input/Output
System (BIOS) firmware version for the system, downloads the update, and executes it to update the
BIOS.

4.2.4 Forescout Platform

In this build the Forescout platform was configured to perform endpoint discovery by detecting
endpoints and determining software information about those endpoints based on a set of attributes.
Forescout also provided the capability to isolate or restrict assets that cannot be patched and to
respond to emergency scenarios, such as providing an emergency mitigation or deploying an emergency
patch. Forescout had several integrations with other example solution technologies:

= The User Directory plugin was configured so that the Forescout platform integrated with the
lab’s AD Domain Controller. This plugin provided Lightweight Directory Access Protocol (LDAP)
services to Forescout, allowing directory-based users to log in to Forescout as well as providing
user directory information such as the current active domain users logged into each endpoint.

= The Domain Name System (DNS) Query Extension configuration setting allowed Forescout to
qguery the DNS server to determine the hostnames of devices identified by Forescout.

= The Tenable VM plugin provided the Forescout platform with vulnerability and scan status
information which can be used to create custom policies. This plugin also enabled Forescout to
utilize vulnerability management information that Tenable.sc collected from endpoints, and
allowed Forescout to determine if scans had been performed on endpoints within the lab.

= The Microsoft Systems Management Server (SMS)/System Center Configuration Manager
(SCCM) module was configured to allow the Forescout platform to integrate with Microsoft
Endpoint Configuration Manager. This module allowed for a custom policy to be created that
used data from Microsoft Endpoint Configuration Manager.

= The Linux plugin was configured to collect information from and manage Linux-based endpoints
via two methods: secure shell (SSH) access to the endpoint, and agent-based integration with
the endpoint.

= The HPS Inspection Engine was configured to collect information from Windows endpoints via
two methods. The first method utilized a directory-based integration with the lab’s AD Domain
Services instance, which collected domain-based information on the Windows endpoint. The
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second method utilized an agent-based integration called SecureConnector that allowed
Forescout to collect and manage Windows endpoints.

= The pxGrid plugin was configured to integrate with Cisco ISE. This plugin gave the Forescout
platform the ability to utilize Cisco ISE to apply adaptive network control (ANC) policies to
endpoints for restricting their network access.

= The Switch plugin was configured to integrate Forescout with the physical Cisco switch located
in the lab. The plugin used information from the switch to collect information about endpoints
that were physically connected to the switch.

Our implementation utilized multiple policies to support the use case scenarios. Examples of capabilities
that the policies provided are described below:

= Check for a particular application running on Windows; if present, stop execution and uninstall
it.

= Check an endpoint for known critical vulnerabilities; if any are present, use Cisco ISE to
quarantine the endpoint via the pxGrid plugin.

= Force a Windows update to occur on an endpoint with Windows Update enabled.

= Determine if a Windows endpoint has the Microsoft Endpoint Configuration Manager agent
installed.

4.2.5 IBM Code Risk Analyzer

IBM Code Risk Analyzer was used to demonstrate vulnerability scanning and reporting for pre-deployed
code as part of a DevOps pipeline to deliver a cloud-native application. Integration with Git allowed the
Code Risk Analyzer to perform vulnerability assessments against applications and base images. The Code
Risk Analyzer would then print a bill-of-materials, which indicates the composition of a deployment. This
allows an administrator to see all of an application’s dependencies and their sources, providing visibility
into application components which could have vulnerabilities.

4.2.6 1BM MaaS360 with Watson

IBM MaaS360 with Watson was used to demonstrate how to securely manage an enterprise’s devices by
enabling deployment, control of content, and policy controls. Enterprises can manage organization-
owned and user-owned devices using this product. The lab used MaaS360 for asset identification and
assessment, routine patching and emergency patching, emergency mitigations, and isolation of assets
that cannot be patched. The first phase of this lab build used MaaS360’s comprehensive enterprise
mobility management (EMM) capability to manage a MacBook Pro and a Windows 10 virtual desktop.
The second phase used MaaS360’s Mobile Device Manager (MDM) capability to manage Android and
Apple iOS devices.
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This build also used Maas360’s Cloud Extender, which allows enterprises to integrate mobile devices
with corporate on-premises and cloud-based resources. The Cloud Extender was installed on the AD
server to allow users to log in with AD accounts.

4.2.7 Lookout

Lookout MES was used in this build to perform security compliance, vulnerability scanning, and
firmware/software discovery for mobile endpoints. Our implementation of Lookout MES was integrated
with IBM MaaS360. Lookout MES shared custom device attributes, such as device threat, with MaaS360,
which could in turn provide policy enforcement. The Lookout for Work mobile client was able to provide
firmware and application vulnerability assessment for mobile endpoints. Administrators could use
Lookout to see which vulnerabilities were affecting deployed endpoints and find risk grades (i.e., A, B, C,
D, or F) for installed applications.

4.2.8 Microsoft Endpoint Configuration Manager

Microsoft Endpoint Configuration Manager was used in this build to perform configuration
management, including software and firmware patching, for Windows-based hosts. Our implementation
of Endpoint Configuration Manager included Windows Server Update Services (WSUS), an update
service primarily used for downloading, distributing, and managing updates for Microsoft Windows-
based systems. The example build used Microsoft Endpoint Configuration Manager to demonstrate the
identification of endpoints utilizing Heartbeat discovery and Windows Domain discovery methods, the
patching of Windows endpoints via Microsoft updates and third-party update sources, and the
deployment of custom scripts to endpoints.

4.2.9 Tenable.io

In the example build, Tenable.io was used to provide vulnerability scanning and reporting for Docker
container images. Containers are built from images and vulnerabilities are patched in images, not
deployed containers, so images are the focus of scanning. Tenable.io scanned the repository of a Red
Hat OpenShift cluster in the lab environment. Tenable.io was scheduled to routinely pull the latest
images from the OpenShift cluster and perform vulnerability scans on them. Scan information was
reported in the container security section of the Tenable.io Web Console. Administrators could see
vulnerability information for containers deployed in their respective networks.

4.2.10 Tenable.sc and Nessus

This example build utilized two Tenable products in the first phase of this project, Nessus and
Tenable.sc. We used Nessus to scan Linux, Windows, and macOS endpoints and network switches for
vulnerability data, and then feed this information to Tenable.sc for reporting. Tenable.sc, a vulnerability
management product, collected the information from Nessus and reported that information to
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administrators using dashboards and reports. Also, Tenable.sc had integrations with other example
solution technologies:

= Anintegration between Tenable.sc and Cisco ISE was performed to initiate scans of any newly
connected network devices. Tenable.sc would pass scan data to Cisco ISE, where a custom policy
was written to quarantine devices based on their CVSS scores.

= Anintegration between Forescout and Tenable was leveraged to scan devices as hosts joined
the network. Forescout could prompt Tenable to scan hosts to determine if an endpoint had
critical vulnerabilities. This information was ingested by Forescout for the purpose of
guarantining endpoints.

4.2.11 VMware vRealize Automation SaltStack Config

In this example build, VMware vRealize Automation SaltStack Config was used to provide configuration
management and patch deployment. In the first phase of the build, it was used to manage Windows
workstations and servers, a macOS laptop, and Linux/Unix-based VMs and servers. SaltStack Config was
configured to run jobs, applying different states or configurations, on endpoints. The job that was
written for this project, in support of the emergency mitigation scenario, could uninstall an application
based on the current version of the product. SaltStack Config also had an add-on component called
SaltStack SecOps which was utilized to scan devices for known vulnerabilities and provide mitigation
actions, including missing updates for endpoints.

4.2.12 Additional Information

See NIST SP 1800-31 Volume C for additional information on each of the technologies we used to
demonstrate the scenarios. It explains each technology, summarizes their integration into the laboratory
environment, and documents our security decisions and associated configurations.
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Section 3.4.7 describes Scenario 6, “Patch management system security (or other system with
administrative privileged access).” In support of Scenario 6, this appendix describes recommended
security practices for systems like patch management systems which have administrative privileged
access over many other systems as defined as “critical software” in Executive Order (EO) 14028. It then
summarizes how the example solution components described in this practice guide could support each
of those recommended security practices.

A.1 Security Measures

The table below defines security measures for software of critical importance. Note that these security
measures are not intended to be comprehensive. They are based on those in the NIST publication
Security Measures for “EO-Critical Software” Use Under Executive Order (EQ) 14028. A security measure
(SM) is a high-level security outcome statement that is intended to apply to critical software or to all
platforms, users, administrators, data, or networks (as specified) that are part of running critical
software. The security measures are grouped by five objectives:

1. Protect critical software and critical software platforms (the platforms on which critical software
runs, such as endpoints, servers, and cloud resources) from unauthorized access and usage.

2. Protect the confidentiality, integrity, and availability of data used by critical software and critical
software platforms.

3. ldentify and maintain critical software platforms and the software deployed to those platforms
to protect the critical software from exploitation.

4. Quickly detect, respond to, and recover from threats and incidents involving critical software
and critical software platforms.

5. Strengthen the understanding and performance of humans’ actions that foster the security of
critical software and critical software platforms.

Each row in the table defines one security measure and lists mappings to it from the NIST Cybersecurity
Framework and NIST SP 800-53 Revision 5, Security and Privacy Controls for Information Systems and
Organizations. These mappings are in the forms of Cybersecurity Framework Subcategories and SP 800-
53 security controls, respectively. The mappings are general and informational; any particular situation
might have somewhat different mappings.
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Security Measure (SM)

Cybersecurity
Framework
Subcategories

SP 800-53 Rev.
5 Controls

Objective 1: Protect critical software and critical software platforms from unauthorized access and

usage.
SM 1.1: Use multi-factor authentication that is verifier PR.AC-1, AC-2, 1A-2, |A-
impersonation-resistant for all users and administrators of PR.AC-7 4, |A-5

critical software and critical software platforms.

SM 1.2: Uniquely identify and authenticate each service PR.AC-1, AC-2, 1A-9
attempting to access critical software or critical software PR.AC-7

platforms.

SM 1.3: Follow privileged access management principles for PR.AC-1, AC-2, I1A-2, SC-
network-based administration of critical software and critical PR.AC-7, 2,SC-7
software platforms. Examples of possible implementations PR.MA-1, enhancement
include using hardened platforms dedicated to administration PR.MA-2 15

and verified before each use, requiring unique identification of

each administrator, and proxying and logging all administrative

sessions to critical software platforms.

SM 1.4: Employ boundary protection techniques as appropriate | PR.AC-3, SC-7

to minimize direct access to critical software, critical software PR.AC-5

platforms, and associated data. Examples of such techniques
include network segmentation, isolation, software-defined
perimeters, and proxies.

Objective 2: Protect the confidentiality, integrity, and availability of data used by critical software and

critical software platforms.

SM 2.1: Establish and maintain a data inventory for critical ID.AM-3, CM-8, PM-5
software and critical software platforms. DE.AE-1

SM 2.2: Use fine-grained access control for data and resources PR.AC-4 AC-2, AC-3, AC-
used by critical software and critical software platforms to 6

enforce the principle of least privilege to the extent possible.

SM 2.3: Protect data at rest by encrypting the sensitive data used | PR.DS-1 SC-28

by critical software and critical software platforms consistent

with NIST’s cryptographic standards.

SM 2.4: Protect data in transit by using mutual authentication PR.AC-3, AC-4, AC-17,
whenever feasible and by encrypting sensitive data PR.AC-7, SC-8
communications for critical software and critical software PR.DS-2, PR.PT-

platforms consistent with NIST’s cryptographic standards. 4, DE.CM-7
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Security Measure (SM)

SM 2.5: Back up data, exercise backup restoration, and be
prepared to recover data used by critical software and critical
software platforms at any time from backups.

Cybersecurity
Framework
Subcategories

PR.IP-4

SP 800-53 Rev.
5 Controls

CP-9, CP-10

Objective 3: Identify and maintain critical software platforms and the software deployed to those

platforms to protect the critical software from exploitation.

SM 3.1: Establish and maintain a software inventory for all ID.AM-1, CM-8, PM-5,
platforms running critical software and all software (both critical ID.AM-2, ID.SC- | RA-9
and non-critical) deployed to each platform. 2
SM 3.2: Use patch management practices to maintain critical ID.RA-1, ID.RA- | CA-7, RA-5, SI-
software platforms and all software deployed to those platforms. | 2, ID.RA-6, 2, SI-5, SR-8
Practices include: PR.IP-12,
= rapidly identify, document, and mitigate known DE.CM-g,
vulnerabilities (e.g., patching, updating, upgrading software RS.MI-3
to supported version) to continuously reduce the exposure
time
= monitor the platforms and software to ensure the mitigations
are not removed outside of change control processes
SM 3.3: Use configuration management practices to maintain ID.RA-1, ID.RA- | AC-5, AC-6, CA-
critical software platforms and all software deployed to those 2, ID.RA-6, 7, CM-2, CM-3,
platforms. Practices include: PR.AC-4, PR.IP- | CM-6, CM-7,
= identify the proper hardened security configuration for each | 1, PR.IP-3, RA-5, SI-5
critical software platform and all software deployed to that PR.PT-3,
platform (hardened security configurations enforce the DE.CM-g,
RS.MI-3

principles of least privilege, separation of duties, and least
functionality)
= implement the configurations for the platforms and software
= control and monitor the platforms and software to ensure the
configuration is not changed outside of change control
processes

Objective 4: Quickly detect, respond to, and recover from threats a
software and critical software platforms.

nd incidents involving critical

SM 4.1: Configure logging to record the necessary information
about security events involving critical software platforms and all
software running on those platforms.

PR.PT-1

AU-2, AU-3,
AU-4, AU-5,
AU-8, AU-9,
AU-11, AU-12
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Security Measure (SM)

Cybersecurity
Framework
Subcategories

SP 800-53 Rev.
5 Controls

SM 4.2: Continuously monitor the security of critical software DE.CM-7 CA-7,SI-4
platforms and all software running on those platforms.
SM 4.3: Employ endpoint security protection on critical software | PR.DS-5, PR.DS- | SI-3, SI-4, SI-7
platforms to protect the platforms and all software running on 6, DE.AE-2,
them. Capabilities include: DE.CM-4,
= protecting the software, data, and platform by identifying, DE.CM-7,
reviewing, and minimizing the attack surface and exposure to | DE.DP-4
known threats
= permitting only verified software to execute (e.g., file
integrity verification, signed executables, allowlisting)
= proactively detecting threats and stopping them when
possible
= responding to and recovering from incidents
= providing the necessary information for security operations,
threat hunting, incident response, and other security needs
SM 4.4: Employ network security protection to monitor the PR.DS-5, AU-13, AU-14,
network traffic to and from critical software platforms to protect | DE.AE-1, SC-7, SI-3
the platforms and their software using networks. Capabilities DE.AE-3,
include: DE.CM-1,
= proactively detecting threats at all layers of the stack, DE.CM-4,
including the application layer, and stopping them when DE.CM-7,
possible DE.DP-4
= providing the necessary information for security operations,
threat hunting, incident response, and other security needs
SM 4.5: Train all security operations personnel and incident PR.AT-5, PR.IP- | AT-3, CP-3, IR-2
response team members, based on their roles and 9, PR.IP-10

responsibilities, on how to handle incidents involving critical
software or critical software platforms.

Objective 5: Strengthen the understanding and performance of humans’ actions that foster the
security of critical software and critical software platforms.
SM 5.1: Train all users of critical software, based on their roles PR.AT-1 AT-2, AT-3

and responsibilities, on how to securely use the software and the
critical software platforms.
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Cybersecurity  SP 800-53 Rev.

Security Measure (SM) Framework 5 Controls
Subcategories

SM 5.2: Train all administrators of critical software and critical PR.AT-2 AT-3, CP-3
software platforms, based on their roles and responsibilities, on
how to securely administer the software and/or platforms.

SM 5.3: Conduct frequent awareness activities to reinforce the PR.AT-1, PR.AT- | AT-3
training for all users and administrators of critical software and 2
platforms, and to measure the training’s effectiveness for
continuous improvement purposes.

A.2 Component Support of Security Measures

This section provides summary tables for how each technology provider’s components in the example
solution could support the security measures defined above. The technical mechanisms, configuration
settings, or other ways in which the components could provide this support were not necessarily utilized
in the example solution build. The information is provided here to offer examples of how these security
measures might be implemented, not to serve as recommendations for how to implement them.

Each table in this section has the same four columns:

= SM#: This lists a security measure ID from the previous section and links to the definition of that
ID.

= Question: This contains a question NIST asked the technology providers to answer for their
components regarding the associated security measure.

= Technical Mechanism or Configuration: This is a summary of the answer from the component’s
technology provider. The content submitted by each technology provider has been edited for
brevity.

= Refs.: This provides hyperlinks to any applicable references specified by the technology
provider. This column is blank if no reference was needed or available, or if there is a single
reference for all entries in a table, in which case the reference is defined immediately before the
table.

In each table, rows with no answer or an answer of “no” or “not applicable” have been omitted for
brevity.
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A.2.1 Cisco FTD Support of Security Measures

SM# Question Technical Mechanism or Configuration Refs.
SM Does the software platform allow for the | Certificates from a Personal Identity Refl
1.1 use of a two-factor authentication Verification (PIV) card or Common Access
method for access? Card (CAC) can be used along with soft
certificates to authenticate admin users.
SM Does the software platform identify and Services using the pxGrid solution to Refl
1.2 authenticate users and machine accounts | gather data from the system or publish
that try to access the platform? require the use of certificates to secure
the communications channel.
SM Does the system allow for creating The Cisco FMC admin console supports Refl
1.3 accounts with different access levels to role-based access control. There are
enforce least management? predefined roles, and custom roles with
permissions can be created.
SM Does the system allow for the use of Administrators can limit access by IP Refl
14 discretionary access control lists (DACLs), | address and port.
network segmentation, or isolation for
access to the platform?
SM Does the system allow for creating The Cisco FMC admin console and Refl
2.2 accounts with different access levels to command-line interface (CLI) both
enforce least management? support role-based access control.
SM Does the system support performing Cisco FMC enables backup and restore of | Refl
2.5 regular backups and restorations? configuration and monitoring. FMC also
provides backup and restore of the
devices it manages.
SM Does the platform allow for the Cisco distributes several types of Refl
3.2 deployment of patches and OS updates? | upgrades and updates for Firepower
deployments. These include OS versions,
patches, vulnerability databases, intrusion
rules, and geolocation databases. These
are all deployed centrally from FMC.
SM Does the security tool support logging FMC allows for sending all logs to a third- | Refl
4.1 and sending that data to rsyslog or party SIEM using syslog or eStreamer.
Security Information and Event
Management (SIEM)?
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https://www.cisco.com/c/en/us/td/docs/security/firepower/621/configuration/guide/fpmc-config-guide-v621/firepower_system_user_management.html#ID-2263-000000e3
https://www.cisco.com/c/en/us/td/docs/security/firepower/621/configuration/guide/fpmc-config-guide-v621/firepower_system_user_management.html#ID-2263-000000e3
https://www.cisco.com/c/en/us/support/docs/security/identity-services-engine-24/214481-configure-ise-2-4-and-fmc-6-2-3-pxgrid-i.html
https://www.cisco.com/c/en/us/td/docs/security/firepower/60/configuration/guide/fpmc-config-guide-v60/Firepower_System_User_Management.html#ID-2263-00000738
https://www.cisco.com/c/en/us/td/docs/security/firepower/623/configuration/guide/fpmc-config-guide-v623/system_configuration.html#concept_C539C10D4F134323933DCD745F1CD645
https://www.cisco.com/c/en/us/td/docs/security/firepower/60/configuration/guide/fpmc-config-guide-v60/Firepower_System_User_Management.html#ID-2263-000015e9
https://www.cisco.com/c/en/us/td/docs/security/firepower/60/configuration/guide/fpmc-config-guide-v60/Backup_and_Restore.html
https://www.cisco.com/c/en/us/td/docs/security/firepower/60/configuration/guide/fpmc-config-guide-v60/System_Software_Updates.html?bookSearch=true#concept_5835D84A07A84D38B6ED455BE5BAC1DD
https://www.cisco.com/c/en/us/td/docs/security/firepower/620/configuration/guide/fpmc-config-guide-v62/connection_logging.html#ID-2174-00000004
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SM# Question Technical Mechanism or Configuration Refs.
SM Does the platform allow for logging The system can generate logs of the Refl
4.4 connection events to the tool? connection events its managed devices
detect. Connection events include
Security Intelligence events (connections
blocked by the reputation-based Security
Intelligence feature.)
SM Are there training courses in how to use Cisco provides training resources through
5.1 the products? Are there different courses | direct offering, partner, knowledge
for different roles? partners, and on-demand through Cisco
Live.
SM Are there training courses for teaching Cisco provides training resources through
5.2 administrators how to utilize the direct offering, partner, knowledge
platform? partners, and on-demand through Cisco
Live.
SM Are trainings updated and metrics Cisco regularly collects metrics from
5.3 collected to improve trainings? completed user training to make
improvements and updates.
A.2.2 Cisco ISE Support of Security Measures
SM# Question Technical Mechanism or Configuration Refs.
SM Does the software platform allow for the | Certificates from a PIV or CAC can be used | Refl
1.1 use of a two-factor authentication along with soft certificates to
method for access? authenticate admin users.
SM Does the software platform identify and Services using the ISE pxGrid solution to Refl
1.2 authenticate users and machine accounts | gather data from the system or publish
that try to access the platform? require the use of certificates to secure
the communications channel.
SM Does the system allow for creating The Cisco ISE admin console and CLI both | Refl
1.3 accounts with different access levels to support role-based access control.
enforce least management?
SM Does the system allow for the use of Both the admin user interface (Ul) and CLI | Refl
14 DACLs, network segmentation, or can be configured to limit IP access to the
isolation for access to the platform? system.
SM Does the system allow for creating The Cisco ISE admin console and CLI both | Refl
2.2 accounts with different access levels to support role-based access control.
enforce least management?
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https://www.cisco.com/c/en/us/td/docs/security/firepower/620/configuration/guide/fpmc-config-guide-v62/connection_and_security_intelligence_events.html
https://www.cisco.com/c/en/us/support/docs/security/identity-services-engine/215308-configure-certificate-or-smartcard-based.html
https://www.cisco.com/c/en/us/support/docs/security/identity-services-engine/215308-configure-certificate-or-smartcard-based.html
https://community.cisco.com/kxiwq67737/attachments/kxiwq67737/4561-docs-security/5070/1/How-To_89_CA-signed_pxGridISEnode_CAsigned_pxGridclient.pdf
https://www.cisco.com/c/en/us/support/docs/security/identity-services-engine/200891-Understanding-Admin-Access-and-RBAC-Poli.html
https://www.cisco.com/c/en/us/td/docs/security/ise/3-0/admin_guide/b_ISE_admin_3_0/b_ISE_admin_30_overview.html
https://www.cisco.com/c/en/us/support/docs/security/identity-services-engine/200891-Understanding-Admin-Access-and-RBAC-Poli.html
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Question

Technical Mechanism or Configuration

SM | Does the system use or contain an option | Cisco ISE can be configured for Federal Refl
24 to enable the use of NIST-certified Information Processing Standards (FIPS)
cryptographic standards for protecting compliance. In this mode, only the
data in transit? protocols listed here are allowed to be
used for authentication: EAP-TLS, PEAP,
EAP-FAST, and EAP-TTLS.
SM | Does the system support performing Cisco ISE backs up both the configuration | Refl
2.5 regular backups and restorations? and event data to a repository. The
system provides high-availability (HA)
capabilities with redundant service pairs.
SM | Does the platform allow for the Cisco ISE provides a centralized patching Refl
3.2 deployment of patches and OS updates? | mechanism through the admin node to
apply patches to all systems that are a
member of the deployment. Patches are
rollups, so administrators do not have to
install multiple patches. Patches include
vulnerability fixes and bug fixes.
SM | Does the platform allow for configuration | Cisco ISE allows administrators to turn on | Refl
3.3 management practices such as removal and off features and functions. Cisco ISE
or disabling of services to maintain does not allow access to the underlying
security? 0S, so services are only enabled and
disabled based on the packages needed to
support the enabled services.
SM | Does the security tool support logging Log events for the following categories Refl
4.1 and sending that data to rsyslog or a are sent by all nodes in the deployment to
SIEM? the logging targets: Administrative and
Operational Audit, System Diagnostics,
and System Statistics.
SM | Does the platform allow for logging The web interface can specify remote Refl
4.4 connection events to the tool? syslog server targets to which system log
messages are sent. Log messages are sent
to the remote syslog server targets in
accordance with the syslog protocol
standard (RFC 3164).
SM | Are there training courses in how to use Cisco provides training resources through
5.1 the products? Are there different courses | direct offering, partner, knowledge
for different roles? partners, and on-demand through Cisco
Live.
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https://www.cisco.com/c/en/us/support/docs/security/identity-services-engine/200535-FIPS-Mode-on-ISE.html
https://www.cisco.com/c/en/us/td/docs/security/ise/2-7/admin_guide/b_ise_27_admin_guide/b_ISE_admin_27_maintain_monitor.html#ID111
https://www.cisco.com/c/en/us/support/docs/security/identity-services-engine/215406-patch-installation-on-ise-and-faq-durin.html
https://www.cisco.com/c/en/us/td/docs/security/ise/2-7/admin_guide/b_ise_27_admin_guide/b_ISE_admin_27_deployment.html#reference_9414B4B3040B4071947D3FA6B865924F
https://www.cisco.com/c/en/us/td/docs/security/ise/3-0/admin_guide/b_ISE_admin_3_0/b_ISE_admin_30_maintain_monitor.html#ID58
https://www.cisco.com/c/en/us/td/docs/security/ise/3-0/admin_guide/b_ISE_admin_3_0/b_ISE_admin_30_maintain_monitor.html#ID58
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SM# Question

Technical Mechanism or Configuration

Refs.

SM | Are there training courses for teaching Cisco provides training resources through
5.2 administrators how to utilize the direct offering, partner, knowledge
platform? partners, and on-demand through Cisco
Live.
SM_ | Are trainings updated and metrics Cisco regularly collects metrics from
5.3 collected to improve trainings? completed user training to make

improvements and updates.

A.2.3 Eclypsium Administration and Analytics Service Support of Security

All entries in this table have the same two references: the Eclypsium-supplied Solution Guide and

Measures

Deployment Guide. The Solution Guide is built into the product, and Eclypsium provides the Deployment
Guide at purchase, so it was not possible to provide hyperlinks for this table.

SM# Question Technical Mechanism or Configuration Refs.
SM Does the software platform allow for the | Eclypsium integrates with multiple
1.1 use of a two-factor authentication authentication mechanisms, many of
method for access? which support multi-factor authentication
(MFA).
SM Does the software platform identify and Unique application programming
1.2 authenticate users and machine accounts | interface (API) tokens are managed by
that try to access the platform? Eclypsium administrators.
SM Does the system allow for creating The Eclypsium platform contains
1.3 accounts with different access levels to Admin/User access roles. Only
enforce least management? administrators can change systemwide
analysis policies.
SM Does the system allow for the use of The Linux OS hosting Eclypsium can be
14 DACLs, network segmentation, or configured to allow for the creation of
isolation for access to the platform? network-based access restrictions.
SM Does the system allow for creating The Eclypsium platform contains
2.2 accounts with different access levels to Admin/User access roles. Only
enforce least management? administrators can change systemwide
analysis policies.
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https://docs.microsoft.com/en-us/mem/configmgr/core/servers/manage/list-of-reports#status-messages---audit
https://docs.microsoft.com/en-us/mem/configmgr/core/servers/manage/list-of-reports#status-messages---audit
https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/hierarchy/ports
https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/hierarchy/ports
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Question

Technical Mechanism or Configuration

SM | Does the system use or contain an option | The data-at-rest encryption
2.3 to enable the use of NIST-certified implementation is done as part of the
cryptographic standards for protecting backend platform onto which Eclypsium is
data at rest? deployed. In the cloud, the provider's key
management system may be used. In an
on-premises deployment, the OS or
hardware-based encryption on the
physical servers may be used.
SM | Does the system use or contain an option | All communications occur over Transport
2.4 to enable the use of NIST-certified Layer Security (TLS). FIPS mode can be
cryptographic standards for protecting enabled and utilized where desired.
data in transit?
SM | Does the system support performing Backups of the Eclypsium backend are
2.5 regular backups and restorations? performed as part of the platform onto
which it is deployed. Standard
mechanisms for Linux server
backup/restore will operate normally.
SM | Does the product list all software This information is in the Solution Guide.
3.1 dependencies and currently installed When scanning firmware on target
applications/services? systems, similar information may be
inferred from binary analysis.
SM | Does the platform allow for the The cloud version is managed by
3.2 deployment of patches and OS updates? | Eclypsium to provide updates. The on-
premises version is the responsibility of
the customer. The OS can be configured
to perform updates. On target systems,
Eclypsium will indicate whether firmware
is up to date.
SM | Does the platform allow for configuration | Eclypsium directly manages the
3.3 management practices such as removal configuration of cloud deployments. In an
or disabling of services to maintain on-premises environment, configuration
security? management becomes the responsibility
of the customer. Normal configuration
management for Linux servers will apply
to the Eclypsium backend.
SM | Does the security tool support logging In most instances, syslog is integrated
4.1 and sending that data to rsyslog or a with SIEM tools. Eclypsium alerts for

SIEM?

target systems are forwarded over syslog
to such tools when configured.
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SM# Question

Technical Mechanism or Configuration Refs.

SM | Does the platform monitor the security There is an audit trail of users who have
4.2 and vulnerabilities associated with all logged in and the actions they performed.
software and dependencies used? Updates are also sent out to help

remediate software running on the
platform.
SM | Is anti-malware or antivirus able to be Eclypsium scanners and the Eclypsium
4.3 installed on the system running your backend are compatible with running
platform? other endpoint security software on the
same device.
SM | Does the platform allow for logging In cloud deployments, Eclypsium manages
4.4 connection events to the tool? network security protections. In an on-
premises deployment, this would be
inherited from the environment into
which Eclypsium is deployed.
SM | Are there training courses or procedures | Eclypsium security operations personnel
4.5 in the event of an incident involving the receive security and incident response
tool or platform? training. Customer training is available
from Eclypsium to cover firmware security
and incident response scenarios.
SM | Are there training courses in how to use Eclypsium has the latest training catalog.
5.1 the products? Are there different courses
for different roles?
SM | Are there training courses for teaching Eclypsium has the latest training catalog.
5.2 administrators how to utilize the
platform?
SM | Are trainings updated and metrics Eclypsium has the latest training catalog.
5.3 collected to improve trainings?

A.2.4 Forescout Platform Support of Security Measures

SM
11

Question

Does the software platform allow for the
use of a two-factor authentication
method for access?

Technical Mechanism or Configuration Refs.

The Forescout platform's integration with | Refl
PIV and Homeland Security Presidential

Directive 12 (HSPD-12) cards allows for

this capability.
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https://docs.microsoft.com/en-us/mem/configmgr/sum/deploy-use/monitor-software-updates
https://docs.microsoft.com/en-us/mem/configmgr/sum/deploy-use/monitor-software-updates
https://docs.microsoft.com/en-us/troubleshoot/mem/configmgr/recommended-antivirus-exclusions
https://docs.microsoft.com/en-us/troubleshoot/mem/configmgr/recommended-antivirus-exclusions
https://docs.microsoft.com/en-us/learn
https://docs.microsoft.com/en-us/learn
https://docs.microsoft.com/en-us/learn
https://docs.microsoft.com/en-us/learn
https://docs.forescout.com/bundle/admin-guide-8-2-1/page/admin-guide-8-2-1.Using-Smart-Card-Authentication.html
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Question Technical Mechanism or Configuration
SM Does the system allow for creating The Forescout platform supports a range Refl
1.3 accounts with different access levels to of accounts with different access levels as
enforce least management? required to support least privilege.
SM Does the system allow for the use of Forescout supports the use of DACLs, Refl
14 DACLs, network segmentation, or virtual local area network (VLAN)
isolation for access to the platform? assignment, and any other network-based
control offered by the network devices in
use for device isolation as needed.
SM Does the software list and maintain an This is enabled via Forescout's native Refl
2.1 inventory of all software criticalities and policy.
integrations?
SM Does the system allow for creating The Forescout platform supports a range Refl
2.2 accounts with different access levels to of accounts with different access levels as
enforce least management? required to support least privilege.
SM Does the system use or contain an option | Forescout natively encrypts the data at Refl
2.3 to enable the use of NIST-certified rest on the hard drives but can also verify
cryptographic standards for protecting and establish the encryption level of
data at rest? managed endpoints.
SM Does the system support performing Forescout supports backup/restore of Refl
2.5 regular backups and restorations? data and configurations of all appliances.
SM Does the product list all software Forescout can identify applications and
3.1 dependencies and currently installed services that are installed and/or running
applications/services? on Windows, Linux, and macOS. Remote
inspection capabilities are enabled either
by integration with AD (LDAP) or via an
agent (Secure Connector). This in turn can
be enhanced by creating Forescout
security policies to identify all software
with enhanced privileges and known
CVEs.
SM Does the platform allow for the Forescout integrates with a variety of Refl
3.2 deployment of patches and OS updates? | patch and OS management tools.
Forescout has native remediations via
scripting on endpoints via policy.
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https://www.forescout.com/resources/modern-nac-whitepaper/
https://www.forescout.com/products/eyesegment/
https://docs.forescout.com/bundle/admin-guide-8-2-2/page/admin-guide-8-2-2.Policy-Management.html
https://www.forescout.com/resources/modern-nac-whitepaper/
https://docs.forescout.com/bundle/install-guide-8-2-2/page/install-guide-8-2-2.Installation-Overview.html
https://docs.forescout.com/bundle/install-guide-8-2-2/page/install-guide-8-2-2.Restore-Enterprise-Manager-System-Settings.html
https://www.forescout.com/products/eyeextend/
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Question

Technical Mechanism or Configuration

SM | Does the platform allow for configuration | Forescout can perform control actions Refl
3.3 management practices such as removal against any managed endpoint. Services
or disabling of services to maintain as a property are an attribute detected
security? running/installed on the endpoint. These
attributes (services) can in turn can be
stopped/started or removed as required
via policy.
SM | Does the security tool support logging The Forescout platform sends rich device | Refl
4.1 and sending that data to rsyslog or a context information to a SIEM system for | Ref2
SIEM? logging and event analysis. -
SM | Does the platform monitor the security Forescout supports a default Windows Refl
4.2 and vulnerabilities associated with all Vulnerability CVE/Patch plugin (published
software and dependencies used? by Microsoft) to actively scan all Windows
clients/servers in real time via policy. The
Forescout platform also provides Security
Policy Templates (SPT) covering zero-day
information and assesses software and
hardware for these issues. SPT includes
vulnerability and response templates with
relevant data for vulnerabilities as
documented by Forescout security labs.
SM | Does the platform allow for logging All successful and failed connections to Refl
4.4 connection events to the tool? the Forescout platform are logged in
system event logs. Administrators can
view these logs. An option is also available
to forward event messages to third-party
logging systems via syslog.
SM | Are there training courses in how to use Forescout offers training and Refl
5.1 the products? Are there different courses | certifications for administrators.
for different roles?
SM | Are there training courses for teaching Forescout offers training and Refl
5.2 administrators how to utilize the certifications for engineers.
platform?
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https://www.forescout.com/resources/forescout-eyecontrol-datasheet/
https://docs.forescout.com/bundle/splunk-3.0-h/page/splunk-3.0-h.Create-a-Send-Endpoint-and-Policy-Details-to-Spl.html
https://www.forescout.com/resources/splunk-extended-module-datasheet/
https://docs.forescout.com/bundle/spt-content-h/page/spt-content-h.c-policy-templates-in-the-security-pol-d1e499.html
https://www.forescout.com/products/eyesegment/
https://www.forescout.com/wp-content/uploads/2017/05/FS-DS-FSCA_Training-and-Certification.pdf
https://www.forescout.com/resources/fsce-training-datasheet
https://www.forescout.com/resources/fsce-training-datasheet
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A.2.5 IBM Code Risk Analyzer Support of Security Measures

SM# Question Technical Mechanism or Configuration Refs.
SM Does the software platform allow for the | It leverages the IBM Cloud authentication
1.1 use of a two-factor authentication mechanism, which provides multi-factor
method for access? authentication for all users and
administrators.
SM Does the software platform identify and All users and machines are identified
1.2 authenticate users and machine accounts | using the Identity and Access
that try to access the platform? Management feature of IBM Cloud.
SM Does the system allow for creating Accounts can be created and assigned to
1.3 accounts with different access levels to appropriate roles that have different
enforce least management? access levels. This functionality is
provided by the Identify and Access
Management feature of IBM Cloud.
SM Does the system allow for the use of Network segmentation and isolation is
14 DACLs, network segmentation, or done by using Kubernetes clusters and
isolation for access to the platform? Istio as the service mesh. Strict policies
exist for egress and ingress.
SM Does the software list and maintain an The software keeps a bill of materials for
2.1 inventory of all software criticalities and each component. This bill of materials
integrations? contains a full list of third-party
dependencies. Integration is allowed with
only IBM-authorized software.
SM Does the system allow for creating This feature is achieved by using the
2.2 accounts with different access levels to Identity and Access Management (IAM)
enforce least management? feature of IBM Cloud. IAM has
comprehensive features for granular
access for users, administrators, and
machines.
SM Does the system use or contain an option | All data at rest, whether in databases or
2.3 to enable the use of NIST-certified file systems, is encrypted using NIST-
cryptographic standards for protecting certified cryptographic standards.
data at rest?
SM Does the system use or contain an option | All data in transit is encrypted using NIST-
24 to enable the use of NIST-certified certified cryptographic standards. This
cryptographic standards for protecting includes data that is flowing between
data in transit? microservices inside a cluster.
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https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/security/plan-for-security#sms-provider-authentication
https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/security/plan-for-security#sms-provider-authentication
https://docs.microsoft.com/en-us/mem/configmgr/core/servers/manage/list-of-reports#status-messages---audit
https://docs.microsoft.com/en-us/mem/configmgr/core/servers/manage/list-of-reports#status-messages---audit
https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/hierarchy/ports
https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/hierarchy/ports
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Question

Technical Mechanism or Configuration

Refs.

SM | Does the system support performing The system data is backed up regularly for
2.5 regular backups and restorations? offsite storage. Disaster recovery
procedures are reviewed and tested
regularly by IBM engineers.
SM | Does the product list all software A bill of materials is created for each
3.1 dependencies and currently installed microservice. Integrations with databases
applications/services? and other systems are tracked. Change
management is rigorously followed.
SM | Does the platform allow for the The OS, middleware, and application
3.2 deployment of patches and OS updates? | components are regularly patched using
automated pipelines. These components
are scanned for any vulnerabilities and
patches are deployed within strict
timeframes.
SM | Does the platform allow for configuration | The system is configured and deployed
3.3 management practices such as removal using various standard techniques such as
or disabling of services to maintain Kubernetes Helm charts and YAML files.
security? The service can be disabled in all regions
within minutes by disabling DNS entries,
reverse proxies, etc.
SM | Does the security tool support logging Syslog data is streamed to centralized
4.1 and sending that data to rsyslog or a logging mechanisms. The security events
SIEM? data is also made available to clients using
the Activity Tracker mechanism.
SM | Does the platform monitor the security Continuous monitoring for security is
4.2 and vulnerabilities associated with all accomplished by using firewalls and
software and dependencies used? service mesh.
SM | Is anti-malware or antivirus able to be All systems running the system have anti-
4.3 installed on the system running your malware software running on them.
platform? Comprehensive reports are generated to
ensure compliance.
SM | Does the platform allow for logging All successful and unsuccessful
4.4 connection events to the tool? connections are logged in the Activity

Tracker and in the Identity and Access
Management system of IBM Cloud.
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https://docs.microsoft.com/en-us/mem/configmgr/sum/deploy-use/monitor-software-updates
https://docs.microsoft.com/en-us/mem/configmgr/sum/deploy-use/monitor-software-updates
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SM# Question Technical Mechanism or Configuration Refs.
SM Are there training courses or procedures Process documentation, runbooks,
45 in the event of an incident involving the training, and technology are in place to
tool or platform? respond to incidents in a timely manner.
High-severity incidents are tracked at
executive levels. Root-cause analysis is
performed and actionable tasks are
documented. Best practices are shared
across all teams in IBM Cloud.
SM Are there training courses in how to use Self-service tutorials are available to users
5.1 the products? Are there different courses | based on their roles. Comprehensive
for different roles? documentation is available as well.
SM Are there training courses for teaching IBM Garage teams host courses for all
5.2 administrators how to utilize the aspects of the IBM Cloud platform.
platform?
SM Are trainings updated and metrics Regular trainings are conducted for all
5.3 collected to improve trainings? developers and administrators who are
responsible for operating the IBM Cloud.
The training materials are revised as new
best practices become available.
A.2.6 1BM MaaS360 with Watson Support of Security Measures
SM# Question Technical Mechanism or Configuration Refs.
SM Does the software platform identify and | Connections to IBM MaaS360 are Refl
1.2 authenticate users and machine authenticated with API keys or credentials.
accounts that try to access the
platform?
SM Does the system allow for creating In the MaaS360 admin console, roles can Refl
1.3 accounts with different access levels to be assigned to each administrator based
enforce least management? on their individual needs.
SM Does the system allow for creating In the MaaS360 admin console, custom Refl
2.2 accounts with different access levels to roles can be defined with granular access
enforce least management? rights.
SM Are there training courses in how to use | IBM MaaS360 offers training courses that Refl
5.1 the products? Are there different are catered to the role an individual will
courses for different roles? hold for utilizing the product.
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https://www.ibm.com/docs/en/maas360?topic=services-auto-provisioning-web
https://www.ibm.com/docs/en/maas360?topic=services-auto-provisioning-web
https://www.ibm.com/docs/en/maas360?topic=administrators-access-roles-rights-portal
https://www.ibm.com/docs/en/maas360?topic=administrators-access-roles-rights-portal
https://www.ibm.com/docs/en/maas360?topic=portal-creating-admin-role-administrators
https://www.securitylearningacademy.com/local/navigator/index.php?level=moma01#roadmapsTab
https://www.securitylearningacademy.com/local/navigator/index.php?level=moma01#roadmapsTab
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SM# Question Technical Mechanism or Configuration Refs.

SM Are there training courses for teaching IBM MaaS360 offers training courses for Refl

5.2 administrators how to utilize the administrative users. Ref2
platform?

SM Are trainings updated and metrics Release Notes are regularly updated with Refl

5.3 collected to improve trainings? new and updated feature information, and

the “MaaS360 Latest” panel provides
videos and tutorials on new and updated
capabilities. Each training course has a star
rating system for effectiveness and
improvement purposes.

A.2.7 Lookout MES Support of Security Measures

Description

Technical Mechanism or Configuration

Refs.

certified cryptographic standards for
protecting data at rest?

SM Does the software platform allow for Organizations can integrate their existing

1.1 the use of a two-factor authentication Security Assertion Markup Language
method for access? (SAML) 2.0 MFA solutions for authorization

purposes into the Lookout MES Console.

SM Does the software platform identify and | Lookout identifies and authenticates each

1.2 authenticate users and machine user or machine account that attempts to
accounts that try to access the access the platform. Audit logs also collect
platform? actions taken by each account.

SM Does the system allow for creating Lookout allows for the creation of several

1.3 accounts with different access levels to administrative types with decreasing levels
enforce least management? of access.

SM Does the software list and maintain an The Lookout MES Console provides a full

2.1 inventory of all software criticalities and | application inventory list of all devices
integrations? within the customer’s user fleet.

SM Does the system allow for creating Lookout allows for the creation of several

2.2 accounts with different access levels to administrative types with decreasing levels
enforce least management? of access.

SM Does the system use or contain an Data at rest is encrypted using Advanced

2.3 option to enable the use of NIST- Encryption Standard (AES) 256-bit

encryption.
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https://www.securitylearningacademy.com/local/navigator/index.php?level=moma01#roadmapsTab
https://www.securitylearningacademy.com/local/navigator/index.php?level=moma01#roadmapsTab
https://www.securitylearningacademy.com/course/view.php?id=3526
https://www.securitylearningacademy.com/course/view.php?id=3526
https://www.securitylearningacademy.com/course/view.php?id=3526
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Description

Technical Mechanism or Configuration

Refs.

SM | Does the system use or contain an Data in transit is encrypted using TLS
24 option to enable the use of NIST- version 1.2.
certified cryptographic standards for
protecting data in transit?
SM | Does the system support performing Daily backups and snapshots of the
2.5 regular backups and restorations? production environment are taken and
stored via Amazon’s S3 service within
multiple zones and U.S. regions. Regular
integrity checks occur through restorations
occurring multiple times annually. These
restores populate new production
instances which are then verified and
monitored.
SM | Does the product list all software The Lookout MES Console provides a full
3.1 dependencies and currently installed application inventory list of all devices
applications/services? within the customer's user fleet.
SM | Does the platform allow for the Patches to the Lookout MES Console are
3.2 deployment of patches and OS updates? | controlled and maintained by Lookout
backoffice support.
SM | Does the security tool support logging Lookout uses a representational state
4.1 and sending that data to rsyslog or a transfer (REST) API to capture and send all
SIEM? console-related logs (e.g., device changes,
threat information, system audit events) to
SIEMs and syslog readers.
SM | Does the platform monitor the security Lookout is Federal Risk and Authorization
4.2 and vulnerabilities associated with all Management Program (FedRAMP)
software and dependencies used? Moderate and therefore follows strict
patch management controls for patching
our own software.
SM | Does the platform allow for logging Lookout captures connection events to the
4.4 connection events to the tool? tool and activities conducted within the
tool via our auditing capabilities.
SM | Are there training courses or procedures | Internally, Lookout has established
4.5 in the event of an incident involving the | procedures for how to respond to a

tool or platform?

security incident (leak, compromise, etc.).
These procedures follow strict FedRAMP
Moderate policies.
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Description

Are there training courses in how to use
the products? Are there different
courses for different roles?

Technical Mechanism or Configuration

Lookout provides first-touch training and
guidance for using the Lookout MES and
for integration guidance with a customer's
MDM. Additionally, frequently asked
questions (FAQs), integration guides, and
console user guides are available to all
administrators via the Lookout Support
Knowledge portal.

%
<

wu
N

Are there training courses for teaching
administrators how to utilize the
platform?

Lookout provides first-touch training and
guidance for using the Lookout MES and
for integration guidance with a customer's
MDM. Additionally, FAQs, integration
guides, and console user guides are
available to all administrators via the
Lookout Support Knowledge portal.

A.2.8 Microsoft Endpoint Configuration Manager (ECM) Support of Security
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Measures
SM# Question Technical Mechanism or Configuration Refs.
SM Does the software platform allow for the | Access to ECM Site Collections can be Refl
1.1 use of a two-factor authentication restricted via strong authentication. This
method for access? can include MFA and passwordless
options like Windows Hello for Business.
SM Does the software platform identify and ECM natively audits logins and activities Refl
1.2 authenticate users and machine accounts | and can be reported on by utilizing ECM
that try to access the platform? Reports.
SM Does the system allow for creating ECM supports achieving least privilege Refl
1.3 accounts with different access levels to through security roles, scopes, and
enforce least management? collections.
SM Does the system allow for the use of Microsoft provides guidance around the Refl
14 DACLs, network segmentation, or ports and protocols required by ECM.
isolation for access to the platform? Customers can use this to implement
firewalls between services and clients.
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https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/security/plan-for-security#sms-provider-authentication
https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/security/plan-for-security#sms-provider-authentication
https://docs.microsoft.com/en-us/mem/configmgr/core/servers/manage/list-of-reports#status-messages---audit
https://docs.microsoft.com/en-us/mem/configmgr/core/servers/manage/list-of-reports#status-messages---audit
https://docs.microsoft.com/en-us/mem/configmgr/core/understand/fundamentals-of-role-based-administration
https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/hierarchy/ports
https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/hierarchy/ports
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Question Technical Mechanism or Configuration
SM Does the software list and maintain an Configuration Manager uses an in-console | Refl
2.1 inventory of all software criticalities and service method called Updates and
integrations? Servicing. It makes it easy to find and
install recommended updates for your
Configuration Manager infrastructure.
SM Does the system allow for creating ECM supports achieving least privilege Refl
2.2 accounts with different access levels to through security roles, scopes, and
enforce least management? collections.
SM Does the system use or contain an option | ECM supports encryption at rest natively Refl
2.3 to enable the use of NIST-certified and through the use of BitLocker.
cryptographic standards for protecting
data at rest?
SM Does the system use or contain an option | ECM supports encryption for data in Refl
24 to enable the use of NIST-certified transport.
cryptographic standards for protecting
data in transit?
SM Does the system support performing Backup and restore operations are core Refl
2.5 regular backups and restorations? resiliency capabilities in ECM.
SM Does the product list all software ECM lists the software dependencies that | Refl
3.1 dependencies and currently installed are required for the platform to operate
applications/services? on the server in addition to client end
nodes.
SM Does the platform allow for the Configuration Manager uses an in-console | Refl
3.2 deployment of patches and OS updates? | service method called Updates and
Servicing. It makes it easy to find and
install recommended updates for your
Configuration Manager infrastructure.
SM Does the platform allow for configuration | Configuration Manager supports installing | Refl
3.3 management practices such as removal specific roles, for example management
or disabling of services to maintain points, distribution points, and software
security? update points, which contain the services
required to run that service only.
SM Does the security tool support logging Logs are stored in the ECM database, log
4.1 and sending that data to rsyslog or a files, and Windows Event Logs.
SIEM? Implementation guidance is specific to the
capabilities of the SIEM.
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https://docs.microsoft.com/en-us/mem/configmgr/core/servers/manage/updates
https://docs.microsoft.com/en-us/mem/configmgr/core/understand/fundamentals-of-role-based-administration
https://docs.microsoft.com/en-us/windows/security/information-protection/bitlocker/bitlocker-how-to-deploy-on-windows-server
https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/security/cryptographic-controls-technical-reference
https://docs.microsoft.com/en-us/mem/configmgr/core/servers/manage/backup-and-recovery
https://docs.microsoft.com/en-us/mem/configmgr/core/clients/deploy/prerequisites-for-deploying-clients-to-windows-computers
https://docs.microsoft.com/en-us/mem/configmgr/core/servers/manage/updates
https://docs.microsoft.com/en-us/mem/configmgr/core/servers/deploy/start-using
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SM# Question Technical Mechanism or Configuration Refs.
SM Does the platform monitor the security Configuration Manager includes software | Refl
4.2 and vulnerabilities associated with all update monitoring, which can be used to
software and dependencies used? identify vulnerable software on its
infrastructure.
SM Is anti-malware or antivirus able to be Anti-malware and anti-virus solutions can | Refl
4.3 installed on the system running your be installed on the host operating system.
platform? Microsoft recommends allowlisting the
files and processes related to ECM.
SM Does the platform allow for logging Client and management point logging can | Refl
4.4 connection events to the tool? be configured at various levels to meet
customer requirements.
SM Are there training courses in how to use Microsoft offers training courses that are | Refl
5.1 the products? Are there different courses | catered to the role an individual will have
for different roles? for utilizing the product.
SM Are there training courses for teaching Microsoft provides e-learning and Refl
5.2 administrators how to utilize the certification preparation guides for ECM
platform? on the Microsoft Learn portal. Hands-on
or train-the-trainer models are provided
through an implementation partner.
SM Are trainings updated and metrics Courses and certifications are periodically
5.3 collected to improve trainings? updated based on product enhancements

and feedback from customers.

A.2.9 Tenable.sc Support of Security Measures

Question

Technical Mechanism or Configuration

SM Does the software platform allow for the | MFA is achieved through certificate-based | Refl
1.1 use of a two-factor authentication authentication and SAML authentication. | Ref2
method for access?
SM Does the software platform identify and This is default behavior. Connections are Refl
1.2 authenticate users and machine accounts | authenticated with API keys or Ref2
that try to access the platform? credentials, then handled via session
cookie.
SM Does the system allow for creating This is default behavior provided by role- | Refl
1.3 accounts with different access levels to based access control.
enforce least management?
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https://docs.microsoft.com/en-us/mem/configmgr/sum/deploy-use/monitor-software-updates
https://docs.microsoft.com/en-us/mem/configmgr/sum/deploy-use/monitor-software-updates
https://docs.microsoft.com/en-us/troubleshoot/mem/configmgr/recommended-antivirus-exclusions
https://docs.microsoft.com/en-us/troubleshoot/mem/configmgr/recommended-antivirus-exclusions
https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/hierarchy/about-log-files
https://docs.microsoft.com/en-us/learn
https://docs.microsoft.com/en-us/learn
https://docs.microsoft.com/en-us/learn
https://docs.microsoft.com/en-us/learn
https://docs.tenable.com/tenablesc/Content/SSLClientCertAuth.htm
https://docs.tenable.com/tenablesc/Content/SAMLAuthentication.htm
https://docs.tenable.com/tenablesc/Content/UserAccess.htm
https://docs.tenable.com/tenablesc/Content/Login.htm
https://docs.tenable.com/tenablesc/Content/UserRoles.htm
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Question Technical Mechanism or Configuration
SM Does the system allow for the use of Tenable.sc can bind the HTTPS interface Refl
14 DACLs, network segmentation, or to a single IP/network interface card (NIC) | Ref2
isolation for access to the platform? and utilize sideband networks for
management/administration.
SM Does the system allow for creating This is default behavior provided by role- Refl
2.2 accounts with different access levels to based access control.
enforce least management?
SM Does the system use or contain an option | Tenable.sc provides encryption for critical | Refl
2.3 to enable the use of NIST-certified resources (target credentials). For
cryptographic standards for protecting vulnerability data and application
data at rest? configuration information, an external
data-at-rest solution is required.
SM Does the system use or contain an option | This is default behavior. Refl
24 to enable the use of NIST-certified
cryptographic standards for protecting
data in transit?
SM Does the system support performing Tenable supports administrator backup of | Refl
2.5 regular backups and restorations? the opt/sc directory. Backups can be
scripted to run on the host OS.
SM Does the security tool support logging The Tenable.sc application can use the Refl
4.1 and sending that data to rsyslog or a host OS’s syslog implementation to
SIEM? leverage an external syslog or SIEM.
SM Does the platform monitor the security Tenable.sc can scan an environment Refl
4.2 and vulnerabilities associated with all passively (with the use of Nessus Network | Ref2
software and dependencies used? Monitor/NNM) and actively to achieve
continuous monitoring.

SM Is anti-malware or antivirus able to be Anti-malware and anti-virus solutions can | Refl
4.3 installed on the system running your be installed. Tenable recommends Ref2
platform? allowlisting the files and processes related

to Nessus and Tenable.sc.
SM Does the platform allow for logging NNM not only does passive analysis for Refl
4.4 connection events to the tool? vulnerabilities, but it can also provide
logging of connection events as
Informational events.
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https://docs.tenable.com/tenablesc/Content/SystemRequirements.htm#Secure
https://docs.tenable.com/tenablesc/Content/ConfigurationSettings.htm
https://docs.tenable.com/tenablesc/lg/Content/AccessControl.htm
https://docs.tenable.com/tenablesc/Content/EncryptionStrength.htm
https://docs.tenable.com/tenablesc/Content/EncryptionStrength.htm
https://docs.tenable.com/tenablesc/Content/Backup.htm
https://docs.tenable.com/tenablesc/Content/ConfigurationSettings.htm
https://docs.tenable.com/tenablesc/Content/ActiveScanObjects.htm
https://docs.tenable.com/nnm/Content/GetStarted.htm
https://docs.tenable.com/nessus/Content/Whitelist.htm
https://docs.tenable.com/nessusagent/Content/Whitelist.htm
https://docs.tenable.com/nnm/Content/ConnectionsSection.htm
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SM# Question Technical Mechanism or Configuration Refs.
SM Are there training courses or procedures | Tenable has many training options Refl
45 in the event of an incident involving the available to customers of our products, Ref2
tool or platform? including instructional videos, free Ref3
trainings, and paid trainings for deeper
dives and larger groups.
SM Are there training courses in how to use Tenable offers training courses that are Refl
5.1 the products? Are there different courses | catered to the role an individual will have | Ref2
for different roles? utilizing the product. Ref3
SM Are there training courses for teaching Tenable offers training courses for Refl
5.2 administrators how to utilize the administrative users. Ref2
platform? Ref3
SM Are trainings updated and metrics Tenable continually collects feedback and
5.3 collected to improve trainings? introduces changes based on product
updates and user feedback.
A.2.10 VMware vRealize Automation SaltStack Config Support of Security
Measures
SM# Question Technical Mechanism or Configuration Refs.
SM Does the software platform identify and This can be set up in the SaltStack Config Refl
1.2 authenticate users and machine accounts | component or done through integration
that try to access the platform? with LDAP, AD, SAML, or OpenID Connect
(OIDC) providers.
SM Does the system allow for creating This can be set up in SaltStack Config or Refl
1.3 accounts with different access levels to done through integration with LDAP, AD,
enforce least management? SAML, or OIDC providers.
SM Does the system allow for the use of The Linux OS hosting SaltStack Config can
1.4 DACLs, network segmentation, or be configured to perform network
isolation for access to the platform? isolation.
SM Does the software list and maintain an VMware tracks each product used by
2.1 inventory of all software criticalities and SaltStack Config and any updates and
integrations? vulnerabilities in those products.
SM Does the system allow for creating This can be set up in SaltStack Config or Refl
2.2 accounts with different access levels to done through integration with LDAP, AD,
enforce least management? SAML, or OIDC providers.
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https://www.tenable.com/education
https://www.youtube.com/channel/UCX_67IPEhqyYF9ppVRAcAwQ
https://university.tenable.com/
https://www.tenable.com/education
https://www.youtube.com/channel/UCX_67IPEhqyYF9ppVRAcAwQ
https://university.tenable.com/
https://www.tenable.com/education
https://www.youtube.com/channel/UCX_67IPEhqyYF9ppVRAcAwQ
https://university.tenable.com/
https://docs.vmware.com/en/VMware-vRealize-Automation-SaltStack-Config/8.4/use-manage-saltstack-config/GUID-C1A1C754-E8E3-4C70-9DB1-0558576549A8.html
https://docs.vmware.com/en/VMware-vRealize-Automation-SaltStack-Config/8.4/use-manage-saltstack-config/GUID-C1A1C754-E8E3-4C70-9DB1-0558576549A8.html
https://docs.vmware.com/en/VMware-vRealize-Automation-SaltStack-Config/8.4/use-manage-saltstack-config/GUID-C1A1C754-E8E3-4C70-9DB1-0558576549A8.html
https://docs.vmware.com/en/VMware-vRealize-Automation-SaltStack-Config/8.4/use-manage-saltstack-config/GUID-C1A1C754-E8E3-4C70-9DB1-0558576549A8.html
https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/hierarchy/ports
https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/hierarchy/ports
https://docs.vmware.com/en/VMware-vRealize-Automation-SaltStack-Config/8.4/use-manage-saltstack-config/GUID-C1A1C754-E8E3-4C70-9DB1-0558576549A8.html
https://docs.vmware.com/en/VMware-vRealize-Automation-SaltStack-Config/8.4/use-manage-saltstack-config/GUID-C1A1C754-E8E3-4C70-9DB1-0558576549A8.html
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Question Technical Mechanism or Configuration
SM Does the system use or contain an option | SaltStack Config has a FIPS-compliant Refl
2.3 to enable the use of NIST-certified mode that can be configured at
cryptographic standards for protecting installation time to support encryption of
data at rest? data at rest.
SM Does the system use or contain an option | SaltStack Config supports encryption for
2.4 to enable the use of NIST-certified data in transit by default. Key generation
cryptographic standards for protecting uses standard algorithms found in the
data in transit? OpenSSL library. These algorithms rely on
OS-generated random seed data.
SM Does the system support performing SaltStack Config allows administrators to Refl
2.5 regular backups and restorations? perform manual backups.
SM Does the product list all software SaltStack provides a list of all dependent
3.1 dependencies and currently installed software and libraries used within the
applications/services? product.
SM Does the platform allow for the The Linux system hosting SaltStack can be | Refl
3.2 deployment of patches and OS updates? | updated by administrators. The SaltStack
SecOps component can be utilized to
perform updates on SaltStack nodes and
client end nodes.
SM Does the platform allow for configuration | SaltStack Config allows for configuration Refl
3.3 management practices such as removal management through the implementation
or disabling of services to maintain of Salt states, the beacon and reactor
security? system, and/or orchestration.
SM Does the security tool support logging Salt returners can be used/configured to Refl
4.1 and sending that data to rsyslog or a send logs to third-party tools like rsyslog
SIEM? and Splunk.
SM Does the platform monitor the security VMware tracks each product used by
4.2 and vulnerabilities associated with all SaltStack Config and tracks any updates
software and dependencies used? and vulnerabilities that are announced by
the product owners.
SM Is anti-malware or antivirus able to be Anti-malware and anti-virus solutions can
4.3 installed on the system running your be installed on the host Linux OS.
platform?
SM Does the platform allow for logging You can set the logging level to debug or Refl
4.4 connection events to the tool? turn on the audit trail, and that will
provide connection events.
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https://docs.vmware.com/en/VMware-vRealize-Automation-SaltStack-Config/8.4/install-configure-saltstack-config/GUID-D3B8A6AF-6F1A-409D-872C-8F96EDADBD73.html?hWord=N4IghgNiBcIGIEkAKBnABAWQPYBMCmIAvkA
https://docs.vmware.com/en/VMware-vRealize-Automation-SaltStack-Config/8.4/install-configure-saltstack-config/GUID-984CCC14-4511-494F-86B6-F257579B57A4.html
https://docs.vmware.com/en/VMware-vRealize-Automation-SaltStack-Config/8.4/use-manage-saltstack-config/GUID-02DF1763-BC06-4454-BCE3-D9C3336DA6B0.html
https://docs.vmware.com/en/VMware-vRealize-Automation-SaltStack-Config/8.4/use-manage-saltstack-config/GUID-96A02EE1-CD8D-4641-8048-A1E25DBAC4D5.html
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SM# Question Technical Mechanism or Configuration Refs.
SM Are there training courses or procedures | There is official training for customers of Refl
45 in the event of an incident involving the the platform. Also, support contracts can
tool or platform? be purchased to help troubleshoot and fix
incidents with the product.
SM Are there training courses in how to use VMware provides training on the Refl
5.1 the products? Are there different courses | underlying platform (SaltStack Config and
for different roles? vRealize Automation) as well as the
security operations product.
SM Are there training courses for teaching VMware provides training on the Refl
5.2 administrators how to utilize the underlying platform (SaltStack Config and
platform? vRealize Automation) as well as the
security operations product.
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CVE
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FIPS
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Active Directory

Advanced Encryption Standard

Adaptive Network Control

Application Programming Interface

Basic Input/Output System
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Command-Line Interface

Cooperative Research and Development Agreement
Common Vulnerabilities and Exposures
Common Vulnerability Scoring System
Discretionary Access Control List

Dynamic Host Configuration Protocol
Domain Name System

(Microsoft) Endpoint Configuration Manager
Enterprise Mobility Management

Executive Order

Frequently Asked Questions

Federal Risk and Authorization Management Program
Federal Information Processing Standards
(Cisco) Firepower Management Center
(Cisco) Firepower Threat Defense

High Availability
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(Microsoft) System Center Configuration Manager
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Windows as a Service
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Certain commercial entities, equipment, products, or materials may be identified by name or company
logo or other insignia in order to acknowledge their participation in this collaboration or to describe an
experimental procedure or concept adequately. Such identification is not intended to imply special sta-
tus or relationship with NIST or recommendation or endorsement by NIST or NCCoE; neither is it in-
tended to imply that the entities, equipment, products, or materials are necessarily the best available
for the purpose.

While NIST and the NCCoE address goals of improving management of cybersecurity and privacy risk
through outreach and application of standards and best practices, it is the stakeholder’s responsibility to
fully perform a risk assessment to include the current threat, vulnerabilities, likelihood of a compromise,
and the impact should the threat be realized before adopting cybersecurity measures such as this
recommendation.

National Institute of Standards and Technology Special Publication 1800-31C, Natl. Inst. Stand. Technol.
Spec. Publ. 1800-31C, 128 pages, (April 2022), CODEN: NSPUE2

As a private-public partnership, we are always seeking feedback on our practice guides. We are
particularly interested in seeing how businesses apply NCCoE reference designs in the real world. If you
have implemented the reference design, or have questions about applying it in your environment,
please email us at cyberhygiene@nist.gov.

All comments are subject to release under the Freedom of Information Act.

National Cybersecurity Center of Excellence
National Institute of Standards and Technology
100 Bureau Drive
Mailstop 2002
Gaithersburg, MD 20899

Email: nccoe@nist.gov

NIST SP 1800-31C: Improving Enterprise Patching for General IT Systems


mailto:cyberhygiene@nist.gov
mailto:nccoe@nist.gov

"T€-008T°dS LSIN/8209°0T/840°'10p//:sd1Y :woly 981eYd Jo 9244 d|qe|ieAe s| uolealjgnd sy

The National Cybersecurity Center of Excellence (NCCoE), a part of the National Institute of Standards
and Technology (NIST), is a collaborative hub where industry organizations, government agencies, and
academic institutions work together to address businesses’ most pressing cybersecurity issues. This
public-private partnership enables the creation of practical cybersecurity solutions for specific
industries, as well as for broad, cross-sector technology challenges. Through consortia under
Cooperative Research and Development Agreements (CRADAs), including technology partners—from
Fortune 50 market leaders to smaller companies specializing in information technology security—the
NCCoE applies standards and best practices to develop modular, adaptable example cybersecurity
solutions using commercially available technology. The NCCoE documents these example solutions in
the NIST Special Publication (SP) 1800 series, which maps capabilities to the NIST Cybersecurity
Framework and details the steps needed for another entity to re-create the example solution. The
NCCoE was established in 2012 by NIST in partnership with the State of Maryland and Montgomery
County, Maryland.

To learn more about the NCCoE, visit https://www.nccoe.nist.gov/. To learn more about NIST, visit
https://www.nist.gov.

NIST Cybersecurity Practice Guides (Special Publication 1800 series) target specific cybersecurity
challenges in the public and private sectors. They are practical, user-friendly guides that facilitate the
adoption of standards-based approaches to cybersecurity. They show members of the information
security community how to implement example solutions that help them align with relevant standards
and best practices, and provide users with the materials lists, configuration files, and other information
they need to implement a similar approach.

The documents in this series describe example implementations of cybersecurity practices that
businesses and other organizations may voluntarily adopt. These documents do not describe regulations
or mandatory practices, nor do they carry statutory authority.

Despite widespread recognition that patching is effective and attackers regularly exploit unpatched
software, many organizations do not adequately patch. There are myriad reasons why, not the least of
which are that it’s resource-intensive and that the act of patching can reduce system and service
availability. Also, many organizations struggle to prioritize patches, test patches before deployment, and
adhere to policies for how quickly patches are applied in different situations. To address these
challenges, the NCCoE collaborated with cybersecurity technology providers to develop an example
solution that addresses these challenges. This NIST Cybersecurity Practice Guide explains how tools can
be used to implement the patching and inventory capabilities organizations need to handle both routine
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and emergency patching situations, as well as implement temporary mitigations, isolation methods, or
other alternatives to patching. It also explains recommended security practices for patch management
systems themselves.

KEYWORDS

cyber hygiene; enterprise patch management; firmware; patch; patch management; software; update;
upgrade; vulnerability management
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DOCUMENT CONVENTIONS

The terms “shall” and “shall not” indicate requirements to be followed strictly to conform to the
publication and from which no deviation is permitted. The terms “should” and “should not” indicate that
among several possibilities, one is recommended as particularly suitable without mentioning or
excluding others, or that a certain course of action is preferred but not necessarily required, or that (in
the negative form) a certain possibility or course of action is discouraged but not prohibited. The terms
“may” and “need not” indicate a course of action permissible within the limits of the publication. The
terms “can” and “cannot” indicate a possibility and capability, whether material, physical, or causal.

PATENT DISCLOSURE NOTICE

NOTICE: The Information Technology Laboratory (ITL) has requested that holders of patent claims whose
use may be required for compliance with the guidance or requirements of this publication disclose such
patent claims to ITL. However, holders of patents are not obligated to respond to ITL calls for patents and
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ITL has not undertaken a patent search in order to identify which, if any, patents may apply to this
publication.

As of the date of publication and following call(s) for the identification of patent claims whose use may
be required for compliance with the guidance or requirements of this publication, no such patent claims
have been identified to ITL.

No representation is made or implied by ITL that licenses are not required to avoid patent infringement in
the use of this publication.
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The National Cybersecurity Center of Excellence (NCCoE) at the National Institute of Standards and
Technology (NIST) built an example solution in a laboratory environment to demonstrate how
organizations can use technologies to improve enterprise patch management for their general
information technology (IT) assets.

This volume of the practice guide shows IT professionals and security engineers how we have
implemented the example solution. It covers all the products employed in this reference design,
summarizes their integration into the laboratory environment, and documents security decisions and
associated configurations. We do not re-create the product manufacturers’ documentation, which is
presumed to be widely available. Rather, these volumes show how we incorporated the products
together in our environment.

This draft covers both phases of the example solution. Phase 1 involved two types of IT assets: desktop
and laptop computers, and on-premises servers. Phase 2 added mobile devices and containers.

Note: These are not comprehensive tutorials. There are many possible service and security configurations
for these products that are out of scope for this example implementation.

1.1 How to Use this Guide

This NIST Cybersecurity Practice Guide demonstrates a standards-based example solution and provides
users with the information they need to replicate the proposed approach for improving enterprise
patching practices for general IT systems. This design is modular and can be deployed in whole or in
part.

This guide contains three volumes:

= NIST Special Publication (SP) 1800-31A: Executive Summary — why we wrote this guide, the
challenge we address, why it could be important to your organization, and our approach to
solving the challenge

= NIST SP 1800-31B: Security Risks and Capabilities — why we built the example implementation,
including the risk analysis performed and the security capabilities provided by the
implementation

= NIST SP 1800-31C: How-To Guides — what we built, with instructions for building the example
implementation, including all the details that would allow you to replicate all or parts of this
project (you are here)

Depending on your role in your organization, you might use this guide in different ways:

Business decision makers, including chief security and technology officers, will be interested in the
Executive Summary, NIST SP 1800-31A, which describes the following topics:

NIST SP 1800-31C: Improving Enterprise Patching for General IT Systems 1
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= challenges that enterprises face in mitigating risk from software vulnerabilities
= example solution built at the NCCoE
= benefits of adopting the example solution

Business decision makers can also use NIST SP 800-40 Revision 4, Guide to Enterprise Patch Management
Planning: Preventive Maintenance for Technology. It complements the implementation focus of this
guide by recommending creation of an enterprise strategy to simplify and operationalize patching while
also reducing risk.

Technology or security program managers who are concerned with how to identify, understand, assess,
and mitigate risk will be interested in NIST SP 1800-31B, which describes what we did and why. The
following sections will be of particular interest:

= Section 3.5.1, Threats, Vulnerabilities, and Risks, describes the risk analysis we performed.

= Section 3.5.2, Security Control Map, maps the security characteristics of this example solution
to cybersecurity standards and best practices.

You might share the Executive Summary, NIST SP 1800-31A, with your leadership team members to help
them understand the importance of adopting standards-based, automated patch management. Also,
NIST SP 800-40 Revision 4, Guide to Enterprise Patch Management Planning: Preventive Maintenance for
Technology may also be helpful to you and your leadership team.

IT professionals who may be interested in implementing an approach similar to ours will find the entire
practice guide useful. In particular the How-To portion of the guide, NIST SP 1800-31C, could be used to
replicate all or parts of the build created in our lab. Furthermore, the How-To portion of the guide
provides specific product installation, configuration, and integration instructions for implementing the
example solution. We have omitted the general installation and configuration steps outlined in
manufacturers’ product documentation since they are typically made available by manufacturers.
Instead, we focused on describing how we incorporated the products together in our environment to
create the example solution.

This guide assumes that the reader of this document is a seasoned IT professional with experience in
implementing security solutions within an enterprise setting. While we have used a suite of commercial
and open-source products to address this challenge, this guide does not endorse these particular
products. Your organization can adopt this solution or one that adheres to these guidelines in whole, or
you can use this guide as a starting point for tailoring and implementing parts of an automated
enterprise patch management system. Your organization’s security experts should identify the products
that will best integrate with your existing tools and IT system infrastructure. We hope that you will seek
products that are congruent with applicable standards and recommended practices. The Technologies
section of NIST SP 1800-31B lists the products we used and maps them to the cybersecurity controls
provided by this example solution.
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A NIST Cybersecurity Practice Guide does not describe “the” solution, but an example solution. This is a
draft guide. We seek feedback on the contents of this guide and welcome your input. Comments,
suggestions, and success stories will improve subsequent versions of this guide. Please contribute your
thoughts to cyberhygiene @nist.gov.

1.2 Build Overview

This NIST Cybersecurity Practice Guide addresses the use of commercially available technologies to
develop an example implementation for deploying an automated patch management system. This
project focuses on enterprise patch management for small to large enterprises. The example solution
demonstrates how to manage assets to reduce outages, improve security, and continuously monitor and
assess asset vulnerabilities.

1.2.1 Use Case Scenarios

The NCCoE team worked with the project collaborators to create a lab environment that includes the
architectural components and functionality that will be described later in this section. These use case
scenarios were demonstrated in the lab environment as applicable for desktop and laptop computers,
on-premises servers, mobile devices, virtual machines, and containers:

= Asset identification and assessment: discovering physical and virtual assets on your corporate
network and performing automated assessments to prioritize their remediation. For this
scenario, it is important to determine some information about each asset, such as hostname,
Internet Protocol (IP) address, Media Access Control (MAC) address, firmware version,
operating system (OS) version, and installed software packages. This information can be used
to identify the asset and synchronize with other systems such as asset and configuration
management tools. Once the asset has been identified, it is important to determine if the
software and firmware versions have known vulnerabilities and how critical those
vulnerabilities are. The collected information is categorized and integrated with other asset and
configuration management tools.

= Routine patching: modifying assets to configure and install firmware, OSs, and applications for
the purpose of addressing bug fixes, providing security updates, and upgrading to later,
supported releases of software. Routine patching is done at regularly scheduled intervals
defined by the organization.

= Emergency patching: performing emergency patching for assets, such as for an extreme
severity vulnerability or a vulnerability being actively exploited in the wild. Systems in this
scenario should be able to deploy patches to assets outside of regularly scheduled intervals.

= Emergency mitigation: implementing emergency mitigations for identified assets, such as
temporarily disabling vulnerable functionality. This scenario demonstrates an emergency
procedure in which an organization needs to temporarily mitigate a vulnerability prior to a
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vendor releasing a patch. Systems included in this scenario need to be able to uninstall,
reconfigure, and disable services on assets.

Isolation of unpatched assets: performing network isolation of assets, like unsupported legacy
assets, end-of-life assets, and assets with high operational uptime requirements, to mitigate
risk for assets that cannot be easily patched or cannot be patched at all.

Patch management system security: implementing recommended security practices for patch
management systems, which have administrative privileged access over many other systems.
See Section 3 of NIST SP 1800-31B for more information on addressing this scenario.

1.2.2 Logical Architecture

This project required a variety of technology capabilities. The following were included in the lab build:

IT endpoints: This represents traditional endpoints, which included Apple laptops, Linux
workstations/servers, and Windows workstations/servers, as well as newer types of endpoints,
such as containers and Android and iOS mobile devices. These endpoints were all integrated
either physically or virtually within the network environment.

Device discovery: This includes systems that actively or passively scan the network
environment and report about newly discovered assets and their observed characteristics.

Network access management: This includes systems that govern access for endpoints, which
are components that typically enforce access restrictions based on telemetry received from
device discovery and vulnerability management systems within the environment. For example,
enterprise assets that are not up to the required patch levels could be restricted from having
access to resources distributed across the network environment.

Vulnerability management: This includes systems that continually scan endpoints to identify
known vulnerabilities and associated risks so that they may be proactively mitigated through
appropriate patching and configuration settings.

Software, firmware, and configuration management: This includes systems that automate and
maintain configuration changes and consistency across endpoints within the environment, as
well as update currently installed software and firmware versions. Configuration changes may
include updating network information, installing/uninstalling programs and services, and
starting and stopping services.

Update sources: This includes systems that house and maintain the most recent and trusted
software updates/upgrade files for distribution within the environment. These update sources
were leveraged by the software distribution systems to maintain an updated repository of
available patches.

Reporting: This includes systems that collect information from device discovery, network
access management, and vulnerability management systems. This collected information can
then be presented via dashboards or reports.

NIST SP 1800-31C: Improving Enterprise Patching for General IT Systems
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Figure 1-1 depicts the components that are used in the logical architecture, and the flow of a new or
returning device joining the network.
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Figure 1-1 Logical Architecture Components and Flow
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The following steps take place as a new or returning device joins the network. Each number corresponds
to a flow in Figure 1-1.

Device discovery: 1) The device discovery tool scans the device and collects information such as Internet
Protocol (IP) address, media access control (MAC) address, installed software/firmware, and OS, then 2)
sends the information to a vulnerability management system.

Vulnerability scanning: 3) The vulnerability management system scans the endpoint for vulnerability
information, including missing patches and outdated software, and 4) receives the scan results. 5) The
vulnerability management system sends the collected vulnerability data to the reporting service for
presentation to administrators.

Quarantine decision and enforcement: 6) The vulnerability management system shares the device
patch level with the network access management system to be used for network access control. 7) The
network access management system applies one of the following two enforcement actions: 7a) If the
network device does not exceed the organizational patch threshold, the device is given network access
and does not need to go through the remainder of the diagram. 7b) If the network device exceeds the
organizational patch threshold, the network access management system performs quarantine actions on
the endpoint and restricts network access. 8) The network access management system shares the
missing patch information with the software and configuration management system.

Patching: 9) The software and configuration management system checks its trusted update source for
patch updates, then 10) receives any new patches and updates its patch repository database. 11)
Missing patches are deployed from the software and configuration management system to the
connected endpoint. 12) The software and configuration management system receives the update that
the patches have been installed successfully. 13) The updates that were applied are sent to a reporting
server for administrator review. 14) The software and configuration management system communicates
that updates were successfully applied to the endpoint.

Vulnerability scanning: 15) The network access management system initiates a rescan of the endpoint
by communicating with the vulnerability management system. 16) The vulnerability management
system rescans the endpoint and 17) collects updated vulnerability data. 18) The vulnerability
management system sends updated endpoint vulnerability data to the reporting server and 19) shares
device patch level information with the network access management server.

Network access granted: 20) The network access management server grants the endpoint network
access.

1.3 Build Architecture Summary

Figure 1-2 depicts the high-level physical architecture of the NCCoE laboratory environment. The
segmented laboratory network backbone models the separation that typically exists between
subnetworks belonging to different parts of an enterprise, such as a backup site, shared services, a data
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center hosting widely used applications and services, and a workstation subnet consisting of user
endpoints. While the majority of the nodes in the workstation subnet were virtual, the gray box notes
physical machines.

The subnets were extended from the virtual lab to the physical lab by a Cisco switch. The switch had the
workstation virtual local area network (VLAN) extended to it from VMware via a trunk port. The lab
subnetworks were connected by a Cisco Firepower Threat Defense (FTD) firewall.
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Figure 1-2 Laboratory Configuration of Example Solution Architecture
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The NCCoE lab provided the following supporting infrastructure for the example implementation:

VMware ESX version 7.0, a shared NCCoE resource provided by the NCCoE IT Operations team
to host the patching infrastructure’s virtual machine (VM) workloads and network
infrastructure

a dedicated VLAN provided for external collaborator remote access to the VMware lab
environment from NCCoE IT operations

a Windows 2016 server that provided Active Directory (AD) services, authenticated users and
machines to the lab.nccoe.org domain, and provided Domain Name System (DNS) services

a Windows 2019 server that provided Dynamic Host Configuration Protocol (DHCP) services to
the endpoint network

a Windows 2019 server that served as a remote backup site for the endpoint configuration
management system

a CentOS 7 machine that served as a remote backup site for the Tenable vulnerability
management system

iDrac interfaces that allowed for remote configuration of Dell R620 server blades

virtualized endpoints running the following OSs: CentOS, Fedora, macOS, Red Hat, Solaris,
Ubuntu, Windows Enterprise, and Windows Server

a physical Windows 10 laptop and a physical Apple laptop running macOS to represent
employee endpoints

a Microsoft Structured Query Language (SQL) server hosting the database for Microsoft
Endpoint Configuration Manager

several Dell R620 machines that had Windows Server 2016, VMware ESXi, and two machines
running CentOS 7 installed to represent physical end nodes. Of the two CentOS 7 machines,
one was chosen to have OpenShift installed to represent a container management platform.
The Docker repository was also run on this same OpenShift machine.

1.4 Implemented Products and Services

The following collaborator-supplied components were integrated with the supporting infrastructure to
yield the example implementation:

Cisco Firepower Management Center (FMC) version 6.5.0.4 provided centralized management
of the Cisco Firepower Threat Defense firewall. It supplied a web interface for firewall
administrators.

Cisco Firepower Threat Defense (FTD) version 6.4.0 was the central firewall that connected the
lab’s internal subnets and the external internet. Through communication with Cisco Identity
Services Engine (ISE), the firewall provided network segmentation capabilities.

NIST SP 1800-31C: Improving Enterprise Patching for General IT Systems
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Cisco Identity Services Engine (ISE) version 2.7.0.36 was utilized to perform asset inventory
and discovery. Using attributes that were collected by Cisco ISE, such as current user or patch
level, the firewall enforced custom network access control policies.

Eclypsium Administration and Analytics Service version 2.2.2 was configured to assess
firmware levels present on a device and report if a vulnerable version of firmware was running
on a device. It could then download firmware updates to affected devices.

Forescout Platform version 8.2.2 provided asset inventory and discovery. Additionally,
Forescout collected attributes associated with endpoints and, through policy, provided
enforcement actions such as network access control via an integration with pxGrid, or service
removal via custom scripts.

IBM Code Risk Analyzer (cloud-based service) provided vulnerability scanning and reporting for
source code as part of the DevOps pipeline. Through an integration with GitHub, it scanned

deployed code for vulnerabilities and produced a report of remediation actions. IBM, as part of
the lab effort, provided source code hosted in GitHub to be ingested by the Code Risk Analyzer.

IBM Maa$360 with Watson (cloud-based service) provided asset inventory, vulnerability
management, and software distribution to laptops and mobile devices. The user authentication
module, part of the Cloud Extender module, was used to integrate IBM MaaS360 with AD. This
allowed users to authenticate to MaaS360 with their domain-joined accounts.

Lookout Mobile Endpoint Security (cloud-based service) provided vulnerability scanning,
assessment, reporting, and policy enforcement for mobile devices. An integration with IBM
MaaS360 allowed custom attributes from Lookout to be used in MaaS360 policies.

Microsoft Endpoint Configuration Manager version 2002 provided device configuration and
software distribution capabilities. Endpoint Configuration Manager allowed for software
updates and software changes to be pushed to endpoints. Discovery capabilities were enabled
to determine what endpoints existed on the network and domain.

Nessus version 8.14.0 provided on-premises vulnerability scanning of the architecture. Nessus
logged into devices over the network, using supplied credentials, and enumerated
vulnerabilities and missing patch information. This information was then presented to the
administrator via the managing Tenable.sc tool.

Tenable.io (cloud-based service) provided vulnerability scanning and reporting for
containerized applications. Tenable.io was configured to upload a repository from an OpenShift
node and perform assessments.

Tenable.sc version 5.18.0 provided management of the lab Nessus scanner. Tenable.sc was
configured to utilize the Nessus scanner to provide on-premises vulnerability scanning, asset
inventorying/discovery, and reporting using dashboards. Scan data from Tenable.sc was
ingested by other systems and was exported in the form of reports.

VMware vRealize Automation SaltStack Config version 8.3.0 provided device configuration
and software distribution capabilities. SaltStack Config allowed for configuration changes to be
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made to devices by updating or removing software as well as updating settings such as network
information.

Table 1-1 lists the collaborator-supplied product versions and system configurations that were utilized in
the implementation, including the number of central processing units (CPUs) and the amount of random
access memory (RAM) and hard disk drive (HDD) space in gigabytes (GB). All products were either
deployed virtually via an Open Virtualization Appliance (OVA) or installed on VMs. In addition to these
products, five cloud-based software-as-a-service (SaaS) offerings were also used for the build: IBM Code
Risk Analyzer, IBM MaaS360 with Watson, Lookout Mobile Endpoint Security, Tenable.io, and a Saa$S
version of Eclypsium.

Table 1-1 Product Versions and System Configurations Used

Product Version OS CPUs RAM HDD ‘ Deployed Via

Cisco FMC 6.5.0.4 N/A 4 32GB | 250GB | OVA

Cisco FTD 6.4.0 N/A 4 8 GB 49 GB OVA

Cisco ISE 2.7.0.36 | N/A 2 8 GB 200 GB | OVA

Eclypsium 2.2.2 CentOS 7 2 8 GB 200 GB | Installed application
Administration and

Analytics Service (on-

premises)

Forescout Appliance | 8.2.2 N/A 6 14 GB | 200GB | OVA

Forescout Enterprise | 8.2.2 N/A 4 12GB | 200GB | OVA

Manager

Microsoft Endpoint 2002 Windows 4 8 GB 240 GB | Installed application
Configuration Server 2019

Manager

Nessus 8.14.0 CentOS 7 2 8 GB 200 GB | Installed application
Tenable.sc 5.18.0 CentOS 7 2 8 GB 80 GB Installed application
VMware vRealize 8.3.0 CentOS 7 2 12GB | 80GB Installed application
Automation SaltStack

Config

Sections 2 through 9 of this volume contain more information on each of these products and services,
grouped by vendor. Note that the vendor sections are in order by the approximate sequence followed in
this build for installing and configuring the products and services.
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1.5 Supporting Infrastructure and Shared Services

In the lab environment, common services were deployed to support the example solution. These
services included AD Domain Services, Windows DNS, Windows DHCP, and a physical Cisco switch.

1.5.1 AD Domain Services

The AD Domain Services deployment provided the directory services that many of the products relied on
for their installations. A directory stores information about objects such as users and computers. This
information is made accessible on the network and can be used for many purposes; in this reference
implementation it was mainly used for authentication and access control. The AD Domain Services
instance in our reference implementation was deployed on a single virtual machine (VM) running
Windows Server 2016. This server was accessible to all subnets on the lab. More information about AD
Domain Services and the capabilities it provides can be found here.

1.5.2 Windows DNS

The Windows DNS deployment provided DNS capabilities to the reference implementation. DNS is an
open protocol that is primarily used to translate domain names to IP addresses. The Windows DNS
instance in our reference implementation was deployed on the same Windows Server 2016 VM running
AD Domain Services. This server was accessible to all subnets of the lab, giving all computers access to
DNS. More information on how to deploy Windows DNS can be found here.

1.5.3 Windows DHCP

The Windows DHCP deployment provided DHCP capabilities to the endpoints located in the Workstation
network segment. DHCP is a network management protocol that is primarily used to provide network
parameters, such as an IP address and default gateway, to endpoints. The Windows DHCP instance in
our reference implementation was deployed on a Windows 2019 server VM. This server was accessible
to the endpoint subnet of the patching architecture, giving all computers connected to the endpoint
subnet access to DHCP. More information on how to deploy Windows DHCP can be found here.

1.5.4 Cisco Switch

The architecture utilized a Cisco Catalyst 9300 switch to extend the VMware VLANs to the physical
devices within the lab environment, including laptops and server blades. A trunk port configured on the
switch allowed for the VLANs configured in VMware to be recognized by the switch. The remaining
switch ports were configured to access one VLAN at a time, depending on the connected device. More
information on the Cisco Catalyst 9300 switch can be found here.
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1.6 Typographic Conventions

The following table presents typographic conventions used in this volume.

Typeface/Symbol Meaning Example

Italics file names and path names; references | For language use and style guidance,
to documents that are not hyperlinks; | see the NCCoE Style Guide.
new terms; and placeholders

Bold names of menus, options, command Choose File > Edit.
buttons, and fields

Monospace command-line input, onscreen mkdir

computer output, sample code
examples, and status codes

Monospace Bold

command-line user input contrasted
with computer output

service sshd start

blue text

link to other parts of the document, a
web URL, or an email address

All publications from NIST’s NCCoE are
available at
https://www.nccoe.nist.gov.

In the first phase of our build, we used Tenable products to provide on-premises vulnerability scanning,
asset inventorying/discovery, and reporting using dashboards. Tenable was leveraged to meet the
device discovery, software/firmware discovery, and software/firmware assessment scenarios. Two
Tenable products, Nessus Scanner and Tenable.sc, were used in the lab environment as part of this
project. Also, Tenable.io, a SaaS-based cloud offering from Tenable, provided vulnerability scanning of
container images to the lab environment during the second phase of the build. This section shows how
each product was installed, configured, and used in the lab.

2.1 Nessus Installation and Configuration

Nessus is a vulnerability scanning engine that is used to scan endpoints, such as Linux, Windows, and
macOS, VMware ESXi, and network switches for vulnerability data. We utilized Nessus to scan endpoints
for vulnerability information and feed this information to Tenable.sc for reporting. Nessus can be
deployed as a standalone server or managed by Tenable.sc. In our lab build, Nessus was managed by
Tenable.sc. Since Nessus needed to be linked to Tenable.sc during Tenable.sc’s setup, Nessus was
installed and set up first.

Nessus was installed on a CentOS 7 VM, with hardware details included in Section 1.4. More information
on Nessus requirements can be found here. Installing Nessus 8.14.0 consisted of the following steps
(with more detailed information available from the hyperlinked resources):
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1. Download the Nessus executable from the Tenable download page. Note that you will need a

Tenable account to download installation software.

2. Install Nessus by running the rpom installation command, then start the Nessus service.

3. Configure Nessus to be managed by Tenable.sc after installing Tenable.sc.

2.2 Tenable.sc

Tenable.sc is a vulnerability management product that collects information from Nessus and reports
that information to administrators using dashboards and reports. Our build utilized Tenable.sc to
manage a Nessus scanner and report on collected vulnerability data for scanned endpoints. This section

assumes that the Nessus scanner from Section 2.1 was installed before installing Tenable.sc.

2.2.1 Tenable.sc Installation and Configuration

Tenable.sc was installed on a CentOS 7 VM, with hardware details included in Section 1.4. The Tenable
site has more information on Tenable.sc requirements. Installing and configuring Tenable.sc 5.18.0

consisted of the following steps:

1. Download Tenable.sc from the Tenable site (note: a Tenable account is needed).

2. Install Tenable.sc using the appropriate rom command and start the Tenable.sc service.

3. License Tenable.sc.

4. Configure Tenable.sc:

a.

Add a Nessus scanner. Tenable.sc relies on vulnerability data collected from Nessus
scanners to provide information on endpoint vulnerability levels.

Add a repository. A repository holds vulnerability data that is collected from Nessus
scanners for organizational endpoints. Repositories provide data storage that can be
restricted to appropriate users.

Add an organization. Organizations provide logical groupings for Tenable resources.

Administrators can restrict access to organizations to ensure that only authorized
personnel can view data.

Add a user with Security Manager permissions. The Security Manager role needs to be
added before a scan can be run. By default, when installing Tenable.sc a local system
administrator account is created, and that account is responsible solely for setting up

organizations and repositories. A Security Manager account has the correct permissions
to view scan data and initiate scans. More information on other Tenable.sc security
roles can be found here.
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e. Add endpoint credentials. Tenable.sc requires credentials to be loaded in order to
obtain the correct access levels for vulnerability scan data to be collected. Missing
results may be observed by scanning an endpoint without credentials. More information
on credentials can be found here.

2.2.2 Tenable.sc Scan Setup and Launch

After installing Nessus and Tenable.sc, the next step was to set up a scan policy. Scan policies allow you
to deploy template-based or custom scan options for assessing endpoints, including Windows, VMware
ESXi, macOS, and Linux-based OSs, as well as networking equipment. Scan policies contain plugin
settings and other advanced options that are used during active scans. For our build, Tenable
recommended the Basic Network scan template with credentials to assess vulnerabilities, because it
performs a full system scan that is suitable for a variety of hosts regardless of OS. Our build performed a
credentialed scan to help Tenable enumerate missing patch information; other options were non-
credentialed scans and agent-based scanning. More information on other types of Tenable.sc scan
templates and when they may be used can be found here.

We used the options below when creating our scan policy. See
https://docs.tenable.com/tenablesc/Content/AddScanPolicy.htm for more information on adding scan
policies.

= Template: Basic Network scan

= Name: Lab Basic Scan

= Advanced: Default

= Discovery: Port scan (common ports)
= Assessment: Default

= The Report and Authentication tabs stayed at their default values, as credentials will be added
in the active scan section.
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Discovery Port zcan (common ports) *

General Settings:
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Assasement Default « Use fast nebwork discovery

Port Scanner Settings:

« Scan common pons

« Use nei=tat if credentials are provided
= Us=se 5YN scanner if necessary

Ping hosts using:

« TCP

« ARP

= ICMP (2 retries)

General Settings:

« Avoid potential false alarms

« Disable CGl scanning

Web Applications:

= Dizable web application scanning

The next step after creating a scan policy was to add that policy to an active scan. Active scans utilize the
scan policy as well as user-supplied options to launch scans against endpoints. More information on
creating an active scan is available here. We used the following options when creating our active scan:

= Name: Credentialed Scan
= Policy: Lab Basic Scan

=  Schedule
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e Frequency: Weekly
e Time: 03:00
e Timezone: America/New_York
e Repeat Every: Saturday
= Import Repository: Patching Lab Endpoints
= Target Type: IP/DNS Name
= IPs/DNS Names: 10.151.40.0/24
= Credentials: Add all credentials created in step

After creating the active scan, click Submit. The example above would be scheduled to run automatical
on Saturdays at 3 a.m.

Information on manually launching scans (ad-hoc) is available here.

2.2.3 Scan Results

By default, when viewing scan results, the user is taken to the vulnerability summary page. This page
contains information on observed vulnerabilities, and the results are sorted by observed Common

ly

Vulnerability Scoring System (CVSS) severity and the number of observed affected machines. Figure 2-1

shows vulnerability summary information from our build. The vulnerabilities can be viewed by package
name and OS. The scan results can also be sorted by different types, such as IP address. This can be
useful in allowing administrators to quickly see which vulnerabilities were discovered per asset.

Figure 2-1 Vulnerability Summary Information

@& Jump to Vulnerability Detail List

Vulnerability Summary ¥ Total Results: 457

Plugin ID Name Family Seventy v VPR  Total

141506 @ CentOS 7 : glib2 and ibus (CESA-2020:3878 CentOS Local Se

[ Critcal |
141814 @  CentOS 7 : libpng (CESA-2020:3901) = m 5.0 5
141624 @  CentOS 7: curl (¢ CentOS Local Security Checks [ Gritca ECE 5
142600 @ CentOS7 CentOS Local Security Checks ([T s: 5
119048 @ CentOST CentOS Local Security Checks [ Criica EER 3
121192 @  CentOS 7 : systemd (CESA-2019:0049 CentOS Local Security Checks BT 3
124023 @  CentOS 7 : python (CESA-2018:0710 CantOS Local Security Checks [ Crical [EEER 3
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Sorting by IP Summary and then clicking the IP address of a machine allows for additional filters to be
applied to scan results. Another filter that could be utilized for software discovery is clicking on List
Software while searching for a specific IP address. This filter shows all the software that is currently
running and discovered on a machine, as the example in Figure 2-2 illustrates.

Figure 2-2 Applying Filters to Scan Results
Filters & List Software +

X Address x Software

10.151.40.105 Cisco AnyConnect Diagnostics and Reporting Tool [version 4.8.03052]

X Repositories Cisco AnyConnect Secure Mobility Client [version 4.8.03052]
All Cisco AnyConnect Secure Mobility Client [version 4.8.03052]
Cloud Extender [version 2.103.000.051]

X Plugin Name

Configuration Manager Client [version 5.00.8968.1000]

All

Eclypsium Software [version 2.0.0.0]
X Severity

Microsoft Policy Platform [version 68.1.1010.0]
All

Microsoft Visual C++ 2013 Redistributable (x64) - 12.0.40664 [version 12.0.40664.0]
Microsoft Visual C++ 2013 Redistributable (x86) - 12.0.40660 [version 12.0.406560.0]
Microsoft Visual C++ 2013 x64 Additional Runtime - 12.0.40664 [version 12.0.40664]

Microsoft Visual C++ 2013 x64 Minimum Runtime - 12.0.40664 [version 12.0.40664]

2.2.4 Tenable.sc Dashboards

Tenable.sc provides graphical representations of information that is obtained via vulnerability scans.
Dashboards can be customized with different widgets to allow organizations to quickly observe
vulnerability information. We utilized Tenable.sc’s reporting dashboards to help prioritize which assets
to remediate first and meet the firmware and software assessment scenarios. Directions for adding a
dashboard are available here. We used two dashboards: the Vulnerability Prioritization Rating (VPR)
Summary dashboard and the Worst of the Worst - Fix These First! dashboard.

The VPR Summary dashboard was utilized to help administrators prioritize which systems in the lab
should be remediated first. VPR combines threat intelligence, machine learning, research insights, and
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vulnerability metrics to dynamically measure risk. A higher number on the VPR dashboard indicated
which systems should be immediately addressed. Figure 2-3 shows the VPR dashboard from the build.
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Figure 2-3 Tenable VPR Summary Dashboard
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The Worst of the Worst — Fix These First! dashboard was used to help system administrators prioritize remediation efforts. The dashboard allows system administrators to gain insight into the top 10 vulnerabilities affecting systems and the
top 10 remediation actions that should be taken. The dashboard also shows a list of the most vulnerable assets. Figure 2-4 shows an example of the Worst of the Worst dashboard, with the top 10 most vulnerable assets and exploitable
vulnerabilities.

Figure 2-4 Tenable Worst of the Worst — Fix These First! Dashboard Example

enable.sc  Dashboad»  Solufions  Analysis»  Scans>  Reporfing>  Assels  Workflow>  Usersw

Worst of the Worst - FIX THESE FIRST 28Suitch Dashboard £ Opfions ~

Worst of the Worst - Reduce Greatest Risk First L A ‘Worst of the Worst - 90 Day Vulnerability Trend
Vuln Count
All Vulnerabifity Instances 578
Exploitable Vulnerabilities 138
Remotely Exploitable, Low Complexity, No Authenfication Required Wulns 50
And Tenable VPR Score is 8-10 - T4
Last Updated: 1 haur ago
Worst of the VWorst - Top 10 Priontized Actions
Siolution Risk Reduction - - - - - - - e - ~ s L
WWorzt of the Worst ulnarability instancee - Tofal
Apply KBS003171: Windows 10 1802, Windows Server 1808 and Windows Server 2018 May 2021 Security Update 54.20%
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Upgrade to Adobe Flash Player version 32.0.0.445 or later, 14.28%
‘Worst of the Worst - 0S/Application™o CPE Vulnerabilities
Apply KB4580325: Security update for Adobe Flash Player (October 2020) 14.20%

05 Only =} o
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Worst of the Worst - Top 10 Must Remediate Vulnerabiliies Worst of the Worst - New Vulnerabilifies Published Last 30 Days
MName Severity VPR Total Mame Severity VPR Total
KBSO00E22: Windows 10 Version 1808 and Windows Server 2019 March 2021 Security Update ag i B Ubunts 18.04 LTS { 20,04 LTS 7 20,101 21.04 : libee 11 vulnerability (LISHN-40566-1) m oo 1
KB4801245: Windows 10 Version 1808 and Windows Server 2018 February 2021 Security Update m 9.8 1
KEBD01342: Windows 10 1200 and Windows Server 2010 1800 Apr 2021 Security Update El - 1
KB4586T83: Windows 10 Version 1508 and Windows Server 20128 Movember 2020 Security Update a7 1
KB4538461: Windows 10 Version 1809 and Windows Server 2018 March 2020 Security Update 26 z =
Last Upcaateed: 1 bour ago Larst Uinciated: 1 hour apo
Worst of the Worst - 10 Most Vulnerable Assets Worst of the Worst - By Asset
IP Address DNS 0S CPE Score Wulnerabiities Azsat Total ulnerabilities
10.151.40.105 cpe:iomicrosoftwindows_server_2018:x54-datacenter 350 Systems that have been Scanned 14

113123 entlsubeat lab.nocoe org 160 Systems with Software inventory 14

100151.40.112 cpe:io:zanonical:ubuntu_linue:13.04 40 Exploited by Mahwvare 13
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2.2.5 Tenable.sc Reporting

Tenable.sc also provides the ability to export vulnerability data to reports. The difference between
dashboards and reports is that reports are meant to be exported and used outside of the Tenable.sc
web console. With reports, data can be exported as a comma-separated values (CSV) file for ingestion by
other systems, or as PDF files to be reviewed by management for compliance or vulnerability
management purposes. Our build utilized reports to demonstrate how software and firmware
assessment data could be shared with security managers to help to prioritize remediation efforts and
actions.

Tenable reports can be scheduled to run after a scan or be scheduled to run during certain times of the
week. To launch a report on demand (manually start), follow the instructions here. Once the report is
ready and the user clicks on the results, the report automatically downloads in the browser. Figure 2-5
shows a portion of the Critical and Exploitable Vulnerabilities report from our build that detailed the top
20 critically affected systems.

Figure 2-5 Exploitable Vulnerability Summary

This chapter displays a summary of top exploitable critical vulnerabilities. The chapter contains a bar chart of
the top 20 exploitable systems, a table of top 10 systems with system details, a port summary, and the top
exploitable critical vulnerabilities.

This chart displays the top 20 systems with critical vulnerabilities. The bar represents the number of exploitable
vulnerabilities discovered on the system. These systems contain known exploitable vulnerabilities and should
be patched as soon as possible.

Top 20 Critical Systems

Number of Vulns

10.151.40.105 10.131.2.91 10.151.40.101 10.151.40.122 10.151.40.123 10.151.40.100

Host

More information about reports, other report templates, and custom report creation can be found here.
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2.2.6 Tenable.sc Integrations

Tenable.sc provides for integrations with third-party software via its representational state transfer
(REST) application programming interface (API). The vulnerability data that is collected by Tenable can
be shared with other systems such as configuration management or access control systems to
automatically apply remediation actions. More information on the Tenable API can be found here. The
following two example integrations with Tenable.sc were implemented in the lab:

= Cisco ISE: This integration allowed Cisco ISE to leverage vulnerability data collected by
Tenable.sc. Cisco ISE initiated a scan when new devices joined the network. The CVSS scores
observed by Tenable were then sent to Cisco ISE, and devices that were over the score threshold
were automatically quarantined from internal access. See Section 5.2.5 for additional
information on the Cisco ISE integration.

=  Forescout Platform: This integration allowed Forescout to leverage vulnerability data collected
by Tenable.sc in order to quarantine endpoints. A Forescout policy was created that specified
that devices with CVSS scores over a certain threshold would be quarantined from the network.
Forescout leveraged an integration with Cisco ISE via pxGrid to perform network enforcement
actions. Section 7.2.8 contains additional explanation of the integration.

2.2.7 Tenable.sc Ongoing Maintenance

All Tenable components should be kept up to date. You must have an active Tenable account to
download updated software. Software for all Tenable components, including Nessus and Tenable.sc, can
be downloaded from https://www.tenable.com/downloads. Follow the directions on these pages to
upgrade Tenable.sc and upgrade Nessus.

Note that while Nessus plugins are updated automatically without user intervention, there is an option
to manually update them. Keeping plugins up-to-date allows Tenable to identify all of the latest
vulnerabilities.

2.3 Tenable.io

Tenable.io is a cloud-based platform that organizations can use to perform vulnerability scanning and
reporting for their on-premises and cloud-based endpoints. In our build we used Tenable.io to provide
container security for a CentOS 7 VM running Red Hat’s OpenShift container orchestration software.

The platform system requirements for endpoints to run the Container Security (CS) Scanner software
can be found here.
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2.3.1 Tenable.io Configuration

Tenable.io is operated using an online portal. It provides a Get Started page that walks administrators
through initial setup steps, such as configuring scans and linking a Nessus scanner. These steps were not
needed to perform the capabilities implemented in the lab demonstration.

Administrators will need to speak with their Tenable representative to ensure access to the CS
dashboard before continuing. Without access to this dashboard, they will not be able to add a connector
to upload registry images or review the results from completed scans.

2.3.2 Performing Container Scans

Container registry users need to perform the following high-level steps in order to begin running
container scans. For more information on getting started running the CS Scanner, please consult the
following page.

1. Download and install the CS Scanner Docker image from the Tenable.io Portal. During
download, you will be presented with a username and password. Please make note of them, as
they will be needed during the installation.

2. Generate API keys. API keys will be needed in order for the CS Scanner tool to securely interact
with and upload data to Tenable.io.

3. Set environmental variables. The following environmental variables were created and exported:

a. TENABLE_ACCESS_KEY — This was created in step 2. It is used to allow the container
security tool to connect with Tenable.io.

b. TENABLE_SECRET_KEY — This was generated during the APl key creation process. It is
used to allow the tool to connect with Tenable.io.

c. IMPORT_REPO_NAME - This is the name of the repository that you would like to export.
Note that this name is what will appear in the container security dashboard of
Tenable.io.

d. REGISTRY_URI—This is the URI of the registry that you would like to import.

e. REGISTRY_USERNAME — This is a machine account on the system that contains the
correct privileges to read from the registry.

f. REGISTRY_PASSWORD — This is the password for the account that will read from the
registry.
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g. IMPORT_INTERVAL_MINUTES — This is how often you want the Tenable.io scanner to
import and scan images. The lab implementation configured the scan to run every 1440
minutes. The scan by default will run in a manual, ad-hoc manner.

4. Configure and run the Tenable.io CS Scanner. This involves running a docker command with the

environmental variables that were previously set, then importing the registry. The registry is
automatically imported after a one-line command is run, without further interaction from the
user.

2.3.3 Container Scan Results
After performing the scan from Section 2.3.2, the container image data will populate inside of
Tenable.io. To view scan results, a user logs in to Tenable.io and navigates to Menu = > Container

Security > Images tab. This tab presents the user with the repository and image name, the associated
number of vulnerabilities or malware, risk score, and date of upload, as Figure 2-6 depicts.

Figure 2-6 Example of Container Image Data

o ° ®
REPOSITORY IMAGE TAG VULNERABILITIES MALWARE RISK UPLOAD DATE
tenablesc nginx-scan-test latest - 0 10 07/12/2021

The scan results can be further drilled into by clicking on the repository that you would like additional
information on. Under this new view, administrators can see the actual vulnerabilities and Common
Vulnerabilities and Exposures (CVE) scores associated with containers as well as malware, package
inventory, and identified containers. Figure 2-7 shows a view of the vulnerabilities associated with the
lab instance’s uploaded registry.
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Figure 2-7 Example of Container Vulnerability Information

nginx-scan-test

10 ) Vulnerabilities Malware  Package Inventory Identified Containers
RISK SCORE \/ VULNERABILITIES
:{’} 0 earc A | 4Vulnerabilities
MALWARE
Image Information
SEVERITY VULNERABILITY RISK SCORE RELEASE DATE
IMAGE ID UPLOAD DATE
4cdc5dd7eaad 07/12/21 CVE-2021-3711 9.8 08/24/2021
LAST UPDATED ANALYZED DATE
09/20/21 09/20/21 | HiGH | CVE-2021-3712 7.4 08/24/2021
REPOSITORY [ HiGH | CVE-2021-36222 7.5 07/22/2021
tenablesc
IMAGE TAG EET CVE-2021-33910 5:5 07/20/2021
nginx-scan-test latest

sha256:a5d8817¢48366db0635e3a1d3655691d150... 0

0S
Debian

2.3.4 Tenable.io Maintenance

Tenable.io is a SaaS offering with updates automatically provided and installed by Tenable, who
maintains the platform.

Eclypsium provides monitoring and alerting for software and hardware components for an enterprise,
along with advanced capabilities such as firmware integrity checking and updating. This section provides
information on Eclypsium installation and usage. In this build, we utilized Eclypsium to provide agent-
based identification of hardware and firmware for our laptop, desktop, and server endpoints while also
monitoring the firmware for vulnerable or end-of-life versions. We utilized both the on-premises and
cloud-hosted versions of Eclypsium. Both solutions offered the same experience, with the cloud product
receiving updates faster and automatically.

3.1 Eclypsium Installation and Configuration

Two machines were required for the on-premises installation: one for the main console and database,
and the other for data processing. The console machine should be accessible by a fully qualified domain
name (FQDN) DNS entry.
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The steps below are a basic overview of the installation. You will receive an installation guide from your
Eclypsium representative with more detailed instructions.

1. Provision two machines that meet or exceed the hardware requirements in the installation
guide.

2. Download the Eclypsium installation script and your license to the same folder.
3. Perform the installation.

4. Install Transport Layer Security (TLS) certificates by copying the private key, public TLS
certificate, and the full certificate chain to the /opt/eclypisum/certs directory. The TLS certificate
was generated and signed by our internal Lab certificate authority (CA).

The SaaS version of Eclypsium comes fully provisioned and installed.

3.2 Eclypsium Scanning

Eclypsium scanning is agent-based, so the binary must be downloaded and installed on the target
machine and registered to the Eclypsium before scanning can begin. To download the Eclypsium agent
go to Deployment > Download to find the binary for your chosen computing platform. Eclypsium
supports installer binaries for Windows, Windows Server, macOS, and Debian or RPM Package Manager
(RPM) based Linux systems. You must also use an access token (a random character string) for the
registration. This token is used both to ensure that only desired endpoints are registered, and optionally
to register devices in groups depending on the token used. Device tokens can be managed by navigating
to Administration > Tokens.

After downloading the binary onto an endpoint and generating a host registration token, the following
commands were run, as an example on a CentOS 7 machine, to install the application and register the
host with the console:

yum install eclypsium*.rpm

EclypsiumApp -s2 <DOMAIN> <REGISTRATION TOKEN>
To launch an ad-hoc or manual scan, navigate to Devices > Device List and click the Scan button.
To schedule a recurring scan, perform the following steps:
1. Navigate to Settings > Scan.
2. Click Schedule under the Scan Schedule field.

3. Fill out the Custom Scan Schedule box with the information shown below.
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Custom Scan Shedule

Schedule a Scan 1, 12:00:00 PM EDT

Schedule Recurring Scans

Repeat Every:

Repeat On: S M T W T F S

Scan At: 08:00 PM EDT
Ends: Never
JCIEEEEE

4. Click Save.

The above options create a scan that will run weekly on Saturdays at 8 p.m. ET. The scan schedule can
be changed so that scans run more than once per week by selecting additional days or be repeated at a
different weekly interval by changing the Repeat Every field.

3.3 Eclypsium Reporting

Eclypsium’s main dashboard (Figure 3-1) provided firmware assessment capabilities to the build. The
main dashboard provided a quick view into monitored devices, devices at risk, and the integrity of
installed firmware. The Devices pane displayed information on the devices that were actively being
monitored by the Eclypsium agent and presented that information grouped by device type (Clients,
Servers, Network). The Risk pane displayed information regarding systems that were affected by
vulnerable firmware versions with high CVSS scores. The Risk pane also showed all vulnerable devices
and devices that were running outdated firmware. The Integrity pane showed devices with integrity
failures and baseline deviations. Eclypsium keeps a running database of good firmware hashes to
compare to an installed firmware hash to check for malicious or potentially compromised firmware
versions.
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Figure 3-1 Eclypsium Main Dashboard
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Figure 3-2 provides an example of details found on a scanned device. The device registration steps were
performed, and a scan was conducted automatically. Although there were vulnerabilities found in the
chipset firmware, Eclypsium determined that no updates were available. Additionally, Eclypsium
provided vulnerability and integrity information for device components such as the CPU, Basic
Input/Output System (BIOS), and Peripheral Component Interconnect (PCl) devices; this was outside the
scope of this project.

Figure 3-2 Eclypsium Dashboard Device Details

Risk Status Integrity Status

PASSED

Vulnerabilities Detected: Improper Buffer Restrictions in Intel ME
Firmware
Vector Register Sampling

View More Vulnerabilities (3) @

Download Raw Data

No out-of-date firmware detected

& Updates: Check For Updates

¥r Recommendation:
There have been 5 vulnerability detections on this device.
«+ 1 has a critical severity rating and a CVSS score of 9.0 - 10.

Please check the individual vulnerability pages in the scan summary for
advisories and recommended actions.

Component Status

UEFI and BIOS Processor and Chipset

Last scanned Jun 24, 2021, 5:13:04 PM EDT Last scanned Jun 24, 2021, 5:10:35 PM EDT

Last changed 17 days ago
A

3.4 Updating Firmware

There is an update script from Eclypsium for automatically finding firmware updates for endpoints. The
script downloads the new firmware, and then the administrator performs the update manually with the
downloaded file. After obtaining the script (currently a python file) from Eclypsium, follow these steps:
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1. Ensure the endpoint you want to update the firmware on has the required python dependencies
installed so it will be able to execute the script.

2. Putthe script on the machine and run it. It will automatically find and download the latest

firmware update file.

3. Run the downloaded file to update the firmware.

Figure 3-3 and Figure 3-4 show the characteristics of a System Management BIOS (SMBIOS) before and

after running the Eclypsium firmware update script. Note that the SMBIOS Version has changed from
1.11.4 to 1.22.3 after running the update script and manually installing the downloaded firmware

binary.

Figure 3-3 SMBIOS Before Eclypsium Firmware Update Script

Device Details

BIOS Mode
Processor Supported
Domain

Product

Part of Domain
Number of Logical Processors

BIOS Manufacturer

Firmware Serial Number

UEFI
Supported
WORKGROUP
Latitude E5570

false

Dell Inc.

THOYVD2

Driver Status
Device Name
Manufacturer
Model

Total Physical Memory

BIOS Version

Firmware Release Date

SMBIOS Version

OK
DESKTOP-P9036J4
Dell Inc.

O0CPTX8
17057128448

DELL - 1072009,1.11.4,American
Megatrends - 50008

20161222000000.000000+000

1.11.4
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Figure 3-4 SMBIOS After Eclypsium Firmware Update Script

Device Details

BIOS Mode UEFI Driver Status OK

Processor Supported Supported Device Name DESKTOP-P9036J4

Domain WORKGROUP Manufacturer Dell Inc.

Product Latitude E5570 Model 0CPTX8

Part of Domain false Total Physical Memory 17070333952

Number of Logical Processors 4 BIOS Version Eﬂii.g:;rl?]zji(?%%;g;3,American
BIOS Manufacturer Dell Inc. Firmware Release Date 20200217000000.000000+000
Firmware Serial Number THOYVD2 SMBIOS Version 1.223

3.5 Updating Eclypsium

The Eclypsium on-premises upgrade process required downloading a script and running it in the same
folder Eclypsium was installed in. Our experience with updating Eclypsium was a successful one-step
process. After running the script and restarting the Eclypsium service, the dashboard was updated.
Eclypsium provides materials to customers on how to update their on-premises installations.

The cloud-hosted version of Eclypsium updates automatically, with no user interaction required. The on-
premises version of Eclypsium is not updated automatically because it is tied closely to environment
policies. Eclypsium users will receive a notification on the main console screen when updates are
available. Managed endpoints can be configured to automatically update the installed endpoint driver
or update manually if needed.

In our build we used VMware vRealize Automation SaltStack Config 8.3.0 to provide configuration
management, vulnerability management, and patch deployment. SaltStack Config was used to manage
Windows workstations and servers, a macOS laptop, and Linux/Unix-based VMs and servers. A full list of
OSes that SaltStack Config can manage can be found here.

VMware vRealize Automation SaltStack Config is deployed with a “Salt master” server that manages
endpoints via an installed agent referred to as the “Salt minion”. In the build, the following SaltStack
Config server components were deployed on a single VM running CentOS 7:
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Salt master: The Salt master service provided the main connection between SaltStack Config
and the targeted endpoints running the minion agent. The Salt master plugin also
communicated with the backend PostgreSQL database to access stored jobs and job
configuration files.

Returner as a Service (RaaS): RaaS provided the communication between the SaltStack Config
web user interface and connected Salt master nodes.

PostgreSQL database: RaaS used a PostgreSQL database to store minion data, the output from
job returns, event data, files, local user accounts, and settings for the user interface.

Redis database: RaaS used a Redis database for temporary storage for items such as cached
data. It also used this database to hold queued work for deployment.

4.1 VMware vRealize Automation SaltStack Config Installation and

Configuration

VMware vRealize Automation SaltStack Config and its components listed above were installed via the
SaltStack installer script on a CentOS 7 VM, with hardware details included in Section 1.4. SaltStack
Config has the following software dependencies:

OpenSSL

Extra Packages for Enterprise Linux (EPEL)
Python cryptography

Python OpenSSL library

More information on SaltStack Config requirements can be found here.

The SaltStack Config installation process consists of the following steps:

1.

2.

3.

6.

Obtain the SaltStack Config installer zip file from your SaltStack representative.

Unzip the zip file on the desired installation node.

Run the setup_single_node.sh script.

Allow port 443 access for reaching the SaltStack Admin Web graphical user interface (GUI).

Allow port 4505 and 4506 access for communication between the Salt master and minion
agents.

Install the license key.

More information on installing SaltStack Config can be found here.
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4.2 Salt Minion Agent

The Salt minion agent is how SaltStack Config communicates with endpoints to perform configuration.
The minion agent needs to be installed on any endpoints that will be managed by SaltStack Config. The
minion agent is available for various OSs and can be found here along with OS-specific installation
instructions.

The minion agent can be installed and configured with the following steps:

1. Download and install the minion agent.

2. Edit the minion agent with the IP address of the Salt master server. Note that by default, the
minion will use the DNS name of ‘salt’ when trying to connect to the Salt master server. On
Linux-based systems the configuration file located under /etc/salt/minion can be edited to use
custom IP addresses or hostnames instead. On Windows-based systems, this information can be
edited using the minion configuration wizard.

3. Start the minion agent.

4. Accept the minion key.

The Salt minion agent uses a public/private key pairing for communicating with the SaltStack Config
server. The key generation process takes place automatically on the client system, and the minion public
key is automatically sent to the Salt master server. The public key of the minion agent will need to be
accepted on the Salt master server so that secure communication can take place. Steps for accepting a
new minion key can be found here. Note that jobs will not be able to be issued to endpoints unless the
minion key is accepted in the SaltStack Config console.

4.3 SaltStack Config Jobs

SaltStack Config uses jobs to run remote execution tasks on endpoints. The build utilized these jobs to
provide configuration management capabilities. Jobs were created, scheduled, and executed via the

SaltStack Config web console.

For brevity, and because jobs are highly customizable, this guide includes one example of creating and
running a job. The example job demonstrates removing 7zip version 19 from a Windows endpoint in an
emergency mitigation scenario, where an administrator chooses to remove a vulnerable product that
cannot be patched. The following are the steps used in the build to set up and execute this job:

1. Click Config > File Server.

2. Click base from the saltenv drop-down menu. Base corresponds to one of the default file
directories that are created to hold configuration files.

3. Type windows/7zip.sls for the path name.
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4. Inthe field name below, add the information in the screenshot, then click SAVE.

Swindows/7zip

bhaze xow
I CLOME I DELETE

1~ Fzip:

g pkg.removed:

3 - pkgs:

4 - Jzip

5 - version: 19.80.80.8

5. Next, click Config > Jobs, then click Create Job. Edit the fields listed in Table 4-1 so they have the
specified values.

Table 4-1 Specified Values for Creating "Uninstall 7zip" Job Using SaltStack Config

Field ‘ Value Explanation

Name Uninstall 7zip | This is the name of the job.

Command Salt The salt command allows for all salt functions to be loaded and
available for choosing.

Targets Windows This field allows for different groups of machines to have
configurations applied to them. The default way that SaltStack
groups machines is by OS; however, other target groups can be
created based on device attributes.

Function state.apply The state.apply function allows for custom state files or .sls
configuration files to be applied to an endpoint.

Environments | Base Base corresponds to one of the default file directories that are

created to hold configuration files.

States

windows.7zip

The states field corresponds to the file with the configurations that
are to be pushed down to the endpoint. In this example, this
corresponds to the uninstallation of 7zip configuration file.

6. Click Minions, then select the Windows Target Group.

7. Click RunJob. Under the Job drop-down menu, select Uninstall 7zip.
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8. Select Run Now.

4.4 SaltStack SecOps

SaltStack SecOps, an add-on component for vRealize Automation SaltStack Config, was utilized to
provide vulnerability and patch management capabilities. SaltStack SecOps can be configured to run
scheduled assessments of endpoint vulnerabilities with the following steps:

1. Click Protect > Policies under the SaltStack Config Web GUI.
2. Click Create Policy.
3. Enter “Endpoint Scan”.

4. Under Targets, select All Minions. This performs a scan of all connected network endpoints
regardless of OS. A scan targeting a specific OS or other defined target group could be
performed instead by selecting a different value.

5. Under Type, choose Repeat Date & Time, and fill out the other options as shown.

Type Not scheduled (on demand)
Recurring
© Repeat Date & Time
Once

Cron Expression

weekly
Sun Mon Tue Wed Thu Fri Sat
21:00
Start Date
End Date

Maximum parallel jobs (@) 1
Run assessment on save

6. Make sure that Run assessment on save is checked.

7. Click Save. The above scan will automatically run and be scheduled to run weekly on Saturdays
at 9 p.m. without further user interaction.
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After running the scan, the Vulnerability Summary and Top Advisories dashboard begins to populate, as
captured in Figure 4-1. The image shows that the SaltStack SecOps engine has started collecting
vulnerability information and categorizing it by severity level. The Top Advisories dashboard shows
vulnerabilities detected in the scan that have the highest CVSS score. In the scan, the top advisories all
have scores of 9.8.
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Figure 4-1 SaltStack SecOps Vulnerability Summary and Top Advisories Dashboard
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SaltStack SecOps can also be used to remediate endpoints. To do so, follow these steps:
1. Click the “Endpoint Scan” policy that was created previously.

2. From the resulting list, either single remediations can be selected, or you can choose to select all
remediations.

3. When the desired patches are selected, click Remediate.

4.5 vRealize Automation SaltStack Config Maintenance

All SaltStack Config components should be kept up to date. You are required to have an active VMware
account to download updated software. Software for all SaltStack Config components can be
downloaded from here. To upgrade SaltStack Config, follow the directions in Section 10 (Upgrade from a
previous version) of Installing and Configuring SaltStack Config.

SaltStack vulnerability data is kept up to date automatically without user interaction. To perform a
manual check for updates, perform the following steps:

1. Login to the SaltStack web console.
2. Navigate to Administration > SecOps.

3. Click CHECK FOR UPDATES under the Vulnerability Content section.
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In this implementation, we used the Cisco FTD firewall to provide network access management
capabilities and Cisco ISE to provide device discovery capabilities. The Cisco FMC product was utilized to
manage Cisco FTD. All Cisco products in the build were virtual appliances that were deployed in VMware
ESX via Open Virtualization Formats (OVFs) downloaded from the Cisco website.

5.1 Cisco FTD and FMC

Cisco FTD is a next-generation virtual firewall that was used to provide networking to the patching
architecture. The build utilized Cisco FTD 6.4.0 to enforce network access control using firewall rules.
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Cisco FTD was deployed and managed in the lab via a separate Cisco FMC VM. This section walks
through installing and configuring Cisco FTD and Cisco FMC.

5.1.1 Cisco FMC Installation

Cisco FMC was utilized to manage an instance of Cisco FTD. With this in mind, it is suggested to set up
FMC first. Installing and setting up the FMC virtual appliance involved the following steps:

1.

2.

3.

Download the FMC VM tar file from the Cisco Downloads page. Note that you will need a Cisco
account to download it.

Deploy the OVF in VMware.

Perform initial configuration of the FMC. This included tasks like accepting the End User License
Agreement (EULA), setting a password, and configuring network settings.

5.1.2 Cisco FTD Installation

For our build, installing the Cisco FTD VM consisted of the following steps:

1.

2.

w

Download the OVF from the Cisco Downloads page.

Deploy the Cisco FTD VM using the VMware vSphere web client.

Complete the Cisco FTD VM setup using the command line interface (CLI). This included
performing initial configuration, such as setting up network information, user credentials,
management mode, and firewall mode. In our build, we chose no for “Enable Local Manager” to
ensure that the FTD was managed by the FMC from Section 5.1.1. The FTD was set to routed
firewall mode, which allowed for IP-based separation between subnets.

Register Firepower Threat Defense to the Firepower Management Center. This included
configuring network information for the management port, which was the IP address that the

management center VM communicated with.

5.1.3 Licensing Cisco FTD with Cisco FMC

When first logging into the Cisco FMC, a license needs to be applied to the Cisco FTD instance.
Instructions can be found here. The smart licensing feature allows for individual features to be licensed
to meet organizational needs. The license types listed in Table 5-1 were applied to our build, and they
granted the specified capabilities.
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Table 5-1 License Types and Granted Capabilities for Cisco FTD

License Type Granted Capabilities

Base User and application control, switching, routing, network address
translation (NAT)

Threat Intrusion detection and prevention

Malware Threat intelligence for detecting malware

URL Filtering Category and reputation-based uniform resource locator (URL) filtering

AnyConnect VPN Only Remote access virtual private network (VPN) configuration

5.1.4 Cisco FTD Initial Network Configuration

After licensing the Cisco FTD instance, the next step is to configure networking information for the
firewall interfaces. Security zones need to be created; they allow firewall interfaces to be grouped
together in order to apply configuration and policy. To create security zones, perform the following

steps:
1.

2.

5.

6.

Choose Objects > Object Management.
Choose Interface from the list of object types.
Click Add > Security Zone.

Enter a name.

Select Routed from Interface Type.

Click Save.

The security zones described in Table 5-2 were created in support of our build:

Table 5-2 Security Zones Created for Cisco FTD

Security Zone ‘ Zone Description

Outside Zone Contained the wide area network (WAN) interface that sat between the firewall

and the internet gateway

Endpoints Contained the interface that communicated with all lab endpoints that repre-

sented end user devices and servers

Shared Services Contained shared common services such as DHCP and DNS

Patching Products | Contained all deployed patching products and services
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The next step is to edit each firewall interface with the correct IP address for your organization and the

appropriate security zone:

1.

6.

7.

Select Devices > Device Management and click Edit (¢") for your FTD device. The Interfaces
page is selected by default.

Click Edit (¢ ) for the interface you want to edit.

Enable the interface by checking the Enabled check box.

Under the Security Zone drop-down, select the correct security zone.
Under the IPv4 tab, enter the appropriate IP address information.
Click Ok.

Click Save.

The last step is to enable network address translation (NAT). Since private IP addresses cannot traverse
the public internet, a NAT rule needs to be created to allow the public IP address for the firewall to be
used for external network traffic from internal network endpoints using private IP addresses. To create a
NAT policy, perform the following steps:

1.

2.

Select Devices > NAT.

Click New Policy > Threat Defense NAT to create a new policy. Give the policy a name, option-
ally assign devices to it, and click Save.

Click Edit (¢ ) to edit the Threat Defense NAT policy.
Click Add Rule, then select Auto NAT Rule.

Under Interface Objects, leave any under Source Interface Objects, and place Outside_Zone
under Destination Interface Objects.
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Edit NAT Rule (- ]

NAT Rule:

Auto NAT Rule L

Type:
| Static -

Interface Objects Translation PAT Pool Advanced

Available Interface Ob... c Source Interface Objects (0) Destination Interface Obj... (1)

|Q Search by name | any Outside_Zone L}
BackupLAN = Add to Source
") | Add to Destination |

6. Under the Translation tab, select IPv4-Private-10.0.0.0-8 under Original Source, and under
Translated Source select Destination Interface IP.

Edit NAT Rule (7]
MNAT Rule:
Auto NAT Rule v
Type:
| Static v
¥ME e
Interface Objects Translation PAT Pool  Advanced
Original Packet Translated Packet
Original Source™ Translated Source:
| IPv4-Private-10.0.0.0-8 vt | Destination Interface IP v
@) The values selected for
Original Port: Destination Interface Objects in

'Interface Objects' tab will be used

| Tcp v |

| | Translated Port:

7. Click Ok, then click Save.

8. Click Deploy > Select Device > Deploy to deploy the NAT policy.
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5.2 Cisco Identity Services Engine

Cisco ISE is a network administration product that allows for enforcement of administrator-created
security and access control policies. Cisco ISE captures attributes about devices, such as IP address, MAC
address, and OS in order to enforce custom policies. Cisco ISE can be deployed as a standalone system
or as a primary and secondary node for high-availability deployments. Our build utilized a single ISE VM
node set in standalone deployment.

5.2.1 Cisco ISE Installation

The installation process for deploying a virtualized version of Cisco ISE requires you to download the
OVA from https://software.cisco.com/download/home and deploy it using VMware. Note that you will
need a Cisco account to be able to download software from Cisco. Follow the steps here for deploying
the Cisco ISE OVA template.

After deploying the ISE OVA, launch the VM console from VMware. At the Cisco ISE CLI, type setup to
start the ISE setup wizard. Use it to configure hostname and IP address information and to create admin
credentials for the Web Admin portal.

Lastly, Cisco ISE needs to be licensed. Follow the guidance here to find more information on licensing

your ISE deployment.

5.2.2 Cisco ISE Initial Configuration

After performing initial setup and licensing, the next step is to ensure that the Cisco ISE deployment
node has the correct settings and profiling configuration services running. Perform the following steps:

1. Click Administration > System > Deployment.

2. Under the General Settings tab, ensure that the options shown below are selected.
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3. Under the Profiling Configuration tab, ensure the following options are selected. Note that a
description of the various profiling services can be found on the Profiling Configuration tab.

When you are done selecting the options, click Save.
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For our build, Cisco ISE needed to have an integration with AD services to perform authentication of
endpoint users to the network. Cisco ISE used AD as a trusted store to authenticate users and machines
to the network. To perform the integration between Cisco ISE and AD, follow the guidance here.

5.2.3 Configuring AnyConnect VPN Using Cisco FTD and Cisco ISE

By default, Cisco ISE cannot make any policy enforcement actions for devices that are not actively
authenticated against it. This means that devices that are not using 802.1X authentication or the
AnyConnect VPN client will not have full device attributes collected nor be subject to ISE policy rulesets.
Our build utilized AnyConnect VPN integration between the Cisco FTD and Cisco ISE to demonstrate
authenticating two hosts to Cisco ISE. The example assets chosen to be connected to the VPN were a
Windows 10 and CentOS 7 VM. Please follow the steps here for setting up the integration.

5.2.4 Cisco Security Group Tags (SGTs)

Cisco security group tags (SGTs) are user-designated tags that can be used to group and classify devices.
Each tag is then used to represent logical group privileges to inform the access policy. SGTs were used by
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the build to restrict access to devices that did not meet the desired organization patch level. This section
covers setting up the Quarantine SGT and sharing SGTs with Cisco FTD.

First, add the Quarantine SGT to Cisco ISE with these steps:
1. Click Work Centers > Trust Sec > Components > Security Groups.
2. Click Add.
3. Under Name, type: Quarantined_Systems.
4. Under Description, type: Quarantine Security Group.

5. Ensure the Propagate to ACl option is checked.

Security Groups List > Quarantined_Systems

Security Groups

* Name

Quarantined_Systems|

*lcan

& & = o §
a w2 >ad®
L E® 9 & 5
Description

Quarantine Security Group

Propagate to ACI

Security Group Tag (Dec / Hex): 255/00FF

Generation Id: 0

After adding the Quarantine SGT, it needs to be shared with the Cisco FTD. SGTs are not shared between
ISE and FTD by default. ISE will have to be added as an identity source to the firewall. This
communication between the firewall and ISE takes place using pxGrid. The process for setting up SGT
sharing from ISE to the firewall involves:

= making sure that SGTs are published via pxGrid by Cisco ISE,

= exporting the ISE pxGrid and monitoring (MNT) system certificates for importation to FTD, and
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= adding ISE as an identity source on the firewall.

The build used this integration to perform network access control on devices that were given the
Quarantine SGT by ISE. This SGT was given by assessing an endpoint’s current patch level. See this page
for step-by-step guidance on adding Cisco ISE as an identity source.

5.2.5 Cisco ISE Integration with Tenable.sc

For our build, Cisco ISE contained an integration with Tenable.sc to perform automated scanning of
endpoints as they were authenticated to ISE. ISE could then take the highest CVSS score that was
associated with an endpoint and, via policy, enforce network restrictions through sharing SGTs with the
Cisco firewall. The build used this capability to scan devices as they connected to the network and
determine whether a quarantine action should take place.

The steps for integrating ISE with Tenable.sc consist of the following:

1. Create a machine account for ISE to log in into Tenable.sc to launch a scan. The device is
referred to as a machine account since it is used by a service and not a person.

2. Export the Tenable.sc Root and System certificates and import them to Cisco ISE. This step is to
ensure there are no errors when Cisco tries to contact Tenable over Hypertext Transfer Protocol
Secure (HTTPS) for API calls.

3. Configure third-party threat integrations on Cisco ISE. This will start the process of creating the
integration with Tenable, including creating a Tenable adapter.

4. Configure the Tenable adapter. The adapter is the way Cisco ISE will communicate with Tenable,
so it needs to be configured to provide login credentials and connection options.

5. Configure an authorization profile. This configures Cisco ISE to assess vulnerabilities via the
newly created Tenable adapter.

Step-by-step guidance on integrating Cisco ISE with Tenable.sc is available here. Note: Your ISE instance
will need to be version 2.7 or higher.

Once the integration between Cisco ISE and Tenable is configured correctly, vulnerability data is
viewable for connected endpoints. To view vulnerability data for connected devices, go to Context
Visibility > Endpoints > Vulnerable Endpoints. The collected device information, such as the example in
Figure 5-1, shows the affected IP address, current user, Tenable plugin ID, and CVSS score.
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Figure 5-1 Cisco ISE View of Vulnerability Data for Connected Devices
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68 more vulnerabilities . .

The highest CVSS score associated with a device was utilized by the patching lab to create policy that would restrict network access to devices with a vulnerability that exceeded a CVSS threshold score of 7. This threshold was designed to
block devices that have high and critical severity scores.

NIST SP 1800-31C: Improving Enterprise Patching for General IT Systems



"[E-()()gI'dS'_|_S|N/SZOQ'OI/EJO'[Op//iSdllq ‘woJj aBJeqa JO 994} 9|qe|leAe s| uoneo”qnd SIyL

5.2.6 Cisco ISE Integration with Cisco Catalyst 9300 Switch

For our build, Cisco ISE contained an integration with a physical Cisco Catalyst 9300 switch located in the
lab network. This allowed Cisco ISE to perform 802.1x port-based authentication for devices that were
connected via ethernet. The build used this capability to authenticate devices to the network and then
later scanned authenticated devices to ensure they were at the appropriate patch level. The example
implementation applied 802.1x authentication to port 40 of a 48-port switch.

The following is an abbreviated version of the steps we performed in the lab to integrate ISE with the
Cisco Catalyst 9300 switch. For more detailed guidance, consult the following Cisco guide.

1. Access the admin console of the Cisco switch via a physical connection or remote protocol.

2. Go to global configuration mode by typing config t and then enter the following:
aaa new-model
i
aaa group server radius ise

server name ISE

aaa authentication dotlx default group ise
aaa authorization network default group ise
aaa accounting update newinfo periodic 1440

aaa accounting dotlx default start-stop group ise

aaa server radius dynamic-author

client 10.132.6.12 server-key password

aaa session-id common

switch 1 provision c9300-48p

!

radius-server attribute 6 on-for-login-auth
radius-server attribute 6 support-multiple
radius-server attribute 8 include-in-access-req

radius-server attribute 25 access-request include
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radius-server attribute 31 mac format ietf upper-case
radius-server attribute 31 send nas-port-detail

|

radius server ISE

address ipv4 10.132.6.12 auth-port 1645 acct-port 1646

key password

3. Configure interface 40 by typing interface Gi10/40 at the switch terminal and then entering
the following information:

switchport mode access

authentication event fail action next-method
authentication event server dead action authorize wvlan 1345
authentication event server dead action authorize voice
authentication event server alive action reinitialize
authentication host-mode multi-auth

authentication open

authentication order dotlx mab

authentication priority dotlx mab

authentication port-control auto

authentication periodic

authentication timer reauthenticate server
authentication violation restrict

mab

dotlx pae authenticator

dotlx timeout tx-period 10

spanning-tree portfast

4. Add the Cisco Switch to ISE by navigating to Administration > Network Resources > Network
Devices and clicking the Add button.

5. Inthe Network Devices field, fill out the information shown below to ensure that Cisco ISE
knows the IP address of the switch, network device group information, and has a name and
description for the new device.
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Network Devices List = CiscoSwitch

Network Devices

* Name | CiscoSwitch |

Description | Cisco Switch |

1P Address  w| “IP: [ 192.168.1.2 | i3z |

* Device Profile | Cisco | = | 5

T —
Software Version |:|

* Metwork Device Group

Location || ap | [ setToDefaut |
IPSEC |N0 | [ Set To Default |
Device Type |C|'sc0 | |  SetToDefault |

6. Ensure the RADIUS Authentication Settings box is checked, then fill out the information shown

below. Please note that the Share Secret field corresponds with the RADIUS server key field
from the last line of the configuration in step 2.
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~ RADIUS Authentication Settings

RADIUS UDP Settings

Protocol  RADIUS

* Shared Secret |........ | | Show :|

Use Second Shared Secrat [] i

[_show |
CoAPort | 1700 | [ set To Default |
RADIUS DTLS Settings (i
DTLS Required [ i
Shared Secret | radius/dtls i
CoAPort | 2083 | | setTo Default |
Issuer CA of ISE Certificates for CoA |Se-|ect if required (optional) v |

DNS Name

General Settings

Enable KeyWrap [

* Key Encryption Key Show
* Message Authenticator Code Key Show

Key Input Format  '® ASCII HEXADECIMAL

7. Next, select the checkbox by SNMP Settings, and fill out the information depicted below.
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+ SNMP Settings

* SNMP Version

* SNMP RO Community

Show

SNMP Usermname
Security Level v
Auth Protocol v
Auth Password Show
Privacy Protocol v

Privacy Password Show

* Polling Interval | 28,800 seconds (Valid Range 600 to 86400 or zero)

Link Trap Query
MAC Trap Query

* Originating Policy Services Node

8. Click Save.

5.2.7 Cisco ISE Policy Sets

Cisco ISE policy sets are policy-based rules that are written to group devices together. Group devices can
then have access control policies applied. Our build utilized policy sets to create rules that would apply
network access control policies to devices that did not meet the appropriate patch level. Guidance for
setting up policy sets can be found here.

5.2.7.1 VPN Policy Set

The following policy set was created for the build to enforce network restrictions on VPN devices that
did not meet the desired patching threshold. As a reminder, VPN devices were chosen because network
enforcement can only be performed on actively authenticated devices. The following steps walk through
setting up the patching example policy set:

1. Inthe Cisco ISE Web Console, click Policy > Policy Sets.
2. Click the Add icon.

3. Under the Policy Set Name field, enter: “VPN".

4. Click the plus (+) button under the Conditions field.

5. In the Editor field, select Click to add an attribute field.
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10.

11.

Tenable_Quarantine

Click the Network Device Button -

Click the Device Type attribute.

Under the Choose from list or type drop-down, select All Device Types#VPNDevice.
Click the Use button.

Click the arrow under View on the newly created VPN Policy.

Under the Authorization Policy — Global Exceptions tab, add the rule depicted below. It

indicates that if an endpoint has a vulnerability with a CVSS score greater than 7, the device

receives the Quarantined_Systems security group tag. This rule was placed into the Global

Exceptions tab because it allows these rules to be checked first. This is important, as it allows

rules in this category to override any rules that may grant network access to a device.

E Threat-Tenable Security Center-CVSS_Base_Score

MachineOnly + Quarantined_Systems x
GREATER_OR_EQUALS 7

5.2.7.2 Wired 802.1x Policy Set

The following policy set was created for the build to enforce network restrictions on wired 802.1x

connected devices that did not meet the desired patching threshold. The following steps walk through

setting up the patching example policy set:

1.

2.

In the Cisco ISE Web Console, click Policy > Policy Sets.

Click the Add icon.

Under the Policy Set Name field, type: Wired.

Click the plus (+) button under the Conditions field.

In the Editor field, select Click to add an attribute field.

Click and drag over the Wired_802.1X and Wired_MAB conditions from the Library field.
Click the Use button.

Click the arrow under View on the newly created Wired policy.

Under the Authentication Policy tab, add the policy depicted below. It allows Cisco ISE to
authenticate 802.1x users against an identity store. The identity store we used was our AD
users.
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V¥ Authentication Policy (4)

+ Status Rule Name Conditions Use Hits Actions
Internal Users x v

Vs ® Wired1x B  wired_802.1X 24028 o
> Options

10. Under the Authorization Policy tab, three new rules need to be created, as the screenshot
below depicts. The Posture-NonCompliant rule says that devices that are assessed and deemed
not compliant should be assigned the Quarantined_Systems security group tag. The Posture rule
says that devices that are marked compliant should be permitted access to the network and
assigned an employee group tag. The Posture-Unknown rule states that devices that have an
unknown posture, meaning the device has yet to be assessed by Cisco ISE, should be redirected
to install the posture assessment module.

Rule Name Conditions Profiles Security Groups

Posture-NonCompliant Z Non_Compliant_Devices « NonCompliantAccept + Quarantined_Systems x v

x PermitAccess
Compliant_Devices + Employees x v o
Tenable_Accept

Posture

[

Posture-Unknown Compliance_Unknown_Devices posture-redirect o Unknown x v

(o

5.2.8 Client Provisioning Policy

The Cisco AnyConnect module is used by ISE to perform posture assessments of 802.1X and VPN
connected devices. To ensure that users can be provisioned with the latest version of the AnyConnect
module, the Client Provisioning Policy needs to be set up for Windows and macOS devices. Our build
downloaded the Cisco AnyConnect Module to the machine administrating ISE, from the following Cisco
download page, and uploaded the resource during the creation of the Client Provisioning Policy.

Under the Client Provisioning Policy field, the Windows and MAC OS fields were edited as shown in
Figure 5-2 to provide access for endpoints to download the AnyConnect Module. For more detailed
information regarding setting up Client Provisioning Resources, please consult the following page.
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Figure 5-2 Examples of Client Provisioning Policies

Windows Any Windows All Condition(s) AnyConnect
Configuration And
WinSPWizard 2.5.0.1
And Cisco-ISE-NSP

MAC OS Any Mac OSX Condition(s) CiscoTemporalAgentOS
X 4.7.00135 And
MacOsXSPWizard
2.1.0.42 And Cisco-ISE-
NSP

5.2.9 Posture Assessment

The lab instance utilized Cisco ISE’s ability to perform posture assessments to determine the patch level
of connected devices. This collected information was used to meet the use case for isolating
unpatchable assets. We configured ISE to perform a posture assessment of a physical Windows laptop.
The posture assessment agent was configured to check if Windows Update reported any missing critical
patches before letting a device join the network. The steps below provide an overview of the work
performed in the lab instance to configure Posture Assessment; more information can be found at the
following page.

1. Inthe Cisco ISE Web console, click Policy > Posture.

2. Under the last rule in the list, click the drop-down arrow by the Edit button and click Insert New
Policy.

3. Inthe policy field, fill out the information as shown below and click Save. The policy states that
users from any policy group running any version of Windows using the AnyConnect Compliance
Module will be subjected to a WinPatching rule that will check for Windows updates.

Policy Options Update_Windows Any Windows All 4.x or later AnyConnect WinPatching

4. Click Policy > Policy Elements > Posture > Patch Management Condition to add a new patch
management condition. This step configures AnyConnect to check for missing patches for
Important and Critical updates on endpoints against Windows Update Agent. Configure the
Patch Management Condition with the information shown below.
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Patch Management Condition

*Name | windowsUpdatd |

Description | |

* Operating System
* Compliance Module | 4.x or later v|
* Vendor Name | Microsoft Corporation v|

Check Type O Installation (O Enabled ® Up to Date

Check patches installed | Important & critical V|

¥ Products for Selected Vendor

Product Name 4 | Version Enabled Checked Support Update Checked Support Minimum Compliant Medule Support
Microsoft Intune Client 5x NO NO 425200
Microsoft Intune ManagementE...  1x NO NO 4.3.2290.6145
[] System Center Configuration Ma... 4.x YES YES 4213310
[] System Center Configuration Ma... 5.x YES YES 4.2520.0
Windows Update Agent 10x YES YES 425200
] Windows Update Agent 7. YES YES 42520.0
5. Next, in the ISE interface click Policy > Policy Elements > Results > Posture > Remediation
Action. This step configures ISE to perform remediation actions on devices that are deemed
non-compliant. Under the last rule in the list, click the drop-down arrow by the Edit button and
then click Insert New Requirement. Add the following:
WinPatching Windows All 4 .x or later AnyConnect MS WindowsUpdate

6.

Click Save to save the new requirement.

5.2.10 Cisco FTD Firewall Rules

The Cisco FTD firewall rules were used to enforce network restrictions on the quarantined systems using
the Quarantined_Systems security group tag in our build. The following steps create a basic
enforcement rule:

1.

2.

On the Cisco FMC web console, click Policies > Access Control.
Click New Policy.

Fill out the New Policy Form with the information below. The default action for the policy is
network discovery. Network discovery allows for traffic to be monitored by the firewall only
without blocking traffic. This monitored traffic is then collected and can be utilized by network
admins to create organizational firewall rules. Once firewall rules are in place for your
organization, this item can be changed to block all traffic.
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New Policy Q

Name:

| MNetwork Control |

Description:
| |

Select Base Policy:

| MNone v |

Default Action:
) Block all traffic

() Intrusion Prevention

(@) Network Discovery

Targeted Devices
Select devices to which you want to apply this policy.

Available Devices Selected Devices
| Q_ Search by name or value | Patching Firewall u
| Add to Policy
4. Click Save.

s

5. Click the edit button on the newly created rule.

6. Click the Add Rule button.

7. Under the Zones category, add the information in the screenshot below. The rule states that
traffic that is coming from anywhere will be allowed to the VendorProducts zone, which
contains the vendor-supplied patching products that were utilized in this build. This rule ensures
that quarantined systems can still receive patches and updates from the appropriate patching
system.
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Editing Rule - Tenable_Quarantine

Name

| Tenable_Quarantine | Enabled Move

Action

| © Allow v | B

Zones Networks VLAN Tags Users Applications Ports URLs SGT/ISE Attributes

Available Zones ¢ Source Zones (0)

Inspection Logging Comments

Destination Zones (1)

| Q_ Search by name | any

BackupLAN - Add to Source
Endpoints Add to Destination

Inside_Zone

Outside_Zone
PhysicalWorkstations
SharedServices
VendorNet

VendorProducts

VendorProducts

o

8. Under the SGT/ISE Attributes tab, fill out the fields with the information in the screenshot. This
applies the network access control from step 7 only to traffic that originates from a machine

with the Quarantined_Systems security group tag.

Editing Rule - Tenable_Quarantine

Name

| Tenable_Quarantine | Enabled Move

Action

| © Allow v | =]

Zones Networks VLAN Tags Users Applications Ports URLs SGT/ISE Attributes |

Available Metadata Selected Source Metadata (1)

Inspection Logging Comments

Selected Dest Metadata (0)

‘ Q_ Search by name or value | Quarantined_Systems

o

l Security Group Tag v ‘

ANY =
Auditors

BYOD

Contractors

Developers

Development_Servers

DomainComputers

any

Employees v

Add a Location IP Address | I Add ]

9. Click Save.

10. Click the Add Rule button to add an additional rule.
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11. Edit the Zones tab with the information in the screenshot. This rule causes any traffic that has
the Quarantined_Systems security group tag to be blocked from traversing the network.

Editing Rule - TenableQuarantineBlock o

Name
[ TenableQuarantingBlock| | Enabled Move

Action

@ Block - B

Zones Networks VLAN Tags Users Applications Ports URLs SGT/ISE Attributes Inspection Logging Comments

Available Zones ' Source Zones (0) Destination Zones (0)
Q Search by name any any

BackupLAN

Endpoints

Inside_Zone

Outside_Zone

PhysicalWorkstations

SharedServices

VendorNet

VendorProducts

12. Under the SGT/ISE Attributes tab, add the Quarantined_Systems security group tag to Selected
Source Metadata, like in step 8.

5.3 Cisco Maintenance

All Cisco products should be kept up to date. You are required to have an active Cisco account to
download updated software. Software for all Cisco products can be downloaded from here. Follow the
guidance on the following pages to upgrade the Cisco product of your choice:

=  Upgrade Cisco Firepower Management Center

=  Upgrade Cisco Firepower Threat Defense

=  Upgrade Cisco Identity Services Engine

In this implementation, we used Microsoft Endpoint Configuration Manager to perform configuration
management, including software and firmware patching. Microsoft Endpoint Configuration Manager
also provided discovery capabilities for endpoints and the capability to respond to emergency scenarios,
such as providing a temporary mitigation or an emergency patch.
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6.1 Microsoft Installation and Configuration

Our implementation utilized a standalone deployment of Microsoft Endpoint Configuration Manager
with a separate instance of the database server running Microsoft SQL 2019. The Microsoft Endpoint
Configuration Manager was configured to manage multiple Windows-based hosts within the lab
environment. The standalone server hosting the Microsoft Endpoint Configuration Manager and the SQL
Server were running Windows Server 2019. Each of these servers was joined to the lab Domain
Controller, allowing Microsoft Endpoint Configuration Manager to utilize the services the Domain
Controller provided. Information on how to determine the correct deployment for your environment
can be found here.

Our implementation of Endpoint Configuration Manager consisted of multiple components, including:

=  Windows Server Update Services (WSUS), an update service primarily used for downloading,
distributing, and managing updates for Microsoft Windows-based systems. Information on how
to deploy the WSUS role on Windows Server 2019 can be found here.

=  Microsoft SQL Server, which served as a database for the Endpoint Configuration Manager
sites. The sites are where most of the data for the Endpoint Configuration Manager product is
stored. Information on how to deploy Microsoft SQL Server 2019 can be found here.

= Microsoft Endpoint Configuration Manager site server, which hosted the core functionality of
Endpoint Configuration Manager. Microsoft Endpoint Configuration Manager sites are used to
manage endpoints. Information on how to deploy the Endpoint Configuration Manager sites
can be found here.

=  Microsoft Endpoint Configuration Manager console, which was needed to perform
administration tasks and was the interface for interacting with the Endpoint Configuration
Manager sites. Information on how to deploy the Endpoint Configuration Manager console can
be found here.

6.2 Device Discovery

In our implementation, we utilized Heartbeat Discovery, AD System, and AD Group Discovery. Heartbeat
Discovery functioned by having the Microsoft Endpoint Configuration Manager agent on the endpoint
periodically communicate with the Microsoft Endpoint Configuration Manager server. AD System and
AD Group Discovery took advantage of the Enterprise Patching domain and retrieved domain
information from the directory server on computers joined to the domain and groups.

More information on how to set up device discovery capabilities can be found here.

6.3 Patching Endpoints with Microsoft Endpoint Configuration Manager

For our implementation, Microsoft Endpoint Configuration Manager was configured to support software
updates to Windows devices. More information on how to do this can be found here.
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Our deployment relied on third-party updates to deploy non-Microsoft-based software updates. The
implementation subscribed to update catalogues that supported software updates for firmware. More
information on how to configure third-party updates can be found here.

Although there are multiple methods for distributing patches, our deployment utilized the manual
method for deploying software updates. This method applied to both third-party updates and updates
from Microsoft. This was achieved by first downloading the software updates we wanted to deploy from
the “All Software Updates” view, as Figure 6-1 shows. From this view you can download the software
updates you want to deploy.
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Figure 6-1 All Software Updates View for Microsoft Endpoint Configuration Manager

Falder Taols | Microsoft Endpaint Configuration Manager (Connected to PE1 - Patching the Enterprise) — O X
Home ‘ Falder ~@ M -
o ? ] _Q £ g / Edit Membership Z? " "y D
o — = - &) Review License L ' @ L
Synchronize Run Schedule Saved Download Create Software Publish Third-Party Deploy Create Phased Move Properties
Software Updates Summarization Summarization Searches ~ Update Group Software Update Content Deployment
All Software Updates Reports Search Update Deployment Move Properties
I 6 = | @' Y » Software Library » OCwverview » Software Updates »  All Software Updates - ’;
Software Library < All Software Updates 1000 items
4 ﬁ[ Overview There are too many results, Marrow your results using search, or click OK to view a maximum of 100000 results. oK | | Cancel
» [ Application Management Search ~ Search | Add Criteria ~
4[] Software Updat = -
e lcan Title Article I | Required | Installed = Percent Compliant Downloaded =
] All Software Updates B  Security Intelligence Update for Microsoft Security Essentials - KE2310138 (Version 1.342,1507.0) 2310138 0 0 56 No
%1 Software Update Groups & 2021-02 Security and Quality Rollup for NET Framewark 2.0, 3.0, 4.5.2, 4.6 for Windows Server 2008 SP... 4603005 0 0 58 Neo
Deployment Packages & 2021-02 Security and Quality Rollup for NET Framewaork 3.5.1, 4.5.2, 46, 46,1, 4.6.2, 47 47.1,47.2, 4.8.. 4803002 O 0 8a Mo
,5_" Automatic Deployment Rules lf?_[ 2021-02 Security and Quality Rellup for NET Framewcrk 3.5.1, 45.2, 456, 4.6.1, 462, 47 47,1, 47.2 4.8... 4803002 0O 0 &2 Mo
LE Third-Party Software Update Catalogs | 2020-10 Security and Quality Rollup for NET Framework 3.5.1, 4.5.2, 46, 4.6.1, 462 47 47.1,47.2, 458.. 4579977 O 0 83 MNo
» ] Operating Systems '=_'[ 2021-06 Security and Quality Rollup for NET Frameweork 3.5.1, 4.5.2, 45, 4.6.1, 462, 4.7 47,1, 47.2 4.8... 50037792 O 0 82 Mo
» ] Windows 10 Servicing '}?_[ 2021-02 Security Only Update for MET Framework 4.6, 4.6.1, 4.6.2, 47 4.7.1, 47.2, 4.8 for Windows Serv.. 4602958 0 0 &8 Mo
b Bl Bektop Anekglics Sericing & 2021-02 Security and Quality Rollup for NET Framewaork 3.5.1, 4.5.2, 46, 46,1, 4.6.2, 47 47.1,47.2, 48... 4803002 O 0 =t Mo
» ] Microsoft Edge Management 'f?_[ Security Update for Microscft Office 2016 (KB5001951) 84-Bit Edition 5001951 0 0 &2 Mo
) _ T . | Security Update for Microscft Office 2016 (KB5001950) 64-Bit Edition 5001930 0 0 g2 Mo
| Office ient Managemen
k e '=_'[ 2021-06 Curnulative Update for .NET Frarmework 3.5 and 4.8 for Windows Server, version 2004 for ARM... 3003234 0 0 a3 Mo
Seri
cripts '=_'[ 2021-06 Curnulative Update for .NET Frarmework 3.5 and 4.8 for Windows 10 Version 20H2 for x84 (KB5... 5003234 0 0 itid Mo
ﬁ'[ 2021-06 Curnulative Update for .NET Frarmework 3.5 and 4.7.2 for Windows 10 Version 18009 for ARME4... 5003778 0 0 82 Mo
# Assets and Compliance | 2021-06 Security and Quality Rollup for NET Framewaork 3.5, 4.5.2, 4.6, 461, 46.2, 47 471, 472, 481, 5003781 O 0 82 MNo
ﬂ 2021-06 Curnulative Update for .NET Framework 3.5 and 4.8 for Microsoft server operating system for x.. 3003329 0 0 ga Mo
Tﬁ Software Library | 2021-06 Cumulative Update for .NET Framewark 4.8 for Windows 10 Version 1607 (KB5003542) 5003542 0 0 88 No
_.. Meonitoring lf?_[ 2020-09 Security Cnly Update for MET Framework £.8 for Windows Embedded Standard 7 (KE4576490) 4576490 0 0 a3 Mo
T- lf?_[ 2020-09 Security Only Update for MET Framework 4.8 for Windows Server 2008 R2 for x64 (KB4576400) 4576490 O 0 82 Mo
+|, Administrati
[; Administration T Security Update for Microsoft SharePoint Foundation 2013 (KB5001962) 5001962 0 0 88 No
g Cnmmuniw "E|'I’ - e U o (W Fioore ST SR ASA AR ST Pite T 1 ™ [t ta T Ka ol o ~ ~ sl B | ,
T Security Update for Microsoft Word 2013 (KB5001931) 64-Bit Edition »
Ready
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From this view you can download the software updates you want to deploy. The next step we
performed was creating a new deployment package. Figure 6-2 provides an example of this.

Figure 6-2 Creating a New Deployment Package with Microsoft Endpoint Configuration Manager

Specify a deployment package

The deployment package contains the software update files that will be available to clients as part of the
deployment. You can select an existing deployment package or create a new one.

() Select a deployment package:

(@) Create a new deployment package:

Mame:
|Test Deployment5

Description:

Package source (Example): “\<server='«folder path:>
| hareWMN02%LabShare " Products Microsoft - ConfigMar Test DEp|U}TI‘|E.'I‘ItH| Browse...

[] Enable binary differertial replication

To minimize the network traffic between sites, binany differential replication updates only the content
that has changed in the package.

Mext = Cancel

After creating a deployment package, the updates can be distributed to endpoints by adding the
deployment package to a software update group. More information on how to use this method can be
found here.
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For instances where updates need to be deployed more quickly, deployments can be specified with
immediate delivery by changing the deployment type to Required. See Figure 6-3 showing the settings
for an example deployment.

Figure 6-3 Deployment Settings

Specify deployment settings for this deployment

Specify if this deployment is available for installation or if it iz a required installation.

Type of deployment: Requied -

[] Use Wake-on-LAN to wake up clients for required deployments

State message detail level.

You can specify the state message detail level retumed by clients far this software update deployment.

Detail level: |Or1h.r success and emor messages >

< Previous Mext = Cancel

This forces the update to be installed based on the schedule specified in the deployment. For immediate
updates, select As soon as possible when configuring the schedule for deployment. Figure 6-4 shows the

schedule details for an example deployment.
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Figure 6-4 Deployment Schedule

Configure schedule details for this deployment

Schedule evaluation
Specify if the schedule for this deployment is evaluated based upon Universal Coordinated Time (UTC) or the local time of
the client.

Time based on: Client local time >

Software available time

Specify when software updates are available. Software updates are available as soon as they are distibuted to the content
server unless they are scheduled to install at a later time.

(@) As soon as possible
() Specific time:

77262021 547 PM

4k

Installation deadline

Specify an installation deadline for required software updates. You can determine the deadline by adding the deadline time
to the installation time. When the deadline is reached, required software updates are installed on the device and the
device is restarted if necessary.

{®) As soon as possible

() Specific time:
Deadline time:

| 8/ 272021 |

947 PM

4k

[] Delay enforcement of this deployment according to user preferences, up to the grace period defined in client settings.

< Previous Mext = Cancel

Our deployment also relied on Endpoint Configuration Manager’s ability to deploy a PowerShell script to
endpoints for emergency mitigation scenarios. We utilized a script that uninstalled Java on the endpoint
on which the script is run. More information on how to deploy PowerShell scripts can be found here.

The script we uploaded into Microsoft Endpoint Configuration Manager for the build was:

gwmi Win32 Product -filter "name like 'Java%'" | % { $_.Uninstall() }
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Our deployment relied on Microsoft Endpoint Configuration Manager’s ability to deploy scripts directly
to endpoints. This was achieved by selecting an endpoint from the Devices view and selecting the Run
Script option, as Figure 6-5 illustrates.

Figure 6-5 Devices View with Run Script Option Selected

E"] Microsoft Endpoint Configuration Manager (Connected to PE1 - Patching the Enterprise)

-7 Home
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6.4 Microsoft Reporting

We utilized the reporting capabilities of Microsoft Endpoint Configuration Manager to determine which
Windows patches and third-party updates were available for endpoints. Information on configuring
those reporting capabilities can be found here.

The build utilized the available Software Updates reports from Microsoft Endpoint Configuration
Manager to determine specific software updates that were available for endpoints. An example of a
report used for this to determine what critical third-party updates are available can be seen in Figure 6-
6.
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Figure 6-6 Report Showing Critical 3™ Party Updates Available for HP Business Clients

Collection: [SMSDM003 - Al Desktop and Server Clierts | Values..
Vendor: [HP Business Clients | Values..
Update Class: [Crtical Updates | Values..
< Back
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Microsoft Endpoint
Configuration Manager

Management 2 - Updates required but not deployed

Description

Title % Bulletin ID % ArticleID % Required +  %of Total % Information URL + UpdateID :
Cloud Recovery Client [2.6.3.1.A1] sp110846 2 12.50 30024850-0000-0000-5350-000000110846
HP BIOS and System Firmware (570, S73) sp112428 1 6.25 30004850-0000-0000-5350-000000112428
[01.04.02.A1]

HP Client Security Manager Gen7 [10.1.1.A1] sp113277 1 6.25 30004850-0000-0000-5350-000000113277
HP Firmware Pack (R77) [01.15.00.A1] sp112390 i 6.25 30004850-0000-0000-5350-000000112390
HP Sure Sense [1.2.36.0.A1] sp111577 1 6.25 30014850-0000-0000-5350-000000111577

6.5 Microsoft Maintenance

Microsoft Endpoint Configuration Manager utilizes in-console updates and servicing. This feature
automatically applies Microsoft-recommended updates that are relevant to your specific infrastructure
and configuration.

In this implementation, we used the Forescout platform to perform endpoint discovery. The Forescout
platform can perform endpoint discovery by detecting endpoints and determining software information
about those endpoints based on a set of attributes. The Forescout platform also provided the capability
to isolate or restrict unpatchable assets and to respond to emergency scenarios, such as providing a
temporary mitigation or deploying an emergency patch. This section explains how the Forescout
platform was utilized in this build.

7.1 Installation and Configuration of Enterprise Manager and Appliance

Our implementation of the Forescout platform utilized both the Forescout Enterprise Manager and
Forescout Appliance. Instructions for deploying these can be found here.

In our setup, the Enterprise Manager allowed for management of multiple Forescout Appliances.
Although our build only contained one appliance, we chose to utilize the Enterprise Manager to
demonstrate an enterprise environment and to enable adding more appliances to our build if needed.
The Forescout Appliance was deployed to have a dedicated virtual device for monitoring network traffic.
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Depending on the size of your network and your specific requirements, more than one physical or virtual
appliance may be recommended.

7.1.1 Installation via OVF

Instructions for deploying OVF templates that can be utilized as either an Enterprise Manager or
Forescout Appliance can be found here. The OVF installation method was used by the team for both the
Enterprise Manager and Appliance deployment; however, there are other installation methods available
that may be better suited for your environment.

7.1.2 Installation of Forescout Console and Initial Setup

The console application is required to complete the installation of the Forescout platform and to
administer the system. The console was installed on a dedicated VM running the Windows 10 OS. This
VM has network access to the Forescout Enterprise Manager and Appliance. The instructions for initial
installation and setup of the Forescout console can be found here.

7.2 Forescout Capabilities Enabled

After installation and initial setup, it is recommended to enable additional capabilities for the Forescout
platform to utilize. The capabilities enabled will depend on what services are available in your
environment for Forescout to integrate with. The following subsections cover the basic options the team
enabled and utilized in our build.

7.2.1 Network

The Forescout platform was configured to capture network traffic from the Forescout Appliance. Traffic
was collected from all the internal subnets from the lab environment. This allowed the Forescout
Appliance to identify hosts on our network by collecting network traffic from the virtual switch using a
mirror port. This allowed traffic to be collected from endpoints without requiring an agent or
communicating directly between the Forescout platform and the endpoints.

7.2.2 User Directory

The User Directory plugin was configured so that the Forescout platform integrated with the lab’s AD
Domain Controller. This plugin provided Lightweight Directory Access Protocol (LDAP) services to
Forescout, allowing directory-based users to log in into Forescout as well as providing user directory
information such as the current active domain users logged into each endpoint. More information about
this plugin can be found in the Authentication Module: User Directory Plugin Server and Guest
Management Configuration Guide.
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7.2.3 DNS Query Extension

This configuration setting allowed Forescout to query the DNS server to determine the hostnames of
devices identified by Forescout.

7.2.4 Tenable VM

The Tenable VM plugin provided the Forescout platform with vulnerability and scan status information
which can be used to create custom policies. This plugin also enabled Forescout to utilize vulnerability
management information that Tenable.sc collected from endpoints and allowed the Forescout platform
to determine if scans had been performed on endpoints within the lab. More information about the
Critical Vulnerability Quarantine policy, which utilizes the data from this policy, can be found in Section
7.3.3. Information on how this plugin can be installed and configured for your environment can be found
in the eyeExtend for Tenable Vulnerability Management Configuration quide.

7.2.5 Microsoft SMS/SCCM

The Microsoft Systems Management Server (SMS)/System Center Configuration Manager (SCCM)
module was configured to allow the Forescout platform to integrate with Microsoft Endpoint
Configuration Manager. This module allowed for a custom policy to be created that used data from
Microsoft Endpoint Configuration Manager. More information about the SCCM Agent Non Compliant
Check policy, which utilizes the data from this module, can be found in Section 7.3.6. In our build, this
module was primarily used to determine which hosts were running the Endpoint Configuration Manager
agent and therefore communicating with Microsoft Endpoint Configuration Manager. Information on
how this module can be installed and configured for your environment can be found in the Endpoint
Module: Microsoft SMS/SCCM Plugin Configuration quide.

7.2.6 Linux

The Linux plugin was configured to collect information from and manage Linux-based endpoints via two
methods: secure shell (SSH) access to the endpoints, and agent-based integration with the Linux
endpoint. Both these methods for collecting data from endpoints were implemented in the lab
environment. Information on how this plugin can be installed and configured for your environment can
be found in the Endpoint Module: Linux SCCM Plugin Configuration guide.

7.2.7 HPS Inspection Engine

The HPS Inspection Engine was configured to collect information from Windows endpoints via two
methods. The first method utilized a directory-based integration with the lab’s AD Domain Services
instance, which collected domain-based information on the Windows endpoint. The second method
utilized an agent-based integration called SecureConnector that allowed Forescout to collect and
manage Windows endpoints. The agent-based integration was deployed to endpoints by a Windows
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Installer (MSI) installer that was manually downloaded from the Enterprise Manager and installed on the
endpoint.

Multiple deployment methods can be utilized for installing the SecureConnector. Two methods that
were not utilized in this build are automatically deploying software utilizing a configuration
management tool and using a corporate image with the SecureConnector preinstalled when configuring
new endpoints for your environment.

Information on how the HPS Inspection Engine can be installed and configured for your environment can
be found in the Endpoint Module: HPS Inspection Engine Configuration guide.

7.2.8 pxGrid

The pxGrid plugin was configured to integrate with Cisco ISE. This plugin gave the Forescout Platform
the ability to utilize Cisco ISE to apply adaptive network control (ANC) policies to endpoints. ANC policies
can be used to control network access for endpoints. The ANC policies were enabled on Cisco ISE and
could be controlled by third-party systems such as the Forescout platform using pxGrid.

In this implementation, an ANC policy configured within Cisco ISE was used to apply a quarantine policy
against the host. For example, in the Critical Vulnerability Quarantine Policy in Section 7.3.3, Forescout
communicates to Cisco ISE to quarantine the host when critical vulnerabilities are found on the endpoint
via the Tenable VM plugin. After the Cisco ISE ANC policy is applied to a host, the device is assigned a
Quarantine security group tag by Cisco ISE. The pxGrid integration between ISE and the Cisco FTD
firewall allows for security group tags to be shared. This SGT is then applied by ISE, and network traffic
at layer 3 is controlled via firewall rules that were created in Section 5.2.7. Information on how this
plugin can be installed and configured for your environment can be found in the pxGrid Plugin
Configuration guide.

7.2.9 Switch

The Switch plugin was configured to integrate the Forescout platform with the physical Cisco switch
located in the lab. The plugin used information from the switch to collect information about endpoints
that were physically connected to the switch. Information on how this plugin can be installed and
configured for your environment can be found in the Network Module: Switch Plugin Confiquration

quide.

7.2.10 VMware vSphere/ESXi

Forescout can integrate with VMware vCenter or ESXi host via a plugin. Our build utilized this plugin to
collect information on what virtual hosts and appliances were running in support of the host discovery
scenario. We configured Forescout to collect information from a VMware ESXi host installed on a Dell
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R620 server in the lab environment. Information on how this plugin can be installed and configured can
be found on the following page.

The following is an overview of the steps for configuring the plugin:

1.

2.

4.

Open the Forescout Console and go to Options > Tools.
Select VMware vSphere from the left pane.
Select Add.

Fill out the resulting form with the requested parameters.

7.3 Policies

The project received policies from Forescout that are normally made available to a customer when they
purchase professional services from Forescout. These policies helped the team to discover, classify, and
assess endpoints on the lab network. More information on how to receive the professional services
policies can be found here.

To satisfy the scenarios outlined in the project description, the team also created the following custom
policies. More information on how to create custom policies can be found here.

7.3.1 Adobe Flash Player Removal Policy

The Adobe Flash Player Removal policy checks if Flash is running on a Windows Endpoint. If it is, this
policy will terminate the process running Flash and uninstall Flash by running the command
“uninstall flash player.exe -uninstall” on the endpoint.

<RULES>

<RULE APP_VERSION="8.2.2—

731" CACHE_TTL="259ZOO" CACHE_TTL_SYNCED="true" CLASSIFICATION="REG_STATUS" DES
CRIPTION=" " ENABLED="true" ID="-2605681954930199910" NAME="Adobe Flash Player
Removal"™ NOT COND UPDATE="true" UPGRADE PERFORMED="true">

<GROUP_IN FILTER>
<GROUP ID="1391284960034120761" NAME="Windows"/>
</GROUP_IN FILTER>

<INACTIVITY TTL TTL="0" USE DEFAULT="true"/>
<ADMISSION RESOLVE DELAY TTL="0" USE DEFAULT="true"/>
<MATCH TIMING RATE="28800" SKIP INACTIVE="true">
<ADMISSION ALL="true"/>

</MATCH_TIMING>
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<EXPRESSION EXPR TYPE="AND">
<!-- Rule expression. Rule name is: Adobe Flash Player Removal -->
<EXPRESSION EXPR TYPE="SIMPLE">

<CONDITION EMPTY LIST VALUE="false" FIELD NAME="process no_ext" LABEL="Windows
Processes Running" LEFT PARENTHESIS="0" LOGIC="AND" PLUGIN NAME="HPS Inspection
Engine" PLUGIN_UNIQUE NAME="va" PLUGIN_VESRION="11.1.2" PLUGIN_VESRION_NUMBER="
111020046"™ RET VALUE ON UKNOWN="UNMATCH" RIGHT PARENTHESIS="0">

<FILTER CASE SENSITIVE="false" FILTER ID="-
8737023325596837863" TYPE="contains">

<VALUE VALUE2="Flash"/>
</FILTER>

</CONDITION>

</EXPRESSION>

<EXPRESSION EXPR TYPE="SIMPLE">

<CONDITION EMPTY LIST VALUE="false" FIELD NAME="nbthost" LABEL="NetBIOS
Hostname" LEFT PARENTHESIS="O0" LOGIC="AND" PLUGIN NAME="NBT

Scanner" PLUGIN UNIQUE NAME="nbtscan plugin" PLUGIN VESRION="3.2.1" PLUGIN VESR
ION NUMBER="32010012" RET VALUE ON UKNOWN="IRRESOLVED" RIGHT PARENTHESIS="O0">

<FILTER CASE SENSITIVE="false" FILTER ID="-575936128989425039" TYPE="contains">
<VALUE VALUE2="PEWKWINSVRO2"/>

</FILTER>

</CONDITION>

</EXPRESSION>

</EXPRESSION>

<EXCEPTION NAME="ip" UNKNOWN EVAL="UNMATCH">
<RANGE FROM="10.131.5.2" TO="10.131.5.2"/>

<RANGE FROM="10.132.2.11"™ TO="10.132.2.11"/>
</EXCEPTION>

<EXCEPTION NAME="mac" UNKNOWN EVAL="UNMATCH"/>
<EXCEPTION NAME="nbthost" UNKNOWN EVAL="UNMATCH"/>
<EXCEPTION NAME="user" UNKNOWN EVAL="UNMATCH"/>
<EXCEPTION NAME="group" UNKNOWN EVAL="UNMATCH"/>

<ORIGIN NAME="CUSTOM"/>
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<UNMATCH TIMING RATE="28800" SKIP INACTIVE="true">
<ADMISSION ALL="true"/>

</UNMATCH_TIMING>

<SEGMENT ID="2960766429758300381" NAME="Endpoints">
<RANGE FROM="10.132.6.0" TO="10.132.6.255"/>

<RANGE FROM="10.151.40.0" TO="10.151.40.255"/>
<RANGE FROM="192.168.1.0" TO="192.168.1.255"/>
</SEGMENT>

<RULE_CHAIN>

<INNER RULE APP VERSION="8.2.2-

731" CACHE TTL="259200" CACHE TTL SYNCED="true" CLASSIFICATION="REG_STATUS" DES
CRIPTION="" ID="1600971908334654081" NAME="Runing

Flash" NOT COND UPDATE="true" RECHECK MAIN RULE DEF="true">

<MATCH TIMING RATE="28800" SKIP INACTIVE="true">
<ADMISSION ALL="true"/>

</MATCH_TIMING>

<EXPRESSION EXPR TYPE="SIMPLE">

<!-- Rule expression. Rule name is: Runing Flash -->

<CONDITION EMPTY LIST VALUE="false" FIELD NAME="process no ext" LABEL="Windows

Processes Running" LEFT PARENTHESIS="0" LOGIC="AND" PLUGIN NAME="HPS Inspection
Engine" PLUGIN UNIQUE NAME="va" PLUGIN VESRION="11.1.2" PLUGIN VESRION NUMBER="
111020046" RET VALUE ON UKNOWN="UNMATCH" RIGHT PARENTHESIS="O0">

<FILTER CASE_SENSITIVE="false" FILTER_ID="2547115646639713943" TYPE="contains">
<VALUE VALUE2="Flash"/>

</FILTER>

</CONDITION>

</EXPRESSION>

<ACTION DISABLED="false" NAME="add-to-group">

<PARAM NAME="temporary" VALUE="true"/>

<PARAM NAME="group-name" VALUE="id:-6458612277141846421;name:Adobe Flash
Running"/>

<PARAM NAME="item key" VALUE="mac or ip"/>

<PARAM NAME="comment" VALUE=""/>

NIST SP 1800-31C: Improving Enterprise Patching for General IT Systems 77



"T€-008T°dS LSIN/8209°0T/840°10p//:sd1Yy :woly 981eYd JO 9344 d|qe|ieAe s| uonealjgnd siyL

<SCHEDULE>

<START Class="Immediately"/>
<OCCURENCE onStart="true"/>
</SCHEDULE>

</ACTION>

</INNER RULE>

<INNER RULE APP_VERSION="8.2.2—

731" CACHE_TTL="259ZOO" CACHE TTL SYNCED="true" CLASSIFICATION="REG STATUS" DES
CRIPTION="Upload the uninstaller into the script repository and have it push to
the endpoint and execute it with the silent uninstall option?
https://fpdownload.macromedia.com/get/flashplayer/current/support/uninstall fla
sh player.exe uninstall flash player.exe -uninstall Or to uninstall a specific
player type (ActiveX, NPAPI, or PPAPI), use the following:
uninstall flash player.exe -uninstall activex uninstall flash player.exe -
uninstall plugin uninstall flash player.exe -uninstall pepperplugin" ID="-
7555287754841043925" NAME="Uninstall Adobe

Flash" NOT COND UPDATE="true" RECHECK MAIN RULE DEF="true">

<MATCH_ TIMING RATE="28800" SKIP INACTIVE="true">

<ADMISSION ALL="true"/>

</MATCH_TIMING>

<EXPRESSION EXPR TYPE="SIMPLE">

<!-- Rule expression. Rule name is: Uninstall Adobe Flash -->

<CONDITION EMPTY LIST VALUE="false" FIELD NAME="process no_ ext" LABEL="Windows

Processes Running" LEFT PARENTHESIS="0" LOGIC="AND" PLUGIN NAME="HPS Inspection
Engine" PLUGIN_UNIQUE NAME="va" PLUGIN_VESRION="11.1.2" PLUGIN_VESRION_NUMBER="
111020046" RET VALUE ON UKNOWN="UNMATCH" RIGHT PARENTHESIS="0">

<FILTER CASE SENSITIVE="false" FILTER ID="2974243046085011295" TYPE="contains">
<VALUE VALUE2="FLASH"/>

</FILTER>

</CONDITTION>

</EXPRESSION>

<ACTION DISABLED="true" NAME="process_kill">

<PARAM NAME="process_name" VALUE="flash"/>

<SCHEDULE>

<START Class="Immediately"/>

<OCCURENCE onStart="true"/>
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</SCHEDULE>
</ACTION>
<ACTION DISABLED="true" NAME="run script">

<PARAM NAME="script howtorun ac" VALUE="uninstall flash player.exe -
uninstall"/>

<PARAM NAME="script interactive" VALUE="false"/>
<PARAM NAME="define time to run" VALUE="false"/>
<PARAM NAME="time to run" VALUE="1"/>

<SCHEDULE>

<START Class="Immediately"/>

<OCCURENCE onStart="true"/>

</SCHEDULE>

</ACTION>

</INNER_RULE>

</RULE_CHAIN>

<REPORT TABLES/>

</RULE>

</RULES>

7.3.2 Java Removal Policy

The Java Removal policy checks if Java is running on a Windows Endpoint. If it is, this policy will
terminate the process running Java and uninstall Java by running a script on the endpoint.

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<RULES>

<RULE APP VERSION="8.2.2-731" CACHE TTL="259200" CACHE TTL SYNCED="true"
CLASSIFICATION="REG STATUS" DESCRIPTION="&#10;&#10; &#10; &#10; "
ENABLED="true" ID="-1659136910494976646" NAME="Java Removal"
NOT COND UPDATE="true" UPGRADE PERFORMED="true">

<GROUP_IN FILTER>
<GROUP ID="1391284960034120761" NAME="Windows"/>

</GROUP_IN FILTER>

<INACTIVITY TTL TTL="0" USE DEFAULT="true"/>

<ADMISSION RESOLVE DELAY TTL="0" USE DEFAULT="true"/>
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<MATCH_ TIMING RATE="28800" SKIP INACTIVE="true">
<ADMISSION ALL="true"/>

</MATCH_TIMING>

<EXPRESSION EXPR TYPE="AND">
<!--Rule expression. Rule name is: Java Removal-->
<EXPRESSION EXPR TYPE="SIMPLE">

<CONDITION EMPTY LIST VALUE="false" FIELD NAME="process no ext"
LABEL="Windows Processes Running" LEFT PARENTHESIS="0" LOGIC="AND"
PLUGIN NAME="HPS Inspection Engine" PLUGIN UNIQUE NAME="va"
PLUGIN VESRION="11.1.2" PLUGIN VESRION NUMBER="111020046"
RET VALUE ON UKNOWN="UNMATCH" RIGHT PARENTHESIS="0">

<FILTER CASE SENSITIVE="false" FILTER_ID="3470905276050252920"
TYPE="contains">

<VALUE VALUE2="Java"/>
</FILTER>
</CONDITION>
</EXPRESSTION>
<EXPRESSION EXPR TYPE="SIMPLE">

<CONDITION EMPTY LIST VALUE="false" FIELD NAME="nbthost"
LABEL="NetBIOS Hostname" LEFT PARENTHESIS="0" LOGIC="AND" PLUGIN NAME="NBT
Scanner" PLUGIN UNIQUE NAME="nbtscan plugin" PLUGIN VESRION="3.2.1"
PLUGIN VESRION NUMBER="32010012" RET VALUE ON UKNOWN="IRRESOLVED"
RIGHT PARENTHESIS="0">

<FILTER CASE_SENSITIVE="false" FILTER_ID="—575936128989425039"
TYPE="contains">

<VALUE VALUE2="PEWKWINSVRO2"/>
</FILTER>
</CONDITION>
</EXPRESSION>
</EXPRESSION>
<EXCEPTION NAME="ip" UNKNOWN EVAL="UNMATCH">
<RANGE FROM="10.131.5.2" TO="10.131.5.2"/>
<RANGE FROM="10.132.2.11"™ TO="10.132.2.11"/>

</EXCEPTION>
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<EXCEPTION NAME="mac" UNKNOWN EVAL="UNMATCH"/>

<EXCEPTION NAME="nbthost" UNKNOWN EVAL="UNMATCH"/>

<EXCEPTION NAME="user" UNKNOWN EVAL="UNMATCH"/>

<EXCEPTION NAME="group" UNKNOWN EVAL="UNMATCH"/>

<ORIGIN NAME="CUSTOM"/>

<UNMATCH TIMING RATE="28800" SKIP INACTIVE="true">
<ADMISSION ALL="true"/>

</UNMATCH_ TIMING>

<SEGMENT ID="2960766429758300381" NAME="Endpoints">
<RANGE FROM="10.132.6.0" TO="10.132.6.255"/>
<RANGE FROM="10.151.40.0" TO="10.151.40.255"/>
<RANGE FROM="192.168.1.0" TO="192.168.1.255"/>

</SEGMENT>

<RULE_CHAIN>

<INNER RULE APP_VERSION="8.2.2-731" CACHE_TTL="259200"
CACHE TTL SYNCED="true" CLASSIFICATION="REG STATUS" DESCRIPTION="" ID="-
7312022728321489321" NAME="Uninstall Java" NOT COND_ UPDATE="true"
RECHECK MAIN RULE DEF="true">

<MATCH_ TIMING RATE="28800" SKIP INACTIVE="true">
<ADMISSION ALL="true"/>

</MATCH_TIMING>

<EXPRESSION EXPR TYPE="SIMPLE">

<!--Rule expression. Rule name is: Uninstall Java-->

<CONDITION EMPTY LIST VALUE="false" FIELD NAME="process no_ ext"

LABEL="Windows Processes Running" LEFT PARENTHESIS="0" LOGIC="AND"
PLUGIN NAME="HPS Inspection Engine" PLUGIN UNIQUE NAME="va"

PLUGIN VESRION="11.1.2" PLUGIN VESRION NUMBER="111020046"

RET VALUE ON UKNOWN="UNMATCH" RIGHT PARENTHESIS="0">

<FILTER CASE SENSITIVE="false"
FILTER ID="8761976385823184780" TYPE="contains">

<VALUE VALUE2="java"/>
</FILTER>
</CONDITION>

</EXPRESSION>
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<ACTION DISABLED="true" NAME="process kill">
<PARAM NAME="process name" VALUE="java"/>
<SCHEDULE>
<START Class="Immediately"/>
<OCCURENCE onStart="true"/>
</SCHEDULE>
</ACTION>

<ACTION DISABLED="false" NAME="run_script">

<PARAM NAME="script howtorun ac" VALUE="uninstall java.psl"/>

<PARAM NAME="script interactive" VALUE="false"/>
<PARAM NAME="define time to run" VALUE="false"/>
<PARAM NAME="time to run" VALUE="10"/>
<SCHEDULE>
<START Class="Immediately"/>
<OCCURENCE onStart="true"/>
</SCHEDULE>
</ACTION>
</INNER RULE>

<INNER RULE APP VERSION="8.2.2-731" CACHE_TTL="259200"
CACHE_TTL_SYNCED="true" CLASSIFICATION="REG STATUS" DESCRIPTION="" ID="-
8890693029182562272" NAME="Runing Java" NOT COND UPDATE="true"

RECHECK MAIN RULE DEF="true">

<MATCH TIMING RATE="28800" SKIP INACTIVE="true">
<ADMISSION ALL="true"/>

</MATCH_ TIMING>

<EXPRESSION EXPR TYPE="SIMPLE">

<!--Rule expression. Rule name is: Runing Java-->

<CONDITION EMPTY LIST VALUE="false" FIELD NAME="process no_ ext"

LABEL="Windows Processes Running" LEFT PARENTHESIS="0" LOGIC="AND"
PLUGIN NAME="HPS Inspection Engine" PLUGIN UNIQUE NAME="va"

PLUGIN VESRION="11.1.2" PLUGIN VESRION NUMBER="111020046"

RET VALUE ON UKNOWN="UNMATCH" RIGHT PARENTHESIS="0">

<FILTER CASE SENSITIVE="false"
FILTER ID="3138188613733535094" TYPE="contains">
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<VALUE VALUE2="Java"/>
</FILTER>
</CONDITION>
</EXPRESSION>
<ACTION DISABLED="false" NAME="add-to-group">
<PARAM NAME="temporary" VALUE="true"/>

<PARAM NAME="group-name" VALUE="id:-
3761570262828389651;name:Java Running"/>

<PARAM NAME="item key" VALUE="mac or ip"/>
<PARAM NAME="comment" VALUE=""/>
<SCHEDULE>
<START Class="Immediately"/>
<OCCURENCE onStart="true"/>
</SCHEDULE>
</ACTION>
</INNER_RULE>
</RULE_CHAIN>
<REPORT TABLES/>
</RULE>

</RULES>

7.3.3 Critical Vulnerability Quarantine Policy

The Critical Vulnerability Quarantine policy utilizes the Tenable VM plugin to determine if an endpoint
has any known critical vulnerabilities. If it does, this policy uses Cisco ISE to quarantine the endpoint by
utilizing the pxGrid plugin.

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<RULES>

<RULE APP VERSION="8.2.2-731" CACHE TTL="259200" CACHE TTL SYNCED="true"
CLASSIFICATION="REG STATUS" DESCRIPTION="" ENABLED="true" ID="-
663948591345721440" META TYPE="COMPLY" NAME="Forescout Critical Vulnerability
Quarantine" NOT COND UPDATE="true" UPGRADE PERFORMED="true">

<GROUP_IN FILTER/>

<INACTIVITY TTL TTL="0" USE DEFAULT="true"/>
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<ADMISSION RESOLVE DELAY TTL="0" USE DEFAULT="true"/>

<MATCH TIMING RATE="28800" SKIP INACTIVE="true">
<ADMISSION ALL="true"/>

</MATCH_TIMING>

<EXPRESSION EXPR TYPE="SIMPLE">

<!--Rule expression. Rule name is: Forescout Critical Vulnerability
Quarantine-->

<CONDITION EMPTY LIST VALUE="false" FIELD NAME="nbthost"
LABEL="NetBIOS Hostname" LEFT PARENTHESIS="0" LOGIC="AND" PLUGIN NAME="NBT
Scanner" PLUGIN UNIQUE NAME="nbtscan plugin" PLUGIN VESRION="3.2.1"
PLUGIN VESRION NUMBER="32010012" RET VALUE ON UKNOWN="IRRESOLVED"
RIGHT PARENTHESIS="0">

<FILTER CASE SENSITIVE="false" FILTER_ID="—847734611131793936"
TYPE="contains">

<VALUE VALUE2="PEWKWINSVRO2"/>
</FILTER>
</CONDITION>
</EXPRESSION>
<EXCEPTION NAME="ip" UNKNOWN EVAL="UNMATCH"/>
<EXCEPTION NAME="mac" UNKNOWN EVAL="UNMATCH"/>
<EXCEPTION NAME="nbthost" UNKNOWN EVAL="UNMATCH"/>
<EXCEPTION NAME="user" UNKNOWN EVAL="UNMATCH"/>
<EXCEPTION NAME="group" UNKNOWN EVAL="UNMATCH"/>
<ORIGIN NAME="CUSTOM"/>
<UNMATCH TIMING RATE="28800" SKIP INACTIVE="true">
<ADMISSION ALL="true"/>
</UNMATCH_ TIMING>
<SEGMENT ID="2960766429758300381" NAME="Endpoints">
<RANGE FROM="10.132.6.0" TO="10.132.6.255"/>
<RANGE FROM="10.151.40.0" TO="10.151.40.255"/>
<RANGE FROM="192.168.1.0" TO="192.168.1.255"/>
</SEGMENT>

<RULE_CHAIN>
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7.3.4

<INNER RULE APP VERSION="8.2.2-731" CACHE TTL="259200"

CACHE TTL SYNCED="true" CLASSIFICATION="REG STATUS" DESCRIPTION="" ID="-

7308160423478365115" NAME="CriticalVuln pxGrid Policy" NOT COND UPDATE="true"

RECHECK MAIN RULE DEF="true">
<MATCH_ TIMING RATE="28800" SKIP INACTIVE="true">
<ADMISSION ALL="true"/>
</MATCH_TIMING>
<META_ TYPE STATE="NA"/>
<ACTION DISABLED="false" NAME="apply anc policy">
<PARAM NAME="policy name" VALUE="Forescout"/>
<SCHEDULE>
<START Class="Immediately"/>
<OCCURENCE onStart="true"/>
</SCHEDULE>
</ACTION>

<ACTION DISABLED="false" NAME="balloon message">

<PARAM NAME="msg" VALUE="You have been quarantined.

update your computer or contact the helpdesk for assistence."/>
<PARAM NAME="look" VALUE="info"/>
<SCHEDULE>
<START Class="Immediately"/>
<OCCURENCE onStart="true"/>
</SCHEDULE>
</ACTION>
</INNER_RULE>
</RULE_CHAIN>
<REPORT TABLES/>
</RULE>

</RULES>

Force Windows Update Policy

Please

The Force Windows Update policy will force a Windows update on an endpoint with Windows Update

enabled by utilizing Forescout’s capability to determine if vulnerabilities exist on that endpoint.
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<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<RULES>

<RULE APP_VERSION="8.2.2-731" CACHE TTL="259200" CACHE TTL SYNCED="true"
CLASSIFICATION="REG STATUS" DESCRIPTION="&#10;&#10; &#10; &#10; "
ENABLED="true" ID="8956849743087666010" NAME="Force Windows Update"
NOT COND UPDATE="true" UPGRADE PERFORMED="true">

<GROUP_IN_FILTER/>
<INACTIVITY TTL TTL="O" USE_DEFAULT:"true"/>
<ADMISSION RESOLVE DELAY TTL="0" USE_DEFAULT="true"/>
<MATCH_ TIMING RATE="28800" SKIP INACTIVE="true">
<ADMISSION ALL="true"/>
</MATCH_TIMING>
<EXPRESSION EXPR TYPE="SIMPLE">
<!--Rule expression. Rule name is: Force Windows Update-->

<CONDITION EMPTY LIST VALUE="false" FIELD NAME="vulns"
LABEL="Microsoft Vulnerabilities" LEFT PARENTHESIS="0" LOGIC="AND"
PLUGIN NAME="HPS Inspection Engine" PLUGIN UNIQUE NAME="va"
PLUGIN VESRION="11.1.2" PLUGIN VESRION NUMBER="111020046"
RET VALUE ON UKNOWN="IRRESOLVED" RIGHT PARENTHESIS="Q">

<FILTER AUTO UPDATE="true" FILTER ID="-32838886002658939"
OPTIONS DIGEST="b3eaalOcf6dflfc550859e51703£f2665a">

<OPT VALUE="KB890830-141"/>
<OPT VALUE="KB890830-139"/>
<OPT VALUE="KB890830-144"/>
<OPT VALUE="KB890830-138"/>
<OPT VALUE="KB890830-143"/>
<OPT VALUE="KB890830-140"/>
<OPT VALUE="KB890830-148"/>
<OPT VALUE="KB890830-145"/>
<OPT VALUE="KB890830-136"/>
<OPT VALUE="KB890830-151"/>
<OPT VALUE="KB890830-146"/>
<OPT VALUE="KB890830-142"/>

<OPT VALUE="KB890830-147"/>
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<OPT VALUE="KB890830-31"/>
<OPT VALUE="KB890830-137"/>
<OPT VALUE="KB890830-150"/>
<OPT VALUE="KB890830-149"/>
</FILTER>
</CONDITION>
</EXPRESSION>
<ACTION DISABLED="false" NAME="remediate wua">
<PARAM NAME="update type" VALUE="keep update settings"/>
<PARAM NAME="wsus_target group" VALUE=""/>
<PARAM NAME="automatic updates type" VALUE="keep update settings"/>
<PARAM NAME="use default if disabled" VALUE="false"/>
<SCHEDULE>
<START Class="Immediately"/>
<OCCURENCE onStart="true"/>
</SCHEDULE>
</ACTION>
<EXCEPTION NAME="ip" UNKNOWN EVAL="UNMATCH">
<RANGE FROM="10.131.5.2" TO="10.131.5.2"/>
<RANGE FROM="10.132.2.11" TO="10.132.2.11"/>
</EXCEPTION>
<EXCEPTION NAME="mac" UNKNOWNiEVALZ"UNMATCH"/>
<EXCEPTION NAME="nbthost" UNKNOWNiEVALZ"UNMATCH"/>
<EXCEPTION NAME="user" UNKNOWNiEVALZ"UNMATCH"/>
<EXCEPTION NAME="group" UNKNOWN_EVAL:"UNMATCH"/>
<ORIGIN NAME="CUSTOM"/>
<UNMATCH TIMING RATE="28800" SKIP INACTIVE="true">
<ADMISSION ALL="true"/>
</UNMATCH TIMING>

<SEGMENT ID="2960766429758300381" NAME="Endpoints">
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7.3.5

<RANGE FROM="10.132.6.0" TO="10.132.6.255"/>
<RANGE FROM="10.151.40.0" TO="10.151.40.255"/>
<RANGE FROM="192.168.1.0" TO="192.168.1.255"/>
</SEGMENT>
<RULE_CHAIN/>
<REPORT TABLES/>
</RULE>

</RULES>

Agent Compliance Check Policy

The Agent Compliance Check policy will determine if a Windows endpoint has the Microsoft Endpoint
Configuration Manager agent installed by seeing if the endpoint has checked in with Endpoint
Configuration Manager.

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<RULES>

<RULE APP VERSION="8.2.2-731" CACHE TTL="259200" CACHE TTL SYNCED="true"
CLASSIFICATION="REG STATUS" DESCRIPTION="" ENABLED="true" ID="-
329523829728915879" NAME="SCCM Agent Compliance" NOT COND UPDATE="true"
UPGRADE PERFORMED="true">

<GROUP_IN FILTER>
<GROUP ID="1391284960034120761" NAME="Windows"/>
</GROUP_IN FILTER>
<INACTIVITY TTL TTL="O" USE_DEFAULT:"true"/>
<ADMISSION RESOLVE DELAY TTL="0" USE_DEFAULT="true"/>
<MATCH_ TIMING RATE="28800" SKIP INACTIVE="true">
<ADMISSION ALL="true"/>
</MATCH_TIMING>
<EXPRESSION EXPR TYPE="SIMPLE">
<!--Rule expression. Rule name is: SCCM Agent Compliance-->

<CONDITION EMPTY LIST VALUE="false" FIELD NAME="Client registered"
LABEL="SMS/SCCM Client Registration Status" LEFT_ PARENTHESIS="0" LOGIC="AND"
PLUGIN NAME="Microsoft SMS/SCCM" PLUGIN UNIQUE NAME="sms"
PLUGIN VESRION="2.4.4" PLUGIN VESRION NUMBER="24040014"
RET VALUE ON UKNOWN="IRRESOLVED" RIGHT PARENTHESIS="Q">
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<FILTER AUTO UPDATE="false" FILTER ID="8830579494271797354"
OPTIONS DIGEST="93e42278ee53b84£8427494bd2a235c6">

<OPT VALUE="db_found true"/>
</FILTER>
</CONDITION>
</EXPRESSION>
<ACTION DISABLED="false" NAME="add-to-group">
<PARAM NAME="temporary" VALUE="true"/>

<PARAM NAME="group-name" VALUE="id:8255406739413382154;name:SCCM
Client Registered"/>

<PARAM NAME="item key" VALUE="mac or ip"/>
<PARAM NAME="comment" VALUE=""/>
<SCHEDULE>
<START Class="Immediately"/>
<OCCURENCE onStart="true"/>
</SCHEDULE>
</ACTION>
<EXCEPTION NAME="ip" UNKNOWN_EVAL:"UNMATCH"/>
<EXCEPTION NAME="mac" UNKNOWN_EVAL="UNMATCH"/>
<EXCEPTION NAME="nbthost" UNKNOWNiEVALZ"UNMATCH"/>
<EXCEPTION NAME="user" UNKNOWN EVAL="UNMATCH"/>
<EXCEPTION NAME="group" UNKNOWN EVAL="UNMATCH"/>
<ORIGIN NAME="CUSTOM"/>
<UNMATCH TIMING RATE="28800" SKIP INACTIVE="true">
<ADMISSION ALL="true"/>
</UNMATCH_ TIMING>
<SEGMENT ID="2960766429758300381" NAME="Endpoints">
<RANGE FROM="10.132.6.0" TO="10.132.6.255"/>
<RANGE FROM="10.151.40.0" TO="10.151.40.255"/>
<RANGE FROM="192.168.1.0" TO="192.168.1.255"/>

</SEGMENT>
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<RULE_CHAIN/>
<REPORT_TABLES/>
</RULE>

</RULES>

7.3.6 SCCM Agent Non Compliant Check Policy

The SCCM Agent Non Compliant Check policy will determine if a Windows endpoint is non-compliant by
seeing if the endpoint has or has not checked into Microsoft Endpoint Configuration Manager.

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<RULES>

<RULE APP_VERSION="8.2.2—731" CACHE_TTL="259ZOO" CACHE TTL SYNCED="true"
CLASSIFICATION="REG STATUS" DESCRIPTION="" ENABLED="true"
ID="6927087801731630440" NAME="SCCM Agent Non Compliant Check"
NOT COND UPDATE="true" UPGRADE PERFORMED="true">

<GROUP71N7FILTER/>
<INACTIVITY TTL TTL="0" USE_DEFAULT="true"/>
<ADMISSION RESOLVE DELAY TTL="0" USE_DEFAULT="true"/>
<MATCH TIMING RATE="28800" SKIP INACTIVE="true">
<ADMISSION ALL="true"/>
</MATCH_TIMING>
<EXPRESSION EXPR TYPE="SIMPLE">
<!--Rule expression. Rule name is: SCCM Agent Non Compliant Check-->

<CONDITION EMPTY LIST VALUE="false" FIELD NAME="Client registered"
LABEL="SMS/SCCM Client Registration Status" LEFT PARENTHESIS="0" LOGIC="AND"
PLUGIN NAME="Microsoft SMS/SCCM" PLUGIN UNIQUE NAME="sms"
PLUGIN VESRION="2.4.4" PLUGIN VESRION NUMBER="24040014"
RET VALUE ON UKNOWN="IRRESOLVED" RIGHT PARENTHESIS="0">

<FILTER AUTO UPDATE="false" FILTER ID="-9113011034532548035"
OPTIONS DIGEST="93e42278ee53b84£8427494bd2a235c6">

<OPT VALUE="db found false"/>
</FILTER>
</CONDITION>
</EXPRESSTION>

<ACTION DISABLED="false" NAME="add-to-group">
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<PARAM NAME="temporary" VALUE="true"/>

<PARAM NAME="group-name" VALUE="1d:6514702438169432101;name:SCCM
Missing Agent"/>

<PARAM NAME="item key" VALUE="mac_or ip"/>
<PARAM NAME="comment" VALUE=""/>
<SCHEDULE>
<START Class="Immediately"/>
<OCCURENCE onStart="true"/>
</SCHEDULE>
</ACTION>
<EXCEPTION NAME="ip" UNKNOWN EVAL="UNMATCH"/>
<EXCEPTION NAME="mac" UNKNOWN EVAL="UNMATCH"/>
<EXCEPTION NAME="nbthost" UNKNOWN EVAL="UNMATCH"/>
<EXCEPTION NAME="user" UNKNOWN EVAL="UNMATCH"/>
<EXCEPTION NAME="group" UNKNOWN EVAL="UNMATCH"/>
<ORIGIN NAME="CUSTOM"/>
<UNMATCH TIMING RATE="28800" SKIP INACTIVE="true">
<ADMISSION ALL="true"/>
</UNMATCH TIMING>
<SEGMENT ID="2960766429758300381" NAME="Endpoints">
<RANGE FROM="10.132.6.0" TO="10.132.6.255"/>
<RANGE FROM="10.151.40.0" TO="10.151.40.255"/>
<RANGE FROM="192.168.1.0" TO="192.168.1.255"/>
</SEGMENT>
<RULE_CHAIN/>
<REPORT TABLES/>
</RULE>

</RULES>
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7.4 Forescout Maintenance

Forescout releases suggested updates and plugins in the Forescout Console and through its ActiveCare
Maintenance and Support policy.

We used two cloud-based IBM offerings for this build. One, IBM MaaS360 with Watson, was used for
endpoint management for desktop and laptop computers in the first phase, and for Android and iOS
mobile devices in the second phase. The second offering, the IBM Code Risk Analyzer, was used during
the second phase to scan source code in cloud-based containers for vulnerabilities. This section shows
how each cloud-based service was configured and used for the build.

8.1 IBM Code Risk Analyzer

The IBM Code Risk Analyzer, a feature of IBM Cloud Continuous Delivery for DevSecOps application
architectures, enables developers to quickly assess and remediate security and legal risks that they are

potentially introducing into source code and provides them direct actionable feedback. It works with
code repositories such as Git to analyze your application, perform a set of compliance control checks,
produce a bill of materials, and report vulnerability findings. Code Risk Analyzer is provided as a set of
Tekton tasks, which can be easily incorporated into delivery pipelines. Also, it is available as a managed
service on IBM Cloud, which eliminates the need to host your own infrastructure to run these delivery
pipelines. This section illustrates how we configured Code Risk Analyzer on IBM Cloud to embed and use
in development workflows.

8.1.1 Getting Ready

No software installation is required to use Code Risk Analyzer on IBM Cloud. However, make sure you
have an active IBM Cloud account.

All the Tekton pipeline definitions for Code Risk Analyzer are open-sourced and publicly available.

We used this sample cloud native micro-service application to demonstrate the configuration and

analysis via a delivery pipeline. You need to fork this application under your authorized account for the
code repository. If you have any other micro-service application, you can use that as well. Make sure
you have WRITE access to the code repository that you plan to use.

8.1.2 Creating Your Toolchain

Follow these steps to create and populate your toolchain:

1. Login to your IBM Cloud account and select DevOps from the service catalog on the left. The
dashboard for Toolchains opens.
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2. Select Create toolchain > Build your own toolchain. Give a name to your toolchain and click
Create.

3. Once the toolchain is created, it needs to be populated with developer tools. Click the Add tool
button to add the following tools to the toolchain:

a. Github (code repository for Code Risk Analyzer Tekton definition): configure it as shown
below. Note: For a first-time user, it will ask you to authorize IBM Cloud to access your
code repository account. This one-time authorization is necessary.

GitHub Server

GitHub (https://github.com)

Authorized as nadgowdas with access granted to deltasherlock GitHub organization(s) Manage Authorization
Repository type

Existing

Link to the repository that is specified in the Repository URL field.
Repository URL @D

https://github.com/open-toolchain/tekton-catalog

Git Integration Owner @

nadgowdas

[] Enable GitHub Issues @
[] Track deployment of code changes @
b. Github (code repository for our sample application): perform a similar integration as
above for your application repository.

c. DevOps Insights (required for authorization and integration): no configuration is
necessary, but make sure it is added to your Toolchain workspace.

d. Delivery Pipeline (automation engine for our pipeline): first give it a Name and select
“Tekton” as the Pipeline Type. The next section contains more detailed information on
pipeline configuration.

4. At this point, your toolchain workspace should have the tools depicted below.
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Code Deliver Learn
) 2 !
% s
GitHub Delivery Pipeline DevOps Insights
hello-containers NIST-Demo
) -~ No pipeline )
v Configured "' detected v Configured

O

GitHub
tekton-catalog

v Configured

8.1.3 Configuring Delivery Pipeline

The core logic of configuring Code Risk Analyzer is in the Delivery Pipeline. We need to perform four

sections of configuration:

1. Definition is where we specify the source for our Code Risk Analyzer pipeline definitions. To do

so, click Add multiple times to add the following list of locations for sources. When done, click

Save.
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Definitions

Tekton pipeline definitions are stored in source repositories. This list specifies the
repository information to be used for triggering pipeline runs.

Add +
Repository Commit Branch/Tag Path
tekton-catalog a603e135 master toolchain
tekton-catalog a603e135 master utils
tekton-catalog a603e135 master cra
tekton-catalog a603e135 master git
tekton-catalog a603e135 master cra/sample

2. Worker allows us to select the cluster where the pipeline should execute. We used a managed
Kubernetes worker on IBM Cloud to run our pipeline. To do so, select IBM Managed workers
from the drop-down list.

3. Trigger allows us to specify “when” or on which events we want to execute a Code Risk Analyzer
scan on a code repository. To configure this, select our sample application code repository, then

enable the option to run when a pull request is opened or updated.
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Triggers

Triggers specify what happens when a specified event occurs. Manual Triggers map to a Tekton Eventlistener resource. Git Triggers map git webhook events to a
Tekton EventListener. Timed triggers invoke the mapped Tekton EventListener at the specified time. In all cases the available listeners are those defined in the

pipeline definition.
Add trigger aF

~ 8  GitTrigger-0 T T @
@

Limit concurrent runs by this trigger

C ol

Max Concurrent Runs @
1 = +

Repository B4
hello-containers (https://github.com/nadgowdas/hello-containers.git) v

(® Branch (O Pattern

Branch

main v

Run jobs automatically for Git events on the chosen branch

[J when a commit is pushed
When a pull request is opened or updated

] when a pull request is closed
EventListener @

github-pr-listener (https://github.com/open-toolchain/tekton-catalog.git) v

4. Environment Properties allows you to store name-value pairs for use in your pipeline. For this
build, specify a Secure value type named apikey with the API_KEY for your IBM Cloud account.
You can create a new API_KEY with Manage > Access (IAM) -> API Keys.

At this point, your pipeline is successfully created and configured to be executed. As per our trigger
configuration, it will be automatically executed on any “Pull Request” on our application repository.

8.1.4 Executing the Developer Workflow

To demonstrate the developer workflow execution, perform the following steps:

1. Switch to the application repository.
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2. Make some code change and create a pull request against the “main” branch. This should
automatically trigger our Code Risk Analyzer pipeline on IBM Cloud. You can view the status of
our pipeline execution in our configured pipeline.

pipelinerun-73b3e78b-b4fl-4e2a-b2a4-07f1d661ac28 iactupdated 2 minutes ago

Running Tasks Completed: 5 (Failed: 0, Cancelled 0), Incomplete: 7, Skipped: 3 D

#3 Triggered by @ nadgowdas Git Trigger -0  Update Dockerfile for NIST Demo
o extract-repository-url @ eXtI’aCt'Vaer'jq Completed
@ extract-value-jq Duration: 1 second
° cra-fetch-repo v Logs Status Details
° cra-discovery-scan v
o cra-vulnerability-scan-status-pending v
@ cra-vulnerability-scan v
@ cra-vulnerability-scan-status-finished v
° cra-cis-set-status-pending v
@ cra-cis-check v
@ cra-cis-set-status-finished v

3. Once all these pipeline tasks finish, they emit their findings as git-comments to your original pull
request.

8.1.5 Reviewing the Code Risk Analyzer Results

After successful execution of our pipeline, you can find the following updates in your pull requests:

= Deployment Configuration Analysis. If there are any Kubernetes deployment manifests
(*.yaml) in the code repository, they are scanned against Docker CIS Benchmarks to identify
any failures to follow best practices.

=  Vulnerability Report. The Code Risk Analyzer allows you to discover vulnerabilities in your
application (Python, Node.js, Java, golang) and OS stack (base image) based on rich threat
intelligence from Snyk. It also provides fix recommendations, as the example below illustrates.
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nadgowdas commented 3 minutes ago Owner ) ( Author ) (©) ---

IBM Cloud Continuous Delivery Vulnerability Report

v Expand to reveal report findings
> Manifest File: Dockerfile-node:alpine-stage-0

v Manifest File: package-lock.json
Vulnerability Data by Snyk

Package Name: ansi-regex Version : 3.0.0

¥ Vulnerabilities
1. ID: CVE-2021-3807
Severity: high
Fixed in Version: 5.0.1
Description: Affected versions of this package are vulnerable to Regular Expression Denial of Service (ReDoS) due to
the sub-patterns [[\\1()#;21% and (2:;[-a-zA-Z\\d\\/#&.:=2%@~_1%)* .

= Bill of Materials. The Code Risk Analyzer generates a Bill of Materials (BoM) accounting for all
the dependencies and their sources for your application. The BoM is produced in JSON format.
The image below shows a portion of a BoM example.
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¥ root:
timestamp: "2021-10-04 18:16:22"
giturl: "https://github.com/nadgowdas/hello-containers"
gitbranch: "nadgowdas-patch-2"
commit_id: "74de01554d958f785ahleel5a67850f17f19c12a"
evidence_type: "gitsecure_bill_of_material"
description: "A bill-of-materials report generated by IBM Code Risk Analyzer"

v build_assets: [] 1item
v O:
manifest: "Dockerfile"
v stage: [] 1item
v O:

stage_name: "stage-0"
start_line: 1
end_line: 12
v base_image:
id: 1026331
name: "node"
tag: "alpine"
os_name: "alpine"
os_version: "3.13.6"
sha256: "sha256:a3c0a72e086ae7e73b6742b36hc9016c27f707801744aefdd4e316ffab693bbfc"
v os-packages: [] 15 items
v O:
name: "libcryptol.1"
version: "1.1.11-r0"
ecosystem: "os"
v 1:
name: "musl"
version: "1.2.2-r1"
ecosystem: "os"
source: "https"
v 2:
name: "apk-tools"
version: "2.12.7-r0"
ecosystem: "os"
v 3:
name: "ca-certificates-bundle"
version: "20191127-r5"
ecosystem: "os"
source: "https"

=  Git Status. In addition to git comments describing the security findings, Code Risk Analyzer also
assigns Pass/Fail status to the pull request. This allows the application owner to enforce policy-
based gates to automatically block code changes with security failures.

= Terraform Scan. Terraform is frequently used to define and configure cloud-based
infrastructure for proper application deployment. The Code Risk Analyzer also scans any
terraform provider files to detect compliance issues before actual deployment. Examples of
compliance checks include requirements for the minimum strength of passwords, and identity
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and access management (IAM) requirements for users and services. Code Risk Analyzer
supports the configuration of a profile for terraform scans; this enables choosing rule
parameters and which rules to run. An embedded JSON file in the Git repo can contain the
following properties, which are also illustrated in the screenshot below:

“scc_goals” - SCC goals to evaluate by goal ID

“scc_goal_parameters” - Parameter values for configurable SCC goals

"scc_goals": [
{ "scc_goal_id": "3@00010" },
{ "scc_goal_id": "3@00015" }

1,
"scc_goal_parameters": {
"no_of_managers_for_cloudant_db": 4

}

8.2 IBM MaaS360 with Watson Phase 1

IBM MaaS360 with Watson is a cloud-based platform that enterprises can utilize for enterprise mobile
device management (MDM) and desktop/laptop management. MaaS360 allows users to enroll
organization-owned and personal devices. Administrators can send enrollment requests to users,
centrally manage security policies, wipe corporate data, and push apps to devices. IBM MaaS360 is
operated using an online portal. The platform system requirements for IBM MaaS360 components like
client device OSs and web browsers are listed here.

Our build used this service for asset identification and assessment, routine and emergency patching,
emergency mitigations, and isolation of assets that cannot be patched. For the first phase of our build,
our managed devices were a MacBook Pro and a Windows 10 virtual desktop. For the second phase of
this project, Android and iOS mobile devices were managed.

MaaS360 provides a Quick Start guide for customers when logging in for the first time. The guide helps
with setting up device enrollment, establishing security policies, configuring corporate email, and
enrolling devices. For this lab, a corporate identifier was set up, as well as an internal AD (lab.nccoe.org),

as the default identification mode. The corporate identifier allows users to enroll their devices in
MaaS360. More information on configuration can be found here.

8.2.1 Enrolling Devices

IBM MaaS360 supports traditional endpoints running Windows 10 and up, as well as macOS endpoints.
Device enrollment is critical in helping enterprises register devices and apply device management
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policies that are specific to their organization. The IBM MaaS360 Portal handles all enrollment settings
for devices, apps, and users.

The device enrollment process is as follows:
1. Select SETUP, then choose Settings.

2. Click Device Enrollment Settings and set the corporate identifier that users will utilize to enroll
devices. It will also be shown in the enrollment URLs. In our lab, we set the identifier to
“nccoelab”. Additional device enrollment settings can be found here.

3. Open a web browser and proceed to the MaaS360 enrollment URL.
4. Enter your credentials.
5. Review and accept the terms and conditions.
6. Install the MDM profile.
Figure 8-1 provides a sample of enrolled devices utilized in this lab.

Figure 8-1 Sample of Enrolled Devices

[] Device Name Username Platform Model Operating Sy... Installed Date Last Reported
DESKTOP-BN5BE26 ) : Windows 10 01/13/2021 20:25 ® 07/19/2021 04:37

Ol ssksents o5 R tdiamond = VMware7,1 Enterprise LTSC 2019 UTC uTC

D Stephen's MacBook Pro bijohnson _L_' Mac Book Pro macOS Mojave 01/13/2021 19:39 04/07/2021 04:48

View Locate Message More... uTC uTC

See the linked pages for detailed enrollment instructions, including bulk enrollment, for macOS devices
and Windows devices.

8.2.2 Cloud Extender Installation

The IBM MaaS360 Cloud Extender allows enterprises to integrate mobile devices with corporate on-
premises and cloud-based resources. The Cloud Extender is installed on a Microsoft Windows server
behind the firewall to allow users and devices to use internal resources like directory services, file
shares, email, and applications.

In this lab, the Cloud Extender was installed on the AD server to allow users to log in with AD accounts.
The Maas360 portal provided links to the Cloud Extender software download, installation, and license
key generation; they were available on the SETUP menu under Enterprise Gateway, as Figure 8-2 shows.
The same line also pointed to a scaling tool that can aid administrators in calculating the number of
Cloud Extenders needed.
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More information about the requirements and instructions on installing the Cloud Extender can be
found here.

Figure 8-2 IBM Maas360 Cloud Extender Download

Enterprise Gateway

o
& ) Enterprise Gateway allows users to access various Corporate servers (Intranet Sites, Windows File Share, SharePoint) from their mobile devices. less

Available relays to use:

Download and install Cloud Extender. Generate license key. To know the number of Cloud Extenders required, use Cloud Extender Scaling Tool. |

Enable Intranet Site Access by selecting Secure Browser =» Intranet Access on the pop up

Define the list of Allowed Intranet Sites in Workplace Persona Policies. Assign Gateways to use also via policies.

oW o

Enable Intranet Content by selecting Mobile Content Management == Gateway for docs.
Use Windows File Share and Internal SharePoint for distribution to devices from DOCS > CONTENT SOURCES

Enable App Security (i.e. in App VPN) under Mobile Application Management by selecting WorkPlace App security and selecting the Gateway in Workplace Persona Policies

o

@

8.2.3 App Catalog and Distribution

This lab build sought to demonstrate how a tool like MaaS360 could be helpful in allowing
administrators to more easily distribute applications required for business operations to users. MaaS360
provides the ability to push applications to users by allowing administrators to build a customizable app
catalog. An app catalog makes it easier to distribute custom apps created by the organization. Also,
multiple versions of the same app can be pre-released to specific groups as a test before a full
deployment.

Lastly, the app catalog allows for the remote distribution, installation, uninstallation, updating, and
configuring of applications. The ability to remotely control apps is an important step in managing
updates and security for an enterprise’s patch management process. In MaaS360, applications must be
added to the app catalog before they can be deployed to devices. The following outlines the steps:

1. From the Maas360 Portal’s APPS menu, select Catalog.

2. Theimage below is a sample App Catalog page from this project’s build. To add an application,

click Add.
[0 App.. Name Type Categories Installs and Pendin.. Distributions App Bundle Approved .. VPP Codes Last Updated App Version
Lookout for Work @ - z
O - Utilities less than 10 e Yes No No 07/17/2021 07:01 UTC 6.14.0
View Distribute Delete More. -
O . Productivity less than 10 e Yes No Yes 07/16/2021 00:12 UTC 6.14.0.941
O - b4 Business less than 10 (] Yes No No 07/14/2021 07:07 UTC 4.40.20
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3. Next, select the kind of app that will be added. For this example, Windows Store App is

selected.
= i0s »
Android »
2
28 Windows v

=M Windows Store App
am

Search and pick from Windows Store

mm Enterprise App for Windows
-% Upload your own private enterprise Windows Phone or Desktop 05 App

i macD§ »

| mecos
E Web App
i

Add & browser URL (Wb Ciip)

App Bundles
1 Search and pick from your app catalog
4. Enter the desired app in the App field (for example, Slack) and select Add to complete the
process.

To distribute an app after it is added to the app catalog, select it from the App Catalog list, then click
Distribute.

Additional information on the app catalog and app installation can be found here.

8.2.4 Deploying Patches

This build utilized the capability of MaaS360 to provide alerts about required patches and take action to
remedy the issues. MaaS360 listed alerts on a dashboard on the Home Page, as illustrated in Figure 8-3.
The first half of the page utilizes colored tiles to demonstrate items in compliance (green) and those that
need attention (red). The information listed on these tiles can be customized. Below the security alert
tiles, there is a My Advisor with Watson section. Watson is an artificial intelligence tool developed by
IBM that scans the internet and other resources for the most recent trends in malware. It then lists any
threats found that are linked to devices that are enrolled in MaaS360. Additional information about the
MaaS360 Portal Home Page is listed here.
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Figure 8-3 MaaS360 Portal Home Page

My Alert Center ©® + c ©

Last Analyzed: Tuesday, July 20, 2021 §:09:45 PM UTC

: Security Alert: Needs Attention Security Alert: Mo Incidents Info only Alert
0 Recently Added 0 Mo Passcode 0 Jailbroken or Rooted
0 Out of Compliance 0 Roaming 0 EmailVPN/Wi-Fi Configuration Failure
O Risky Apps 1 Long Inactivity 0 Pending Approval
M'}" Advisor Q Witson All w~ Last180 Days (3, E

Risk Exposure: Windows Print Spooler Remote Code Execution Vulnerability

. Security updates released on and after July 6, 2021 contain protections for a remote code execution vulnerability in the Windows Print Spooler service (spoolsv.exe) known as "PrintMightmare” |, documented in
CVE-2021-34527
Learn mare

Risk Exposure: End of Support - MaasS360 VPN for Windows 10

. As of June 14, 2021, MaasS360 will be deprecating the support of its VPN for Windows. During a review of Maas5360 offerings, it was determined that the MaasS360 VPN for Windows was not up to our standards.
Therefore, we will be deprecating the support for Windows VPM, it will not impact i0S or Android.
Learn mare

Information: Windows Phone and Win 10 Maobile End of Life Support

0 As of May 24, 2021, Maas360 will no longer support WinPhone or Win 10 Mobile devices for enroliments, security updates, non-security hotfixes, policies, actions, or application distribution. Palicies will still be in
place, but changes will not be accommodated, and devices will not synch.
Learn mare
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MaaS360 allows administrators to apply and distribute patches to a single device or multiple devices.
The patches page for Windows and macOS devices lists the patches that are missing from devices.
Administrators are also able to see current patching schedules. For example, these steps were followed
in the lab to use MaaS360 to schedule deployment of patches:

1. Select SECURITY, then click OS Patches (Windows).

2. Select the Windows machines to be patched, then click Distribute to apply the patches.

The options shown in Table 8-1 were utilized to schedule automated patching.

Table 8-1 Values Specified for Scheduling Automated Patching

Distribution Setting
Distribute to

Value

Devices Missing
Patches

Explanation

Choose which device(s) to apply patching to. Select
from Single Device, Device Groups, or All Devices.

Start Date

12/04/2021

This field sets the date that the remediation step
will happen. This field was set to a future date so
that patches would be scheduled for deployment.

Start Time (0-23 Hrs)

01

This establishes the time of day that distribution
will start for selected devices.

Distribute Over (0-24 Hrs)

15

This causes patching to be staggered to reduce
network load by making updates available over a
set amount of time, in this case 15 hours, instead of
instantaneous availability for all users.

Action Expiry (in days)

The action will automatically expire after seven
days.

To distribute patches out of schedule for emergency remediation needs, the following options were

utilized:

= Start Date: The current date was chosen

= Start Time (0-23 Hrs): Immediate (causes the patch to be deployed immediately)

= Distribute Over (0-24 Hrs): Immediate

=  Action Expiry (in days): 7
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Distribute Patches

2021-01 Update for Windows 10 Version 1809 for x64-based Systems (KB4539208)

Distribution Settings Restart Settings

Start time and staggered distribute setlings are not applicable for DTM enrolled devices.

Distribute to . Devices Missing Pal ~

Start Date @ 07/23/2021 4
Start time (0-23 Hrs) g Immediate Ny
Distribute Over (0-24 Hrs) Immediate o
Action Expiry (in days) (i ] 7

More information about patch management with IBM MaaS360 is available here.

8.2.5 MaaS360 Maintenance

MaaS360 is a SaaS offering, so updates are continuously pushed out by IBM, who maintains the
platform.

8.3 IBM MaaS360 with Watson Phase 2

This section goes over phase 2 deployment of the lab instance utilizing MaaS360. The phase 2 build
utilized MaaS360 to administer Google Android and Apple iOS devices.

8.3.1 Enrolling Mobile Devices

In our build we enrolled mobile devices in both a supervised state (or corporate owned) and a bring-
your-own-device (BYOD) method. Corporate owned or supervised status means that organizations have
full control over the device, as opposed to BYOD where organizations only have control over the work
applications on the device. The following is an overview of how to enroll an iOS device in a supervised
state using the Apple configurator:
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1. Select Devices > Enrollments > Other Enroliment Options and select Apple Configurator from
the drop-down menu.

2. Select the Non-DEP only Enrollment URL (Note: DEP stands for Device Enrollment Program), and
copy the URL from the With Authentication tab.

3. Connect the Apple iPhone or iPad device to a MacBook and start the Apple Configurator.

4. Follow the wizard through specifying the MDM Server URL and certificates and assigning the de-
vice to an organization.

For more information on enrolling iOS devices in MaaS360 using Apple Configurator, review the
following page.

The lab instance enrolled Android devices manually using a QR code during device setup. The following
steps provide an overview for how to do this:

1. Click Devices > Enroliments > Other Enrollment Options > Android Enterprise QR Code
Provisioning.

2. Enter the requested information into the form that appears. Of note is the Android Enterprise
Mode options for Android Enterprise mode. The Device Owner option allows an organization to
have complete control over the device, while Work Profile on Corporate Owned allows
organizations to only manage apps under the work profile of the device.

3. During initial setup of the mobile device, tap the screen six times and then scan the QR code
displayed in the MaaS360 portal.

For more information on enrolling devices using a QR code, follow the information on this page.

While the lab instance utilized manual processes to enroll devices, MaaS360 also supports bulk
enrollment of Apple and Google devices. For information, consult the following links:

=  Bulk Enrolling Android devices using Android Zero Touch enrollment

=  Bulk Enrolling Apple devices using Apple Device Enrollment Program

8.3.2 Device Inventory

The Devices > Inventory tab lists all the devices that have been enrolled into MaaS360. The patching
instance utilized this tab to perform firmware and software discovery capabilities.

The firmware of enrolled devices is displayed directly on the device inventory list. The Operating System
field shows the detected OS on the device. Figure 8-4 shows the connected devices in the patching
instance with the OSes that were detected.
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Figure 8-4 Example of Enrolled Device Inventory

O

o 0O 0O O O

O

Device Name

nccoepatching-SM-G955U

View Locate Message More.

DESKTOP-BN5BE26
View Locate Lock More.

pixel5-Pixel 5

View Locate Message More.

iPhone

View Locate Message More.

NCCoE's iPad

View Locate Message More.

Stephen's MacBook Pro

View Locate Message More.

Username

Platform

R
g
R
(1
,
0

Model

SM-G955U

VMware7,1

Pixel 5

iPhone 12

iPad 8th Gen (WiFi)

Mac Book Pro

Operating System

Android 9
(PPR1.180610.011)

Windows 10 Enterprise
LTSC 2019

Android 11
(RQ1A.201205.011)

i0S 14

i0S 14

macOS Mojave

More detailed information regarding the installed OS and hardware information can be found under
View > Device Summary > Hardware & OS.

The installed applications on enrolled devices can be found by going to Device Inventory > View > Apps
Installed. The Apps Installed list shows all installed applications on a device. Figure 8-5 gives an example
of installed applications on a device. The list allows user-installed applications to be uninstalled by
administrators.
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Figure 8-5 Example of Installed Apps on a Mobile Device

* Excludes Android system apps (Typically these apps have an App |D that starts with com.google, com.android, com_htc, com.motorola, com.samsung, com.sec, com.lge, com.symhbol, com.zebra, com.asus, kr.co.m3mobile, com.m3, com.honeywell, com_bluebird, kr.co.bluebird, com.bluebirdcorp, com kyocera, jp.kyocera or com.panasonic).

On Android O devices, application size is not available.

w Apps Installed

Application Name App ID Full Version
Adreno Graphics Drivers com.gualcomm.gti.gpudrivers lito_api30 01.0
AppDirectedSMS COM.VErizon Services 12
CACertApp vendor.gti.hardware cacert.server 1.0

CneApp com.gualcomme.gti.cne 1.0

D-MAT com.verizon.obdm 200
Loockout for Work com.lookout.enterprise §.16.0.8985
Maa3360 cam.fiberlink. maas360_android.control 7.55

My Verizon Services COM.VErizon mips.samvicas 1.0137.11

For more information regarding the device inventory page, please consult the following page.

Application Size (MB)

NA

NA

NA

NA

NA

NA

NA

NA

Data Size (MB)

NA

NA

NA

NA

NA

NA

NA

NA

Managed

No

No

No

MNo

No

Installed by MDM

No

No

App Type

Pre-Installed

Pre-Installed

Pre-Installed

Pre-Installed

Pre-Installed

User Installed

User Installed

Pre-Installed

Install Location

Internal

Internal

Internal

Internal

Internal

Internal

Internal

Internal

Action

Remove App

Remove App
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8.3.3 Device Policies

The Security > Policies section of MaaS360 allows security policies and settings to be applied to devices
to make sure they comply with organizational policies. The lab instance utilized policies to ensure that
the Android devices had the MaaS360 and Lookout for Work applications, as well as to perform
automatic OS updates. Policies for Apple were configured to require the MaaS360 and Lookout for Work
applications.

To configure the Android Default Policy to support required apps and automatic updates, perform the
following steps:

1.

2.

Click Security > Policies.

Under Default Android MDM Policy, click View.

Under the Android Enterprise Settings field, click App Compliance.
Click the Edit button.

Select Configure Required Apps.

Under Application Name, type the following:
app:com.fiberlink.maas360.android.control
app:com.lookout.enterprise

Click on Android Enterprise Settings > System Update Settings.

Click the check box for Configure System Update Settings and fill out the information as shown
in the screenshot below.
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+ System Update Settings

Configure System Update Settings

Install during maintenance window ¢
Update options

If "Install during maintenance window only” is selected and the maintenance window is specified. this is valid
for 30 days only. After this period, the updates are installed immediately.

11:00 ~

Daily maintenance window - Start time (in mins)
In 24 hour format and in device local timezone

) ) ) ) . . 06:00 ~
Daily maintenance window - End time (in mins)
In 24 hour format and in device local timezone
Configure Freeze Period D
System updates will be blocked when the device local clock time is within the freeze periods

To configure a default Apple policy to require the installation of MaaS360 and Lookout for Work,
perform the following steps:

1. Click Security > Policies.

2. Click the Default i0OS MDM Policy.

3. Under Device Settings, click Application Compliance.

4. Click Edit and check the Configured Required Applications check box.

5. Under the application names, add Lookout for Work and IBM MaaS360. Note that typing in the
Application Name field will cause MaaS360 to search for the application. Click the application
when it appears in the search field.

6. Click the Save And Publish button.

8.3.4 Alerts

MaaS360 can alert via the My Alert Center dashboard on the home page. The My Alert Center
dashboard can have custom alerts added. The lab instance used this capability to alert administrators
when mobile devices might be running older firmware versions. For more information on building the
alert center, see the following page.

The following steps walk through creating an alert to show out-of-date Apple devices:
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1. Click the Home tab of MaaS360.
2. Under the My Alert Center, click the plus (+) icon.

3. Fill out the Search Criteria as shown below. This rule creates a search that looks for devices that
are currently active and fall under the category of smartphones and tablets. To make sure that
we only look at Apple devices, the first condition has been set to match devices that have been
manufactured by Apple. The second condition sets the OS version to be no less than 14.8.

Name & Description Apple Out of Date Apple Device Out of Date Security

Advanced Search

1. Search for (®) Active Devices (O Inactive Devices (O Al Devices
2. With Device Type(s) [] Desktops [] Laptops Smartphones Tablets Other
3. Last Reported Last 7 Days v
4. Search Criteria All Conditions (AND) > Leamn more about configuring Search Criteria accurately
Condition 1 Hardware Inventory v Manufacturer v Contains v  Apple -
Condition 2  Operating System v OS Version (Numeric) ~  Less Than v 148
4. Click Save.

5. The My Alert Center will update with the results of the search, as shown below.
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My Alert Center

Security Alert: Needs Altention Security Alert: Mo Incidents

1 Android Out of Date

0 Pending Approval

0 Jailbroken or Rooted

Info only Alert

2 Apple Out of Date

0 Recently Added

‘I Out of Compliance

8.3.5 Firmware Updates

The MaaS360 tool can push out firmware updates to devices that are corporate owned or enrolled as
supervised devices. The lab instance utilized this feature to push firmware updates to devices to meet
the firmware patching scenario.

Android device patching was covered in Section 8.3.3. The policy that was previously configured will
have Android devices automatically install software updates during a defined maintenance window.
Administrators can set the policy to automatically install updates as soon as they are available instead of
waiting for a maintenance window. This can be used to provide immediate patching in the case of
emergencies. Please consult the following page for more information on configuring policy for Android
system updates.

Apple i0OS devices do not have a way for policy to be configured to automatically push out system
updates. However, administrators can still push out iOS updates to supervised devices through a manual
process. To push out an Apple iOS update to a group of devices, perform the following steps:

1. From the MaaS360 Portal click Devices > Groups.

2. Under the Groups list, find iOS devices. Note that other device groups are automatically
available, such as iPhones or iPads, if an administrator does not want to push out the update to
all iOS devices.

3. Under the More button, select Push iOS Update.
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Groups

MName Type
iPhones O E
Devices Refresh Edit More...
i0S Devices . E
Devices Refresh Edit More...
Windows Mobile Devices Delete . E
Devices Refresh Edit M
Create Copy
Symbian Devices .
6

Devices Refresh Edit M Buzz Devices

Employee Owned Devices Hide Devices . E

Devices Refresh Edit M
Send Message

Windows Phone Devices . ,g
Devices Refresh Edit t  cccuie Shell Script 0

K € 1 Push macOs Update -310f31Records | Show 25
Pugh i0OS Update
Change Policy
Change Rule Set
Distribute App
Remove App
Restart i0S Devices
Shutdown i0S Devices
Manage Android Devices

Manage Windows 10 Devices

Migrate to Android Work Profile

4. The Push iOS Update window will appear. Select Download and Install, then click the Continue
button.
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8.4 IBM MaasS360 with Watson Reporting

IBM MaaS360 has the capability to create a variety of reports that may help administrators gain better
insight of the enterprise’s mobile environment. Reports are available for hardware inventory, network,
app inventory, mobile data usage, user endpoint management overview, and app security settings.
Administrators can also customize reports and opt to have reports delivered on a daily, weekly, or
monthly basis. Reports are refreshed every 24 hours, and they are available for data that is up to 180
days old. There are also filters available that may be helpful with managing the report data.

Reports can be accessed by selecting REPORTS from the MaaS360 Portal, then choosing the type of
report that is needed. For example, the sample report from the lab shown in Figure 8-6 broke down
devices by platform to provide an asset inventory.
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Figure 8-6 Sample Report from MaaS360

Devices by Platform

B Windows.null
B Windows Virtual Machine
B Mac.Laptop

Device Name Username Phone Number Platform Last Reported
PEWKWINSVRO1 ] Not Available Windows 2021-07-20
Stephen's MacBook Pro [ Not Available Mac 2021-04-07
DESKTOP-BNSBE26 e Not Available Windows 2021-07-20

Ownership

Not Available

Corporate Owned

Corporate Owned

Figure 8-7 demonstrates the administrator’s ability to create reports based on the Security State, Vulnerability, Mailbox Approval State, MDM Policy, ActiveSync Policy, and Details Report.

Figure 8-7 IBM Maas360 Report Options

Security Overview = L)

Security State Vulnerability Mailbox Approval State MDM Policy ActiveSync Policy —
] il r | 1 9 H

Additional instructions concerning managing reports in MaaS360 are available here.

Last 180 Days

Details Report

Total Devic

e

Pie
s -3 | Export
Managed Status
Enrolled
Enrolled
Enrolled
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Lookout Mobile Endpoint Security (MES) is a SaaS-based mobile threat defense solution that collects
information from devices via the Lookout for Work mobile application. In our build, it provided
vulnerability scanning, assessment, and reporting for Android and Apple mobile devices. We also
integrated Lookout MES with IBM MaaS360 to provide security policy enforcement actions.

9.1 Integrating Lookout with IBM MaaS360

Lookout MES device enrollment can be accomplished without third-party integration. However, to
enforce installation, the Lookout for Work client must be managed and pushed via an MDM to mobile
devices. In our build, the MDM was IBM MaaS360 with Watson. Detailed information regarding
integrating Lookout and MaaS360 can be found here. Please note that you will need an account to view
the documentation. The following steps provide a high-level overview of integrating Lookout MES with
MaaS360:

1. Create an APl user in MaaS360: This step creates a user in MaaS360 with the correct
permissions that can then be used for Lookout MES to access the MaaS360 API.

2. Create custom attributes in MaaS360: Lookout MES passes device state information back to
MaaS360. Custom attributes will need to be set up in MaaS360 so that the information passed
by Lookout can be stored by MaaS360 and used in policy enforcement. The following attributes
are created:

= |ookout_activation_state: This specifies whether the Lookout for Work app is installed and
activated on the device.

= |ookout_device_state: This indicates the overall state of the device, such as secured, threats
detected, deactivated, or pending activation.

= |ookout_disconnected: This indicates if there is a connection from the mobile device to
Lookout.

= |ookout_threat_level: This categorizes the threat level of the device by none, low, medium,
or high.

= |ookout_unreachable: This indicates if the Lookout MES server is reachable by the mobile
device.

3. Add the Lookout for Work app to the MaaS360 App Catalog.

4. Configure the MaaS360 connector from the Lookout Console.
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9.2 Adding Lookout for Work to the MaaS360 App Catalog

Adding the Lookout for Work iOS and Android applications to the MaaS360 App makes the application
available in the IBM MaaS360 app store. For supervised or corporate-owned devices, the application will
install automatically without further user interaction. More information for adding the Lookout for Work
App to MaaS360 can be found here.

The following steps provide an overview of the process of adding Lookout to MaaS360:
1. From the MaaS360 Portal, select APPS and then click Catalog.

2. Click Add and choose the OS required (iOS is chosen for this example).

i0s i

iTunes App Store App

W08 Sazrch and pick from iTunes

iTunes App Store App (B2B)

05 Lpload your business app detzils

Enterprise App for iOS

05 Lpload your own private enterprise i05 App
Android »

== Windows L4

* macO$§ »

macOS

E Web App

Add a browsar URL (Web Clip)

App Bundles

Search and pick from your app cat=iog

3. Next, select iTunes App Store App. Then enter Lookout Mobile Security in the search bar and
click Add.

4. Add the Lookout for Work configuration details so that when users open the application, it will
be automatically configured and connect to Lookout without further interaction.

9.3 Configuring MaaS360 Connector in the Lookout MES Console

To integrate Lookout MES with IBM MaaS360, perform the following steps:
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1. Select Integrations in the Lookout MES console.

2. Enter the Label for the connection, MaaS360 URL, the APl username and password, Access Key,
Apple ID, and Billing ID. An example is shown below.

Maas360

Connector Settings

Label for this MDM connection

NCCoE
Maas3s0 URL (required)

herps: [ fsenaces. fiberlink.com

Usermame [reguired)

Admin Password

Billing ID {required)

After a successful integration, the Integration page should display the following:
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Integrations

You can connect to supported Mobile Device Management (MDM), Identity and Access
Management (IAM), Mobile Application Management (MAM), and Security Information and
Event Management (SIEM) systemns to syne Lookout threat information and automate
enrollment, activation, and compliance.

Connected products

IBM MaaS360 MDM Conneetor

® Connected - Last polled 4 minutes ago

NCCoE

9.4 Firmware Discovery and Assessment

Once Lookout for Work is activated, it collects details about devices that include the device’s OS version
and the patch level for Android devices, and then lists all CVEs associated with the device based on the
OS version and Android Security Patch Level (ASPL). The Lookout MES platform can discover firmware
(the OS running), and it displays this information under the Devices tab.

Once the Devices tab is chosen, a list of all connected devices are displayed in the window. Select a
device from the list to discover its firmware. Then information about the device’s firmware, including OS
and Security Patch level, can be found by scrolling down to the software section. An example of this
information is displayed in Figure 9-1.
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Figure 9-1 Example of Device Firmware Information

MaaS360
com.fiberlink.maas360.android.control

Software

0Ss

OS Version

OS Version Available
Security patch level

Security Patch Level
Available

Lookout for Work App

Android Locale
11 (Up to date) Firmware Version
11.0.0 Unpatched CVEs

2020-12-05 (Update available)

2021-09-05

en_US

google/redfin/redfin:11/RQ1A.201205.01
1/6966805:user/release-keys

345 View list

By clicking the View List button from the Unpatched CVEs section, administrators can see all CVEs that
are associated with the current OS and ASPL on the device. The Vulnerability Summary tab breaks down
the vulnerabilities associated with a device by severity. An example of this information is displayed in

Figure 9-2.
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Figure 9-2 Example of Vulnerability Severity Information

Oct 4, 2020 449

Vulnerability summary

Showing 1-30 of 449 vulnerabilities

CVE-2020-047 ® Critical Elevation of privilege in System

CVE-2021-043 Critical Remote code execution in System

]
]
J
)

I
»
="
L

CVE-2020-11272 ® Critical Qualcomm components
CVE-2020-3639 ® Critical Qualcomm closed-source components
CVE-2020-11215 ® Critical Qualcomm closed-source components

9.5 Software Discovery and Assessment

Activation of the Lookout for Work client allows for the collection of running applications on the device.
For Android devices, Lookout collects an app inventory for the device which includes details about app
versions plus libraries and software development toolkits (SDKs) used by the apps. For iOS devices, this
information is obtained using the MaaS360 API. Lookout MES can also indicate if there are
vulnerabilities in the applications themselves.

The Lookout MES platform displays a risk grade which shows the risk that the app presents if it was
compromised. Lookout calculates this grade based on the application’s permission (what information it
can access). Each risk grade is on an A to F scale (A, B, C, D, or F). Lookout MES does not link applications
to specific devices unless a device fails a compliance check because of an installed application. For
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example, if there is a rule that prohibits the installation of TikTok, only devices with TikTok installed will
be highlighted.

To view the applications that are installed on devices, select Apps from the Lookout MES dashboard.
Figure 9-3 shows a sample of the Apps page from our build.

Figure 9-3 Lookout Apps Page Sample

548 Apps Custom Policies SUBMIT APPS

91-1200f 548 < >

APP NAME VERSION OS  DEVICES §  FIRST DETECTED RISK GRAL
) Lookout Work 6.16.1 " 1 Sep 9, 2021 B
# com.lookout.work 25% 1:46 PM
TikTok 2110 é 1 Sep 9, 2021 B
com.zhiliaoapp.musically 25% 1:46 PM
SIM Manager = 1 Sep 25, 2021
D.2.0.368100797-google L ] !

a com.google.android.euicc gocg " 25% 2:26 PM =
Google Play Games 2021.07.28550 (389899460.389899460-000408) C >ep 8, 2021 B
com.google.android.play.games 25% 1:45 PM
Payment Services 2028 |ﬁ| 1 Sep 8, 2021 C
com.samsung.android.kgclient 25% 1:45 PM

9.6 Lookout MES Security Protections

Lookout MES allows organizations to set protection parameters for enrolled devices. Lookout comes
preconfigured with multiple templated rules that can be configured to meet organizational risk
tolerance. Policy enforcement can be accomplished through MES directly or via integration with an
MDM.

Our build utilized this feature to implement a rule to restrict network access to devices that had an out-
of-date firmware level. The lab configured this rule by defining a minimum OS version and Android
security patch level and by choosing to alert the device’s user and block access to certain domains if the
minimum is not met.

To configure such a rule, perform the following steps:
1. Click the Protection tab.
2. Scroll down to OS Out-of-date and select a risk level of High under the Risk Level drop-down.

3. Click the gear icon by the Risk Level drop-down menu.
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4. Select the minimum compliant iOS and Android OS versions from the drop-down, as shown

5.

below, then click Save changes.

Configure OS Out-Of-Date Policy X

From this screen you can manage the minimum OS versions for both Android

and 105 that are considered compliant for devices in your fleet.

Minimum Compliant iOS Version

14.0

Minimum Compliant Android OS Version

11.0 (API 30)

From the Protections tab, click On-Device Threat Protection, and set Enable On-Device Threat
Protection to ON.

Protections

Manage settings for: Default Group

Group for unassigned devices - There are 5 devices assigned to this group

Policies Phishing and Content Protection On-Device Threat Protection

Configure policies to either block all internet traffic or block specific corporate domains
when threats are detected.

Enable On-Device Threat Protection

By default, all internet traffic is blocked when a threat is encountered unless you specify
domains you want to be blocked.

L 0" @,
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Under the Response drop-down, choose Block domains and alert devices.
Scroll down to Block specific domains and click a domain to add.

Specify a domain that non-compliant devices should not access. Note that domains can be
added by CSV files.

Click Save changes.

9.7 Security Compliance Enforcement with IBM Maa$360

Lookout MES can pass custom attributes to MaaS360 for use in custom security compliance rules. This
integration was set up in Section 9.1. Our build utilized this capability to block access to corporate
resources for any device with a threat level of high by Lookout MES. Information on applying security
compliance rules for devices can be found here.

The following steps show how to create a security compliance rule using Lookout custom attributes:

1.
2.

Under the MaaS360 console click Security > Compliance Rules.

Click Add Rule Set.

Under the Rule Set Name Field, type in Lookout Custom Attributes and then click Continue.
Under the Basic Settings, ensure that the i0OS and Android fields are checked.

Click on Custom Attribute Rules and fill out the following fields:

= Rule Name: Lookout Threat High

=  Select Attribute: lookout_threat_level (this corresponds to the threat level that Lookout
assigns to a device, which was configured in Section 9.6)

=  Select Criteria: Equal To
= Choose Value: High

Under Enforcement Action, click to Alert and then Block as shown below.

Click Save.
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w Configure Custom Attribute Rules

Lookout Threat High

lookout_threat_lavel g Equal To w high e
Enforcement Action
Configure the actions to be taken at the required time intervals. Time interval specified at any level is taken as the wait Immediately after OOC Alert w4

fime post the previous action.

1 Hours ~ |ater Block w4

Motify User |:| Email Device Notification

Notify Admins [ ] Standard Email List

Please update your device

Message

Enter a custom message for this rule. Maximum of 1024 characters are allowed and =" ~§*|[]{}= cannot be used.
Customize for each action
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Active Directory

Adaptive Network Control

Application Programming Interface
Basic Input/Output System

Bring Your Own Device

Certificate Authority

Command Line Interface

Central Processing Unit
Comma-Separated Values

Common Vulnerabilities and Exposures
Common Vulnerability Scoring System
Device Enrollment Program

Dynamic Host Configuration Protocol
Domain Name System

Extra Packages for Enterprise Linux
End User License Agreement

(Cisco) Firepower Management Center
Fully Qualified Domain Name

(Cisco) Firepower Threat Defense
Gigabyte

Graphical User Interface

Hard Disk Drive

Hypertext Transfer Protocol Secure
Internet Protocol

(Cisco) Identity Services Engine
Information Technology

Lightweight Directory Access Protocol
Media Access Control

Mobile Device Management
(Lookout) Mobile Endpoint Security

Monitoring
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MSI
NAT
NCCoE
NIST
oS
OVA
OVF
PCI
RaaS
RADIUS
RAM
REST
RPM
Saa$
SCCM
SGT
SMBIOS
SMS
SNMP
SP
sqQL
SSH
SSL
TLS
URL
VLAN
VM
VPN
VPR
WAN
WSUsS

(Microsoft) Windows Installer

Network Address Translation

National Cybersecurity Center of Excellence
National Institute of Standards and Technology
Operating System

Open Virtualization Appliance

Open Virtualization Format

Peripheral Component Interconnect
Returner as a Service

Remote Authentication Dial-In User Service
Random-Access Memory

Representational State Transfer

RPM Package Manager

Software as a Service

(Microsoft) System Center Configuration Manager

Security Group Tag

System Management Basic Input/Output System

(Microsoft) Systems Management Server
Simple Network Management Protocol
Special Publication

Structured Query Language

Secure Shell

Secure Sockets Layer

Transport Layer Security

Uniform Resource Locator

Virtual Local Area Network

Virtual Machine

Virtual Private Network

Vulnerability Prioritization Rating
Wide Area Network

Windows Server Update Services
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